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Preface

Information in this document is subject to change without notice.

© 2013 ERLPhase Power Technologies Ltd. All rights reserved. 

Reproduction in any manner whatsoever without the written permission of 
ERLPhase Power Technologies Ltd. is strictly forbidden.

This manual is part of a complete set of product documentation that includes 
detailed drawings and operation. Users should evaluate the information in the 
context of the complete set of product documentation and their particular 
applications. ERLPhase assumes no liability for any incidental, indirect or 
consequential damages arising from the use of this documentation.

While all information presented is believed to be reliable and in accordance 
with accepted engineering practices, ERLPhase makes no warranties as to the 
completeness of the information.

All trademarks used in association with B-PRO, F-PRO, iTMU, L-PRO, 
ProLogic,   S-PRO, T-PRO, TESLA, TESLA Control Panel, Relay Control 
Panel, RecordGraph and RecordBase are trademarks of ERLPhase Power 
Technologies Ltd.

Windows® is a registered trademark of the Microsoft Corporation.

HyperTerminal® is a registered trademark of Hilgraeve.

Modbus® is a registered trademark of Modicon.

Contact Information

ERLPhase Power Technologies Ltd

Website: www.erlphase.com

Email: info@erlphase.com

Technical Support

Email: support@erlphase.com

Tel: 1-204-477-0591
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Using This Guide

This User Manual describes the installation and operation of the TESLA power 
system recorder and the accompanying TESLA Control Panel user interface 
software. It is intended to support the first time user and clarify the details of 
the equipment. 

The manual uses a number of conventions to denote special information:

Example Describes

Start>Settings>Control Panel Choose the Control Panel submenu in the Set-
tings submenu on the Start menu.

Right-click Click the right mouse button.

Recordings Menu items and tabs are shown in italics.

service User input or keystrokes are shown in bold.

Text boxes similar to this one Relate important notes and information.

.. Indicates more screens.
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Version Compatibility

Please contact ERLPhase Customer Service for complete Revision History.

TESLA LITE Version Compatibility

TESLA LITE Firmware Setting Version TESLA Control Panel

v1.0 401 v1.4
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PC System Requirements and Software 
Installation

Hardware The minimum hardware requirements are:

   •   1 GHz processor

   •   2 GB RAM

   •   20 GB available hard disk space

   •   USB port

   •   Serial communication port

A serial port, modem or Ethernet LAN connection is required if communica-
tion with a TESLA recorder is desired.

Operating 
System 

The following software must be installed and functional prior to installing the 
applications:

   •  Microsoft Windows XP Professional Service Pack 3 or 

   •  Microsoft Windows 7 Professional Service Pack 1 32-bit or 64-bit

Software 
Installation 

The CD-ROM contains software and the User Manual for TESLA Control 
Panel.

Software is installed directly from the CD-ROM to a Windows PC. 

The CD-ROM contains the following:

   •  TESLA Control Panel: Program for the recorder

   •  TESLA LITE Firmware: Firmware and installation instructions.

   •  TESLA LITE User Manual: TESLA LITE manual in PDF format

   •  USB Driver

To Install 
Software on 
your Computer

Insert the CD-ROM in your drive. The CD-ROM should open automatically. 
If the CD-ROM does not open automatically, go to Windows Explorer and find 
the CD-ROM (usually on D drive). Open the ERLPhase.exe file to launch the 
CD-ROM.

To install the software on your computer, click the desired item on the screen. 
The installation program launches automatically. Installation may take a few 
minutes to start.

To view the TESLA LITE User Manual the user must have Adobe Acrobat on 
their computer.

Anti-virus/Anti-spyware Software

If an anti-virus/anti-spyware software on your local system identifies any of 
the ERLPhase applications as a “potential threat”, it will be necessary to con-
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System Requirements
figure your anti-virus/anti-software to classify it as “safe” for its proper oper-
ation. Please consult the appropriate anti-virus/anti-spyware software 
documentation to determine the relevant procedure.

Installing TESLA Control Panel
The user must be logged on to the target computer as a user with local admin-
istrator privileges to install TESLA Control Panel. Once installed, the user may 
be logged in as a Limited User, as administrator privileges are not generally re-
quired for operation of the program. The exception to this is the ability to com-
municate with TESLA LITE  recorders through Modem-LAN Gateway, see “If 
an internal modem was installed at the factory, it will already be appropriately 
configured.” on page 4-12.

Overview

Once these steps are complete, go to the First Time Start-Up section for details 
on launching TESLA Control Panel (see “First Time Start-Up” on page 3-6).

Instructions for installing TESLA Control Panel and configuring Win-
dows for its use are covered in “TESLA Control Panel Installation” on 
page 3-1. 
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1 Overview

1.1 TESLA LITE System Description
The TESLA LITE power system recorder is a multi-time frame recording sys-
tem used to monitor electrical power systems. It can record up to 12 ac currents 
and 6 voltage channels and 38 digital (status) channels and store up to 150 re-
cordings.

The TESLA LITE can record data simultaneously in three time domains: high 
speed transient fault (seconds), low speed dynamic swing (minutes), and con-
tinuous trend (10 second to 1 hour intervals). A wide variety of triggers are 
available to initiate recording.

The TESLA LITE system consists of the recorder and the TESLA Control Pan-
el user interface software. TESLA Control Panel user interface software pro-
vides tools to configure the recorder, retrieve and manage records and display 
real time measured values. Control Panel also includes RecordGraph, a graph-
ical record display and analysis software tool.

An optional central station program - RecordBase Central Station - is available 
to automatically collect and store records from multiple recorders. RecordBase 
provides fast network-based access to collected records through distributed 
RecordBase View desktop clients.

1.2 TESLA LITE Features

Installation • 19" rack-mount format

• Small 4U footprint

• Standard signals: 1 A/5 A nominal ac currents, 69 V (120/Root 3) nominal ac 
voltage, dc current or voltage

Hardware 
Supports

• 6 voltage analog inputs  (69.0 V nominal and 138.0 V peak voltage)

• 12 current analog inputs (1.0 A or 5.0 A nominal and 40.0 A or 200.0 A peak 
current defined by installed CTs on the unit level)

• 38 digital inputs (48/125/250 Vdc selectable via jumper setting on the unit 
level)

• 7 output contacts (5 general purpose alarm contacts, 1 cross trigger output 
contact and 1 recorder functional output contact)

• 6 front panel LED, namely Recorder Functional LED, IRIG-B Functional 
LED, Records Stored LED, Recorder Triggered LED, Test Mode LED and 
Alarm LED
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1 Overview
Communication 
Ports

• Front USB to serial COM port (450)

• 100BASE Ethernet with front and rear connectors (401)

• SCADA (404)

• Modem port for internal modem (400)

• Rear COM port (405)

• IRIG-B (403)

Recording • Simultaneous operation in transient fault, dynamic swing and long term trend 
time frames

• 96 samples/cycle (50/60 Hz) transient fault recording. Transient fault records 
from 0.2 to 10.0 seconds with automatic record extension up to the Maximal 
Record Length seconds under multiple trigger conditions. The Maximal 
Record Length for the transient fault recording is user configurable and is set 
in the Utilities>Recording.

• 60 samples/second (1 sample/cycle) dynamic swing recordings. Dynamic 
swing record from 10 seconds to 15 minutes with automatic record extension 
up to the Maximal Record Length minutes under multiple trigger conditions. 
The Maximal Record Length for the dynamic swing recording is user config-
urable and is set in the Utilities>Recording.

• Trend recording for 45 user configurable channels for 15 days at sample in-
tervals from 10 seconds to one hour

• Calculated channels: summations, watts/vars, power factor, positive, nega-
tive and zero sequence components, impedance, fault location, frequency, 
harmonics and logic channels

• Record compression to reduce record size, maximize storage capacity and 
minimize transmission time

Triggers • Rates and level triggering on all input and calculated channels with individual 
controls for delay, logging, record initiation and alarm contact activation

• Configurable logic can be applied to digital inputs and internal trigger states

• User-assigned trigger priorities help identify critical events and records

• Centralized cross-triggering of dynamic swing recordings through Record 
Base Central Station

SCADA • TESLA LITE supports DNP3 and Modbus SCADA communication proto-
cols

• Detailed specifications for the DNP 3 and Modbus communications are pro-
vided in the respective appendices.
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1 Overview
Logging    •  250 entry event log (circular)

   •  15 day long term event log

   •  Voltage sag and swell logging

Fault Location • Automatic fault location on up to 5 lines

• Fault location data available in the event log, in recordings and through 
SCADA

User Interface • Intuitive power system element model simplifies complex configurations

• Integrated record and configuration management tools

• Offline mode allows records to be viewed and configurations created without 
connecting to the recorder

• Record display shows record summaries with trigger event lists so that a pre-
liminary evaluation can be made before the record is transferred

• Real-time metering display shows all input and calculated quantities in user 
customizable layouts

Analysis Tools • Recorder configuration and relevant event information is embedded in each 
record

• Record graphics provide a flexible multi-page interactive display and meas-
urement of all channels including calculated ones

• COMTRADE record export facility

Output 
Contacts

• Up to 5 user-configurable output contacts can be activated by triggers

• Cross-trigger contact can activate other devices

• Failure / Service Required contact
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1 Overview
Communication • Front USB 2.0 interface (user interface)

• Front or rear copper Ethernet network link (user interface and SCADA)

• Direct serial link (user interface and SCADA)

• External or internal modem link (user interface only)

• Standard TCP/IP communication protocol used to communicate with Control 
Panel and RecordBase software

• SCADA (Supervisory Control and Data Acquisition Systems) protocols, 
DNP3 and Modbus. DNP3 over Ethernet is supported

1.3 Front Panel

Figure 1.1: Front Panel

USB port

Table 1.1:  Port Numbers for TESLA LITE

450 USB port

401 100BASE-T

400 internal modem

403 IRIG-B

404 RS-232 SCADA

405 RS-232 User Interface serial or external modem

1. Status LEDs

2. Port 401: Ethernet

3. Port 450: USB

2 3 1

450401
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1 Overview
1.4 Rear Connections

Figure 1.2: Rear Connections

Made in Canada

I1 I4 I7 V1I10I2 I5 I8 V2I11I3 I6 I9 V3 V4 V5 V6I12
AC Current Inputs AC Voltage Inputs

500 512 524503 515 527504 516 528505 517 529506 518 530507 519 531508 520 532509 521 533510 522 534511 523 535501 513 525502 514 526

536 537

538

Power Supply
43 to 275 Vdc
90 to 265 Vac

300 318301 319302 320303 321304 322305 323306 324307 325308 326309 327310 328311 329312 330313 331314 332315 333316 334317 335

External Inputs
29 30 31 32 33 34 35 3628

External Inputs
38 1 2 3 4 5 6 737

Output Contacts
Cross Trig Inoperative

200 201 202 203 204 205 206 207 208 209 210 211 212 213 214 215 216 217 218 219 220 221 222 223 224 225 226 227 228 229 230 231 232 233 234 235

External          Inputs External Inputs
11 20 21 22 23 24 25 26 2712 13 14 15 16 17 1810 19

100 101 102 103 104 105 106 107 108 109 110 111 112 113 114 115 116 117

2 3 4 5 6 7 8 91
External Inputs

Modem IRIG-B SCADA COM

400
403

404 405

Network 2Network 1

402401 RXRX TXTX

Port 400: Internal Modem (option)
Port 401 – 100/1000 BASE-T Ethernet Network
Port 402 – Disabled
Port 403: IRIG B External Clock, modulated or unmodulated
Port 404: EIA 232 SCADA Communication (DNP 3 and Modbus)
Port 405: EIA 232 Serial Connection for PC or an external modem
Ports 500 – 523: AC Current Inputs
Ports 524 – 535: AC Voltage inputs
Ports 100 – 117, 200 – 235 and 300 – 321: External Inputs
Ports 322 – 335: Output Contacts
Ports 536 – 537: Power Supply (43 to 275 Vdc, 90 to 265 Vac)
Port 538: Chassis Ground

Port 400: Internal Modem (option)
Port 401 – 100/1000 BASE-T Ethernet Network
Port 402 – Disabled
Port 403: IRIG B External Clock, modulated or unmodulated
Port 404: EIA 232 SCADA Communication (DNP 3 and Modbus)
Port 405: EIA 232 Serial Connection for PC or an external modem
Ports 500 – 523: AC Current Inputs
Ports 524 – 535: AC Voltage inputs
Ports 100 – 117, 200 – 235 and 300 – 321: External Inputs
Ports 322 – 335: Output Contacts
Ports 536 – 537: Power Supply (43 to 275 Vdc, 90 to 265 Vac)
Port 538: Chassis Ground

Made in Canada

I1 I4 I7 V1I10I2 I5 I8 V2I11I3 I6 I9 V3 V4 V5 V6I12
AC Current Inputs AC Voltage Inputs

500 512 524503 515 527504 516 528505 517 529506 518 530507 519 531508 520 532509 521 533510 522 534511 523 535501 513 525502 514 526

536 537

538

Power Supply
43 to 275 Vdc
90 to 265 Vac

300 318301 319302 320303 321304 322305 323306 324307 325308 326309 327310 328311 329312 330313 331314 332315 333316 334317 335

External Inputs
29 30 31 32 33 34 35 3628

External Inputs
38 1 2 3 4 5 6 737

Output Contacts
Cross Trig Inoperative

200 201 202 203 204 205 206 207 208 209 210 211 212 213 214 215 216 217 218 219 220 221 222 223 224 225 226 227 228 229 230 231 232 233 234 235

External          Inputs External Inputs
11 20 21 22 23 24 25 26 2712 13 14 15 16 17 1810 19

100 101 102 103 104 105 106 107 108 109 110 111 112 113 114 115 116 117

2 3 4 5 6 7 8 91
External Inputs

Modem IRIG-B SCADA COM

400
403

404 405

Network 2Network 1

402401 RXRX TXTX
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2 Connection and Power Up

For drawings, see “TESLA Drawings” in Appendix H.

2.1 Mounting
The recorder is designed to be mounted in a standard . It is 18.970" wide, 
6.930" high and 12.742" deep. An additional 3 inches of depth is required for 
rear connections and cables. 

Case 
Grounding

2.2 Power Supply
A wide range power supply is standard. The nominal operating range is 48-250 
Vdc, 100-240 Vac, +/-10%, 50/60 Hz. To protect against a possible short cir-
cuit in the supply use an inline fuse or circuit breaker with a 5 A rating. Make 
the chassis ground connection to ensure proper operation and safety. 

There are no power switches on the recorder. When the power supply is con-
nected, the recorder starts its initialization process. See “Installing TESLA 
Control Panel” on page 3-1 for the start up process details.

The use of an external surge protection device is required to pass the surge im-
munity requirements of IEC/EN 60255-22-5 Criterion A. ERLPhase recom-
mends either of the following for this function: 

ERLPhase p/n: 107898 

Manufacturer: Phoenix Contact Ltd. 

Manufacturer's p/n: 2858357 (PT 2-PE/S 230AC) 

or 

ERLPhase p/n: 107899 

Manufacturer: Dehn Ltd. 

Manufacturer's p/n: 953 200 (DR M 2P 255) 

One surge protector can be used to protect multiple units, as long as the current 
limit of the surge protection device is not exceeded.

Note that this is a consumable item and not covered by ERLPhase warranty.

WARNING!

To ensure safety and proper operation you must connect the record-
er’s grounding terminal to the station ground. Do not rely on the rack 
mounting screws to provide case grounding. 

Ground the recorder even when testing. 
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2 Connection and Power Up
2.3 Signal Connections

External Input 
Channels

The recorder’s external inputs are dry inputs intended for use with signals from 
a 48/125/250 Vdc station battery. The external inputs are isolated and protect-
ed against transient surges. They activate at approximately 32 Vdc.

Alarm Contacts The alarm contacts on the rear of the unit are dry contacts. They are isolated 
and protected against transient surges. The contacts are designated as follows:

1. User-configurable

2. User-configurable

3. User-configurable

4. User-configurable

5. User-configurable

6. Cross-trigger

7. Recorder function

The cross-trigger contact is used to initiate recording on another recorder when 
this unit triggers. When activated, the cross-trigger contacts close for 0.10 sec-
onds, regardless of the duration of the triggering condition. This ensures that 
the cross-trigger function does not become blocked by a continuous trigger 
condition.

The user-configurable alarm contacts can be defined for use as part of the re-
corder’s trigger configuration. 

IRIG-B Time 
Signal

The BNC connector on the rear of the unit accepts either modulated or unmod-
uled IRIG-B time signals, with or without the 1344 extensions.

Communication 
Ports

See “Communicating with the Recorder (IED)” on page 4-2.
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2 Connection and Power Up
Startup 
Sequence

Front Panel 
LEDs

Table 2.2:  Startup Sequence

On Power Up Front panel Test Mode LED turns on to indicate the 
presence of power

 ~15-20 seconds after Power Up Test Mode LED goes off

 ~25-30 seconds after Power Up Recorder Functional LED turns on.At this point you 
can log into the recorder
Records Stored LED turns on if records are present

Table 2.3:  Front Panel LEDs

Front Panel LED Indications

Recorder 
Functional

Normally active green LED that is turned on approximately 25-30 sec-
onds after power up, indicating the unit is functional. If an internal fault 
is detected, the LED is turned off. The LED state corresponds directly 
with the Failure Contact 

IRIG-B 
Functional

Green LED that is active when a valid external time synchronizing sig-
nal is detected on the IRIG-B port

Recorder 
Triggered

Green LED that is active while the recorder is in the process of creat-
ing a record

Records Stored Green LED that turns on when there are records stored in the 
recorder’s memory. The LED will flash to indicate the Storage Alarm 
limit has been reached if so configured

Test Mode Normally inactive red LED that turns on immediately on power up and 
goes of after the self-test has been completed (approximately 15-20 
seconds)

Alarm Normally inactive red LED that indicates a failure has been detected 
by the software. The presence of the Alarm LED means much of the 
system is functioning and can be accessed for diagnosis
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3 TESLA Control Panel Installation

The TESLA LITE CD-ROM contains the following: 

   •  TESLA Control Panel: interface software

   •  Firmware update with installation instructions

   •  User Manual in PDF format

   •  Mechanical drawings in electronic format

3.1 Installing TESLA Control Panel
You must be logged on to the target computer as a user with local administrator 
privileges to install TESLA Control Panel. Once installed, you may be logged 
in as a Limited User, as administrator privileges are not generally required for 
operation of the program. The exception to this is the ability to communicate 
with TESLA LITE recorders through Modem-LAN Gateway (see “If an inter-
nal modem was installed at the factory, it will already be appropriately config-
ured.” on page 4-12.

Overview Instructions for installing TESLA Control Panel and configuring Windows for 
its use are covered in the following sections. Separate instructions for each ver-
sion of Windows Operating System are provided for the above steps. Use the 
one that is appropriate for your computer. 

The procedure has the following parts: 

1. Install TESLA Control Panel. 

2. Install the Null Modem driver. 

3. Create Windows Dial-Up Network definitions for modem and direct serial 
connections.

Installation of TESLA Control Panel software may require changes to 
your Windows system configuration for proper operation. Please re-
view the instructions in this chapter to ensure proper setup. 

Once these steps are complete, go to the First Time Start-Up section 
for details on launching TESLA Control Panel (see “First Time Start-
Up” on page 3-6).
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3 TESLA Control Panel Installation
3.2 Installation on Windows XP or Windows 7

Step 1: Install 
TESLA Control 
Panel Software 
from CD-ROM

1. Insert the TESLA LITE CD-ROM in your drive. 

2. The CD-ROM should start automatically. If it doesn’t, go to Windows Ex-
plorer and run the “CD.exe” file at the root of the CD-ROM directory.

3. To install TESLA Control Panel software on your computer, select the 
TESLA LITE Power System Recorder icon, then the Install TESLA Control 
Panel. The installation program starts automatically, but may take a few 
minutes to begin.

4. During installation a prompt appears asking whether your TESLA recorders 
are 50 Hz or 60 Hz units. For proper operation it is important to select the 
correct one. If you need to change this in the future, re-install TESLA Con-
trol Panel.

5. When the installation is complete, a TESLA Control Panel icon is placed on 
your desktop. Use the icon to launch Control Panel. 

If you prefer, you can start Control Panel through Windows Start menu 
(Start>Programs>ERLPhase/TESLA Control Panel). 

Step 2: 
Installing Null 
Modem Driver 
Software 

A virtual software modem called a “Null Modem” must be set up for direct se-
rial cable communication between this computer and a TESLA recorder. A 
Null Modem driver is provided with the TESLA installation CD-ROM.

This section provides step by step instructions on how to install the Null Mo-
dem driver. 

1. Start Windows Control Panel by going to Start>Control Panel.

2. Double-click the Phone and Modem Options icon.

3. Select the Modems tab. Select Add to open the Add Hardware Wizard.

4. Select Don't detect my modem; I will select it from a list, then select the Next 
button.

The user will need to have installed previously the ERLPhases USB 
driver provided with the installation CD. See section “USB Link” on 
page 4-5 for instructions. 
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3 TESLA Control Panel Installation
Figure 3.1:  Null Modem Driver Installation

5. Select the Have Disk button, select Browse. To find the file go to c:\Program 
Files\ERLPhase\TESLA Control Panel\Null_Mdm.Inf. Select OK. This is 
the default location for TESLA Control Panel. If you selected a different 
location to install TESLA Control Panel, you will find the Null Modem 
driver (Null_Mdm.Inf) in that directory.

Step 1 - Start>Settings>Control Panel.
Step 2 - Double-click Modems icon.

Step 3 - Add

Step 4 - Select Don't detect my modem; 
I will select it from a list. 
Select Next.
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3 TESLA Control Panel Installation
Figure 3.2: Browse for Null_Mdm.Inf

6. Select the Generic Null Modem driver and select Next. If you are given more 
than one option, select the one that has the most recent date associated with 
it. 

7. Select the serial port you wish to use. You are setting up a serial port to be 
used for a direct cable connection to a TESLA. Typically COM1 or COM2 
are available on a PC for this purpose. Select Next. 
3-4 TESLA LITE User Manual  D03283R01.02



3 TESLA Control Panel Installation
Figure 3.3: Select Serial Port

In Windows XP, you may get a message stating that the Null Modem “has 
not passed Windows Logo testing” and asking “Do you want to continue 
the installation?” Select Continue Anyway to continue. 

8. Select Finish and close the Phone and Modem Options and Control Panel 
dialog boxes.
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3 TESLA Control Panel Installation
3.3 First Time Start-Up

Starting TESLA 
Control Panel

To start TESLA Control Panel, double-click the TESLA Control Panel icon 
placed on your desktop by the installation process or select Start>Program 
Files>ERLPhase>TESLA Control Panel.

Data Location TESLA Control Panel uses a data location on your computer to store records 
and settings from your recorders. By default it is C:\Program Files\Nxt-
Phase\Data, although you may change this later by using the File\Data Loca-
tion command from the Main Menu.

Figure 3.4: Data Location

When you change the data location, previously configured IEDs will 
not be affected. Only newly created IEDs will use the new data loca-
tion. To edit the data location of existing IEDs use the Main Menu Edit 
button.

Note that recent Microsoft Windows security updates prevent non-
Administrative user accounts from storing data under c:\program 
files; it may be necessary to change the default record and config 
storage locations for the IEDs.
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4 Communicating with the Recorder

4.1 Communication Ports
The TESLA recorder has multiple communication ports for local and remote 
access to its user interface and SCADA services. For port pin-out and cabling 
information see “Communication Port Details” on page 4-18.

Table 4.1:  Communication Ports

Location Port Function

Front Panel 401

RJ-45 receptacle, 100BASE-T Ethernet interface. Default IP = 
192.168.100.80

Used for user interface access or SCADA access through Ethernet 
LAN.

Front Panel 450

USB-B receptacle, High speed USB 2.0 interface

Used for user interface access

Default fixed baud rate 115,200 N81 (no parity, 8 data bits, 1 stop 
bit). 

Rear Panel 400
RJ11 receptacle, Internal modem interface.

Default Baud rate 38,400 N81 (no parity, 8 data bits, 1 stop bit)

Rear Panel 401

RJ-45 receptacle 100BASE-T Ethernet interface. Same subnet as 
front panel port 401.

Used for user interface access or DNP SCADA access through 
Ethernet LAN

Rear Panel 403
BNC receptacle, IRIG-B Interface. Modulated or un-modulated, 
330 ohm impedance.

Rear Panel 404

RS-232 DCE female DB9.

Used for SCADA communication.

Default Setting: 19,200 baud O71 (odd parity, 7 data bits, 1 stop 
bit)

Rear Panel 405

RS-232 DCE female DB9. 

Used for: 

• User interface access through a direct serial connection. 
• User interface access through an external modem. The 

optional ERLPhase Modem Adapter converts this port to a 
Data Terminal Equipment (DTE) to simplify connection to an 
external modem.

•  Default Setting: 38,400 baud N81 (no parity, 8 data bits, 1 stop 
bit) 
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4 Communicating with the Recorder
4.2 IRIG-B Time Input
The recorder is equipped to handle modulated or unmodulated GPS satellite 
time IRIG-B signals. The IRIG-B time signal is connected to the BNC connec-
tion on the back of the recorder. When the IRIG-B signal is provided to the re-
corder and is enabled in the settings through the user interface, the IRIG-B 
functional LED comes on and the recorder clock is referenced to this signal. 
No settings are required to differentiate between modulated or unmodulated 
signals; this is automatically detected by the recorder.

You can enable or disable the IEEE 1344 extension in the terminal mode set-
tings Utilities>Setup>Time. The enabled mode receives the year from the 
IRIG-B signal. Disable this setting, if the available IRIG-B signal has no year 
extension.

4.3 Communicating with the Recorder (IED)
You can connect to the recorder to access its user interface and SCADA ser-
vices by: 

   •  Front USB 2.0 interface (user interface) 

   •  Front or rear copper or optical Ethernet network link (user interface and 
SCADA)

   •  Direct serial link (user interface and SCADA) 

   •  External or internal modem link (user interface only) 

The recorder has a front panel USB Port (Port 450), two Ethernet Ports 401 
(one front and one rear panel) and two rear serial ports (Port 404 and Port 405) 
that provide direct access to its user interface and SCADA services.
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4 Communicating with the Recorder
4.4 Ethernet LAN Link

Figure 4.1:  Ethernet LAN Link

You can access both the recorder’s user interface and DNP3 SCADA services 
simultaneously with the Ethernet TCP/IP LAN link through the network port 
Port 401. Both front and rear ports 401 are 100BASE-T copper interface with 
an RJ-45 connector.

Connect to the LAN using a standard Ethernet cable with RJ-45 connectors.

By default, the Port 401 is assigned with an IP address of 192.168.100.80. If 
this address is not suitable, it may be modified using the relay's Maintenance 
Menu, see “Maintenance Menu and Error Handling” on page 12-1.

Modify the Default Gateway and Network Mask if necessary.

   •  The Default Gateway may need to be changed if the recorder and the 
control panel (or RecordBase) are on different but connected networks. 
The default setting is No Default Gateway.

   •  The Network Mask may need to be changed if the recorder and control 
panel are on different subnets. The default setting is 255.255.255.0

   •  To modify the Default Gateway or Network Mask use the maintenance 
Menu command 1- Modify IP address

   •  If unsure of these setting contact your network administrator

PC with TCP/IP

Port 401 - RJ-45

Network Port

Port 401 or Port 402

TCP/IP

Network
D03283R01.02 TESLA LITE User Manual 4-3



4 Communicating with the Recorder
TESLA Control Panel Setup 

1. Ensure that the computer running TESLA Control Panel has access to the 
Ethernet network to which the recorder has been connected.

2. Start TESLA Control Panel.

3. Choose the target recorder from the Select IED list in TESLA Control Pan-
el’s Main Menu.

   •  If there is not already an entry for this recorder, create one using the Add 
New button

Figure 4.2: Edit IED

   •  The method of communication with the recorder is specified as part of 
its IED definition. Use the Edit button to view or change this informa-
tion. Ensure the Network Link option is selected and the recorder’s IP 
address is entered.

Main Menu

Select IED List

Edit button

Edit IED dialogue box
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4 Communicating with the Recorder
   •  For details on IED definitions see “Working with TESLA Control Pan-
el” on page 5-1.

4. Initiate the connection by selecting the Connect button.

   •  A dialog box will appear to show connection progress.

   •  The connection state and the current IED you are connected to is shown 
on the Windows status bar

Figure 4.3: Connect Button Dialog Box

4.5 USB Link

Figure 4.4: USB Link

To create an USB link between the recorder and the computer, first the USB 
driver for the ERLPhase 4000 Series Device needs to be installed, as follows:

Unzip the file (can be obtained from ERL web site):

ERLPhase_USB_driver.zip

Your PC must be appropriately configured for USB communication 
(see “TESLA Control Panel Installation” on page 3-1).

Port 450 - USB

Laptop PC
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4 Communicating with the Recorder
In this case we assume you unzipped to the Desktop

In Windows XP or Windows 7

Connect a USB port of the PC to Port 450 (USB front) of the TESLA 
4000. The TESLA 4000 was already powered on.

In the window

“Welcome to the Found New Hardware Wizard”

“Can Windows connect to Windows Update to search for software?”

Check the option “No, not this time”

In the window

“This wizard helps you install software for:”

ERLPhase 4000 Series Device

“What do you want the wizard to do?”

Check the option “Install from a list or specific location (Advanced)”

In the window

“Please choose your search and installation options”

“Search for the best driver in these locations”

“Uncheck the option “Search removable media (floppy, CD-ROM.)”

Check the option “Include this location in the search”

Browse for the following folder:

C:\WINDOWS\tiinst\TUSB3410

In the window

“Hardware Installation”

“The software you are installing for this hardware

“ERLPhase 4000 Series Device”

has not passed Windows Logo testing to verify its compatibility with 
Windows XP or “Windows can’t verify the publisher”

Hit Continue Anyway

In the window

“Completing the Found New Hardware Wizard”

“The wizard has finished installing the software for”

“ERLPhase 4000 Series Device”

Hit Finish

To verify the installation was successful, and to which comm port is the 
ERLPhase 4000 Series Device configured, do the following:

In Windows XP go to

Start>Control Panel>Performance and Maintenance>Sys-
tem>Hardware>Device Manager>Ports

or (if using Control Panel’s Classic View)

Start>Control Panel>System>Hardware>Device Manager>Ports
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4 Communicating with the Recorder
In Windows 7 ‘small icons’ view, go to 

Start>Control Panel>Device Manager>Ports

Look for the port number associated to this device

“ERLPhase 4000 Series Device”

Look for a COM#, where “#” can be 1, 2, 3, etc. Leave the default 
settings for this port.

It is recommended to restart the PC after the USB driver installation.

The default baud rate for the recorder USB Port 450 is 115200, however to 
double check it login to the recorder display and go to:

Main Menu> System> Recorder Comm Setup

To establish a USB link between the recorder and your computer, connect 
your computer’s USB port and Port 450 on the recorder’s front panel. Use a 
standard USB peripheral cable.

1.  Ensure the recorder port and your PC’s port have the same baud rate and 
communication parameters. 

   •  The recorder’s USB port appears as a serial port to the PC and is fixed 
at 8 data bits, no parity and 1 stop bit and has a default baud rates of 
115,200 bauds. 

   •  The baud rate and communication parameters of your computer's USB 
port is set automatically by TESLA Control Panel (Edit IED>Commu-
nication>Direct Serial Link)

2.  Choose the target recorder from the Select IED list in TESLA Control Pan-
el’s Main Menu.

   •  If there is not already an entry for this recorder, create one using the Add 
New button.

   •  The method of communication with the recorder is specified as part of 
its IED definition. Use the Edit button to view or change this informa-
tion. Ensure the Direct Serial Link option is selected.

   •  For details on IED definitions see “Working with TESLA Control Pan-
el” on page 5-1.

3.  Initiate the connection by selecting the Connect button.

   •  A dialog box will appear to show connection progress.

   •  The connection state and the current IED you are connected to is shown 
on the Windows status bar at the bottom of the screen. 

Status Bar shows TESLA Control Panel 

software is connected to the recorder 

and the name of the Current IED.
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4 Communicating with the Recorder
Figure 4.5: Status Bar

If the connection fails, check the following:

   •  The communication parameters are the same on both ends (see Step 1 
above).

   •  The correct serial port has been selected on your computer.

4.6 Direct Serial Link

Figure 4.6: Direct Serial Link

To create a serial link between the recorder and your computer, connect your 
computer’s serial port and Port 405 on the recorder’s rear panel.

The serial ports are configured as EIR RS-232 Data Communications Equip-
ment (DCE) devices with female DB9 connectors. This allows them to be con-
nected directly to a PC serial port with standard straight-through male-to-
female serial cable, for pin-out for details see Communication Port Details on 
page 4-14. Rear Port 404 is for SCADA and Port 405 can be used for direct 
serial access and external modem.

1. Ensure the recorder port and your PC’s port have the same baud rate and 
communication parameters. 

Some newer laptop computers do not have serial ports. A USB serial 
converter adapter can provide a surrogate serial port for a direct 
connection to the TESLA recorder. The Edgeport USB Serial 
Adapter, model # Edgeport/1, from B&B Electronics 
(www.bbelec.com) is an example of such a device. 

Your PC must be appropriately configured for serial communication 
(see “TESLA Control Panel Installation” on page 3-1).

Port 405 - direct/modem

Laptop PC
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4 Communicating with the Recorder
   •  Port 405 is fixed at 8 data bits, no parity and 1 stop bit and has a default 
baud rates of 38,400 bauds. 

2. Choose the target recorder from the Select IED list in TESLA Control Pan-
el’s Main Menu.

   •  If there is not already an entry for this recorder, create one using the Add 
New button.

   •  The method of communication with the recorder is specified as part of 
its IED definition. Use the Edit button to view or change this informa-
tion. Ensure the Direct Serial Link option is selected.

   •  For details on IED definitions see “Working with TESLA Control Pan-
el” on page 5-1.

3. Initiate the connection by selecting the Connect button.

   •  A dialog box will appear to show connection progress.

   •  The connection state and the current IED you are connected to is shown 
on the Windows status bar at the bottom of the screen. 

Figure 4.7: Status Bar

If the connection fails, check the following:

   •  The communication parameters are the same on both ends (see Step 1 
above).

   •  The correct serial port has been selected on your computer.

Status Bar shows TESLA Control Panel 

software is connected to the recorder 

and the name of the Current IED.
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4 Communicating with the Recorder
4.7 Modem Link 

External Modem

Figure 4.8: Modem Link - External

Using an external modem, you can also access the recorders’s user interface 
through a telephone link between the recorder and your computer. 

Recorder Setup

1. Connect a PC-compatible external serial modem to Port 405 on the rear of 
the recorder. 

   •  The cable between the recorder and the modem requires a crossover and 
a gender change as both devices are configured as RS-232 DCE ports.

   •  You can use the ERLPhase Modem Port Adapter (part # 101629) to 
make the recorder’s Port 405 appear as a DTE (like a PC serial port). A 
standard modem cable can then be used to connect to the recorder. 

   •  For port pin-out and cabling information see “Communication Port De-
tails” on page 4-18.

   •  If the unit has an internal modem, an external modem will not work. 

2. Connect the modem to an analog telephone line or switch and turn it on.

   •  A standard telephone cable with an RJ-11 connector is used. 

3.  Configure the recorder’s Port 405 to work with the modem.

   •  Port 405 settings are accessed through the recorder’s standard user in-
terface.

a. Establish a network or a USB connection between your computer 
and Port 401 or 450 on the recorder, run TESLA Control Panel soft-
ware and initiate a connection to the unit. 

b. When connected, select Utilities in the Main Menu list, and go to the 
Communication tab to access the Port 405’s settings.

Your PC must be appropriately configured for modem communica-
tion (see “TESLA Control Panel Installation” on page 3-1).

External

Modem

Telephone

System

Desktop Computer

Analog

Telephone

Line

Port 405 - Direct/Modem

Analog

Telephone

Line
4-10 TESLA LITE User Manual  D03283R01.02



4 Communicating with the Recorder
Figure 4.9: Communications Setup Utility

c. Set the Baud Rate. This will be the rate at which the recorder will 
communicate with the external modem. It does not control the rate 
at which the modems communicate with each other. Unlike a direct 
serial link, there is no need for this baud rate to match that of the re-
mote computer. A rate faster than the modem’s top speed is recom-
mended to take full advantage of the modem’s compression 
capabilities.

d. Select External Modem.

e. The Modem Initialization String lets you set any special command 
codes required by your modem. The factory default for this field is 
“M1” for external modems. These default values are all that are re-
quired for most modems.

f. Save your changes, close the Utilities tab and disconnect.

TESLA Control Panel Setup

1.  Configure your computer to work with its modem. Refer to your computer 
and modem documentation.

2.  Choose the target recorder from the Select IED list in TESLA Control Pan-
el’s Main Menu.

   •  If there is not already an entry for this recorder, create one using the Add 
New button.

   •  The method of communication with the recorder is part of each IED’s 
definition. Use the Edit button to view or change this information. En-
sure the Modem Link option is selected and the telephone number of 
the recorder’s modem is entered.

From Main Menu select Utilities,

then the Communication tab.

Set Baud rate.

Enable modem.
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4 Communicating with the Recorder
   •  For details on IED definitions see “Working with TESLA Control Pan-
el” on page 5-1.

3.  Initiate the connection by selecting the Connect button

   •  A dialog box will appear to show connection progress.

   •  The connection state and the current IED you are connected to is shown 
on the Windows status bar. 

 Internal Modem

Figure 4.10: Modem Link - Internal

You can access the recorder’s user interface through a telephone link between 
the relay and your computer using an optional internal modem (Port 400 if 
installed). 

Connect the recorder's Port 400 to an analog telephone line or switch using a 
standard RJ-11 connector.

Internal modem configuration is done the same way as for external modem. 
Modem initialization string is M1 for internal modem.

If an internal modem was installed at the factory, it will already be 
appropriately configured.

Desktop Computer 

Analog

Telephone

Line

Modem Port - RJ-11

Telephone

System

Analog

Telephone

Line
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4 Communicating with the Recorder
4.8 Accessing SCADA Services
The recorder supports DNP3 (Level 2) and Modbus SCADA protocols as stan-
dard features. This section describes how to connect and configure the servic-
es. Protocol details, including point lists, are provided in the appendices. 

Serial Port 
Connection

Both DNP3 and Modbus protocols are available on the recorder’s serial Port 
404, an RS-232 DCE port with a female DB9 connector. The port is wired to 
support a connection to a PC serial port (or equivalent) using a standard 
straight-through male to female serial cable. An external RS-232 to RS-485 
converter can be used to connect to an RS-485 network. For port pin-out and 
cabling information see “Communication Port Details” on page 4-18.

Ethernet 
Connection

The DNP protocol can also be available over Ethernet using TCP or UDP. A 
standard 100BASET Ethernet cable is required. 

The Ethernet port can support DNP SCADA and user interface access via TES-
LA Control Panel at the same time. 

For details on setting the recorder’s IP address, “Maintenance Menu and Error 
Handling” on page 12-1.

Protocol 
Settings 

Configuration of the SCADA protocol and communication parameters is done 
through the recorder user interface. Use TESLA Control Panel to connect to 
the recorder, then go to Configuration editor section to access SCADA Com-
munication from the Elements Tree. Setting descriptions follow.

Figure 4.11: SCADA Protocol Settings

From Config Edit select

SCADA Communications.
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4 Communicating with the Recorder
Table 4.2:  SCADA Protocol Settings Mode

Mode Select one of the available SCADA modes.

Baud Rate Port 404 serial baud rate. Default is 19,200.

Parity Port 404 serial parity.
Note: When parity is set to None and a Modbus protocol is selected, 
the number of stop bits automatically is set to 2, as per the Modbus 
standard.

Stop Bits (Automatic setting). Always set to 1 stop bit except as noted in Parity 
setting above.

Data Bits (Automatic setting) The number of data bits is controlled by the 
selected protocol mode.
Modbus ASCII:7 data bits
Modbus RTU:8 data bits
DNP 3:8 data bits

Slave Address Identifies the unit to the SCADA master.

Datalink Timeout (DNP) Specifies the time in which the recorder expects a response 
from the SCADA master to primary frame messages. If a response is 
not received in this time, the recorder will re-transmit the message. 
Configuration default timeout is 1000 ms per DNP3 Technical Bulletin 
9804-002. This document is available from the DNP3 User's Group 
(www.dnp.org).
For UDP and TCP modes, the timeout is not settable and is 
automatically set to 0 milliseconds.

Master IP Address (DNP TCP or UDP) Defines the IP address of the master SCADA 
device that will be polling the TESLA. This prevents unauthorized 
master devices from communicating with the TESLA.
Note: This setting does not control IP address of the TESLA's 
Ethernet card. That is done through the recorder's Maintenance 
Menu.
Make sure the Master IP Address is different from the TESLA IP 
Address.

Port DNP TCP or UDP) Defines the TCP or UDP port on which the DNP 
service may be accessed. Usually set to 20000.
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4 Communicating with the Recorder
SCADA Point 
Mapping

Modbus Protocol

The data points available for Modbus SCADA interface are fixed and are not 
selectable by the user. Complete details regarding the Modbus protocol emu-
lation and data point lists can be found in “Modbus Functions” on 
page Appendix D-1.

Figure 4.12: Communications Setup In Control Panel for Modbus
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4 Communicating with the Recorder
DNP Protocol

The relay supports a DNP3 (Level 2) SCADA connection. DNP3 is available 
via a direct serial link or an Ethernet LAN connection using either TCP or 
UDP.

Serial DNP communications can be utilized exclusively via serial Comm Port 
404. Comm Port 404 is an RS232 DCE DB9F port located on the back of the 
relay. An external RS-232 to RS-485 converter can be used to connect the relay 
to an RS-485 network. 

Network DNP communications can be utilized via physical LAN Port 401. 
Port 401 is available as a pair of RJ-45 ports, one on the front of the recorder 
and one on the rear. DNP communications can be used with multiple masters 
when it is utilized with TCP. 

The data points available for DNP SCADA interface are selectable by the user. 
Complete details regarding the DNP3 protocol emulation and data point lists 
can be found in “DNP3 Device Profile” on page Appendix E-1.

Figure 4.13a: DNP_point_map
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4 Communicating with the Recorder
Figure 4.13b: DNP_class_data

Diagnostics Protocol monitor utilities are available to assist in resolving SCADA commu-
nication difficulties such as incompatible baud rate or addressing. The utilities 
can be accessed through the Maintenance user interface, “Maintenance Menu 
and Error Handling” on page 12-1.

Figure 4.14: HyperTerminal
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4 Communicating with the Recorder
4.9 Communication Port Details
The serial port 405 is configured as EIA RS-232 DCE devices with female 
DB9 connectors. This allows them to be connected directly to a PC serial port 
with a standard straight-through male-to-female serial cable. 

A modem adapter (part #101629) is available to convert a port into a DTE de-
vice, equivalent to the serial port on a PC. The adapter allows you connect an 
external modem to the recorder’s Port 405 using a standard modem cable. 

Notes:
IED is DCE, PC is DTE.
Pins 1 and 6 are tied together internal to the IED.

Table 4.3:  TESLA Recorder Serial Ports

Port Location Function

405 Rear Panel Serial port for connection to an external modem or for direct con-
nection to a computer (configurable). Default baud rate set at 
38,400 baud. 

404 Rear Panel Connection to SCADA (DNP3 or Modbus) interface. Default baud 
rate set at 19,200 baud.

Table 4.4:  Signal connections to pins on Recorder Port

Signal Name Direction PC<->IED Pin # on the IED Port

DCD  1 

RxD  2

TxD  3

DTR  4

Common 5

DSR  6

RTS  7

CTS  8

No connection 9
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4 Communicating with the Recorder
Notes:
IED (with modem adapter) is DTE, modem is DCE.
Pins 1 and 6 are tied together internal to the IED.

Table 4.5:  Cable Pin Connections

Male DB-9 Cable End for IED Port Female DB-9 Cable End for Computer Port 

Pin # on Cable Pin # on Cable

1 1

2 2

3 3

4 4

5 5

6 6

7 7

8 8

9 9

Table 4.6:  Signal name connections to pins on Modem Adapter

Signal Name Direction Modem <-> IED Pin # on the Modem Adapter

DCD  1 

RxD  2

TxD  3

DTR  4

Common 5

DSR  6

RTS  7

CTS  8

No connection 9
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5 Working with TESLA Control Panel

5.1 Recorder Workspace
TESLA Control Panel supports multiple recorders. Each recorder has its own 
workspace within Control Panel that stores its communications parameters, re-
cords and configuration files. 

When first installed, TESLA Control Panel includes a workspace for a recorder 
called TESLA Demo Unit. It contains sample records and configuration files 
and is configured for network connection with an evaluation unit.

Selecting a 
Recorder 
Workspace 

To work with a particular recorder, select it from the Select IED box on the 
Main Menu tab. If you are already connected to an IED you will not be able to 
select a different IED until you disconnect.

 

Figure 5.1:  Selecting a Recorder Workspace 

A separate workspace should be created for each recorder on your 
system to store its configuration files and records.

Current IED

Select IED - 
TESLA LITE

Connection Status 
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5 Working with TESLA Control Panel
Current IED Selecting a recorder sets TESLA Control Panel’s focus to that recorder’s work-
space, known as the Current IED. The records and configuration files belong 
to the selected recorder. 

If you initiate a connection using TESLA Control Panel, it connects to the cur-
rent IED using the communication parameters specified for this IED. 

TESLA Control Panel assumes that the recorder it is communicating with is 
the one identified as the Current IED. Forcing a connection with a different re-
corder (i.e. moving the serial cable without telling Control Panel to discon-
nect), can cause the records and configuration files of that recorder to be mixed 
with those of the Current IED. 

The name of the Current IED is always displayed in the Status Bar at 
the bottom of the TESLA Control Panel window (for details see Fig-
ure 5.1: Selecting a Recorder Workspace on page 5-1).
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5 Working with TESLA Control Panel
5.2 Adding/Editing a Recorder Workspace Definition
Recorder workspaces are added, modified or deleted from the TESLA Control 
Panel Main Menu using controls in the Select IED dialog box (for details see 
Figure 5.1: Selecting a Recorder Workspace on page 5-1) The Edit button dis-
plays the selected recorder’s definition screen. The Add New button is used to 
create a new recorder definition. The IED definition is shown in Figure 5.2: 
Recorder Workspace Definition and the settings are described in the following 
table.

Figure 5.2: Recorder Workspace Definition

Table 5.1:  IED Workspace Settings

IED Definition

IED Name The IED Name is the name you assign to this recorder’s workspace. 
It appears in the IED selection and the Current IED display at the bot-
tom of the TESLA Control Panel window.
We recommend that you use the same name for this workspace as 
the Unit Name given to the recorder (“Unit Identification” on page 7-
2).

Comments User-defined, for your reference only.

Location User-defined, for your reference only.

IED Serial Number Enter the IED Serial Number to match the serial number of the actual 
recorder.
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5 Working with TESLA Control Panel
Get Information from 
IED

Connects to the recorder and retrieves its configured name, location 
and serial number.  The corresponding fields in the IED Defini-
tions are overwritten.

Model TESLA 2000 / 3000 / 4000 / LITE, 18 or 36 channel, or TESLA 3000 /
4000- Cooperative IED

Configuration

IP Address IP addresses of the recorder. The recorder’s default factory IP 
addresse 192.168.100.80. It is changed through the recorder’s Main-
tenance Menu,

Communication

Direct Serial Link Connect to this recorder through a serial cable.

Modem Link Connect to this recorder via a telephone link. 

Network Link Connect to this recorder via a TCP/IP network. 

Connect Through 
IED

Connect to this recorder through another recorder that is providing a 
modem-Lan gateway. An IED Definition for the selected recorder 
must already exist. For details on setting up a modem-Lan Gateway 
“If an internal modem was installed at the factory, it will already be 
appropriately configured.” on page 4-12)

Folder Placement The Default Folder directory applied to new IED definitions can be 
modified with the File>Data Locations command from the Main 
Menu. 

Recordings Folder The directory where the IED’s retrieved records are stored.

Configs Folder The directory where the IED’s configuration files are saved.

You can share configuration files and records with other TESLA Con-
trol Panel users by using common folders

Table 5.1:  IED Workspace Settings
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5 Working with TESLA Control Panel
5.3 Online and Offline Operation
TESLA Control Panel can be used with or without a connection to the selected 
recorder. Both offline and online modes work within the selected Current IED 
workspace. 

Offline (Not 
Connected)

In Offline mode, you can manage and display a recorder’s local (previously up-
loaded) records and create and edit configuration files without being connected 
to the unit.

Online 
(Connected)

In Online mode you are connected to the recorder and have access to both local 
and remote data and functions: 

   •  Records (both local and on the recorder)

   •  Event log 

   •  Metering (realtime readings of input and calculated channels) 

   •  Channel and trigger configurations (the one presently active in the recorder 
and any saved ones you may have created) 

   •  Setup utilities and record configuration screens 

   •  Record graphics display 

   •  Trend logs

Connection 
Status

The Status Bar at the bottom right side of the TESLA Control Panel window 
shows if you are presently online or offline.
D03283R01.02 TESLA LITE User Manual 5-5



5 Working with TESLA Control Panel
5.4 Navigating in TESLA Control Panel
TESLA Control Panel uses a split screen format. The left pane is used for nav-
igation or selection. The right pane is the working area for each of the pro-
gram’s main sections. To bring up the Control Tabs, shown below, you must 
select the appropriate item on the Navigation Tree by double-clicking.

Figure 5.3: TESLA Control Panel Display Sections Navigation Tree

The left pane provides a means of moving between TESLA Control Panel 
functions or selecting items within a function (e.g. channels from a record). 
TESLA Control Panel functions—Records, Trend, Events, Metering, Utilities 
and Configuration are activated by a double-click. 

You can optimize the screen space between the tree and the working area to 
create a larger working area. Some screens have a Hide Tree button to maxi-
mize the working area.

Working Area The Working Area on the right pane of the display represents the main working 
area of each section of the TESLA Control Panel. 

Control Tabs The Control Tabs are a row of selection tabs near the bottom of the screen. 
Each time you start a function, a corresponding tab is created.

Select the control tabs to navigate from one screen to another or the Main Menu 
item. Use the Close button to close the screen. 

Status Bar The Status Bar at the bottom of the TESLA Control Panel displays the name of 
the selected recorder workspace and the status of the connections.

Navigation Tree Working Area

Re-Size Bar

Control Tabs Status Bar

Select Item
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6 Metering Display

The recorder has a full set of real-time metering displays that provide present 
readings from the analog and digital input channels, and the calculated chan-
nels.

The Metering display is accessed through the Metering item in the Main Menu 
tab’s function list.

Figure 6.1:  Metering Display

Standard 
Metering 
Screens

The Metering display provides tabs at the bottom to select among multiple dis-
play screens. The first two tabs, Analogs and Digitals are the default tabs and 
present the readings from the analog inputs and external inputs.

User-Defined 
Metering 
Screens

You can define an additional ten user-defined metering screens. Setup of these 
additional screens is part of the recorder’s configuration (see “Meter Groups” 
on page 8-43).

Primary/
Secondary

Metered values can be shown as either system primary or secondary quantities.
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6 Metering Display
Display Zoom The magnification of metering screens can be adjusted using the Zoom Level 
(%) control. This allows the display to be enlarged for easy viewing while com-
missioning or testing.

Freeze The Freeze button provides a way to temporarily stop the update of the display. 
It can be used to ensure a synchronized set of readings for documentation pur-
poses. The metering display can be exported to another program using Win-
dows built-in Alt PrintScreen key and standard paste functions.

Phase angle readings displayed in meter groups are based on the 
configured Phase Angle Reference Channel (see “Phase Angle Ref-
erence Channel” on page 8-10).
6-2 TESLA LITE User Manual  D03283R01.02



7 Recorder Setup Utilities

The TESLA recorder has global setup parameters that establish its identity and 
define its operation. Setup parameters define: 

   •  Unit identification 

   •  Communication port parameters

   •  Record length and mode settings 

   •  Time display and settings

   •  Analog input calibration

   •  Central Station trigger and record notification

   •  Passwords

Figure 7.1:  Recorder Setup Utilities

The setup parameters are accessed through the Utilities tab on TES-
LA Control Panel. You must be communicating with the IED for the 
Utilities tab to be available.

For details on connecting to the recorder using TESLA Control Panel 
software see “Communicating with the Recorder” on page 4-1.
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7 Recorder Setup Utilities
7.1 Unit Identification
The Unit Identification tab identifies a particular recorder and its records. Dou-
ble-click Utilities to bring up the tabs; select Unit Identification. 

Figure 7.2: Recorder Setup Utilities - Unit Identification

Table 7.1:  Unit Identification Settings

Identification

Serial Number Read-only field, displays the serial number of the TESLA unit cur-
rently connected.

Unit ID User-entered field that identifies the unit. It is part of the name given 
to records produced by the unit to identify their origin. 
By convention, this name should be the same as the "IED Name" 
assigned to the recorder and recorder’s workspace. The name must 
not contain the following: “,” “/” “\” “:” or any other character not valid 
for a Windows file name. 

IED Firmware 
Version

Read-only field that displays the firmware version of the currently 
connected TESLA unit.

Required Settings 
Version

Describes the version of the settings file required by the connected 
recorder. Control Panel is capable of creating older versions of set-
tings files for use with recorders whose firmware has not been 
updated (see “Managing Configuration Files” on page 8-1).
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7 Recorder Setup Utilities
7.2 Communication Port Settings
The Communication settings control the modes and baud rates of the record-
er’s communication ports and defines the SCADA communication mode. 

Figure 7.3: Recorder Setup Utilities - Communication Ports 

Communication 
Version

Read-only field that displays the version of the communications pro-
tocol used by the currently connected TESLA unit.

System Frequency Read-only field that displays the assumed power system frequency of 
the recorder. This is a factory setting.

Station

Station Name User-defined, for your reference only.

Station Number User-defined, for your reference only.

Location User-defined, for your reference only.

Table 7.1:  Unit Identification Settings
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7 Recorder Setup Utilities
For details regarding the data and functions available on the TESLA recorder’s 
SCADA port see “Modbus Functions” in Appendix D and “DNP3 Device Pro-
file” in Appendix E.

Table 7.2:  Communication Settings

Service Port

The Service Port is Port 450 on the front of the recorder. It can be used for connection with 
TESLA Control Panel or a terminal program (to access the Maintenance Menu).

Baud Rate Sets the baud rate of the port. The default baud rate is 115,200 
N81 baud.

Note: The baud rate must match that of the port of the compu-
ter connected to this port. For details about changing the baud 
rate see “Setting Windows Serial Port Parameters” on page 4-
18.

For best results, use the maximum baud rate that your com-
munication link and equipment can sustain.

Direct/Modem Port

The Direct/Modem Port refers to either the recorder’s rear panel Port 405 or its (optional) 
Internal Modem port, depending on the Port Select setting.

Port Select Direct Serial: Port 405 is enabled for a direct serial connection 
with TESLA Control Panel or a terminal program (to access 
the Maintenance Menu).

External Modem: Port 405 can be used to connect to an exter-
nal modem through a serial link.

Internal Modem: Enables a modem connection through the 
recorder’s rear panel RJ-11 Internal Modem Port. Requires 
that the recorder has the internal modem option installed. The 
internal modem can be disabled through the Maintenance 
Menu.

Baud Rate Sets the baud rate of port 405. The default baud rate is 38,400 
baud. For a direct serial connection on Port 405, the baud rate 
must match that of the port of the computer connected to this 
port. For details about changing the baud rate see “Setting 
Windows Serial Port Parameters” on page 4-18.

When configured for an internal or external modem, the baud 
rate specifies the rate at which the recorder communicates 
with the modem. The actual communication rate between 
modems is less than or equal to this setting, depending on 
what the modems can negotiate over the phone line.

For best results, use the maximum baud rate that your 
communication link and equipment can sustain.

Modem Initialization

String

When using an internal or external modem, a modem 
initialization string can be entered containing modem control 
codes. The factory default for this field is “M1”. Refer to the 
modem manual for details.
7-4 TESLA LITE User Manual  D03283R01.02



7 Recorder Setup Utilities
7.3 Recording Control Settings
The Recording Settings control the parameters of the High Speed Recording, 
Low Speed Recording and Trend Logging.

For High Speed and Low Speed Recording the TESLA recorder can create up 
to three records simultaneously. The TESLA employs sophisticated trigger 
combination algorithms used to combine data from multiple events into a sin-
gle record and also to reduce the amount of redundant data in the records. In 
addition, the TESLA will combine data captured using multiple time-frames 
into a single record.

In the TESLA there are two modes of capturing data; Edge Recording and Du-
ration Recording. Both modes are available for High Speed Recording, only 
Edge Recording is available for Low Speed Recording.

Edge Mode

Figure 7.4: Recorder Setup Utilities - Edge Recording 

In Edge Recording, the rising edge of the trigger is used to create a record that 
has a set amount of pre-trigger data and a set amount of post-trigger. This is 
known as a normal length record. If another trigger is processed while the re-
cord is being created, the record may be extended to the full normal length of 
data associated with the new trigger. Multiple extensions can occur up to the 
Maximum Record Length limit. Records with combined High Speed and Low 
Speed data can only be extended during the High Speed data capture portion 
of the record.

Edge Recording mode tends to create smaller records that contain useful fault 
data around the start of the trigger, but may not capture data for the entire du-
ration of the trigger.
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7 Recorder Setup Utilities
Duration Mode

Figure 7.5: Recorder Setup Utilities - Duration Recording 

In Duration Recording, the duration of the trigger determines the record length. 
The record stores the configured amount of pre-trigger data, continues to re-
cord while the trigger is active and then records a configured amount of post-
trigger data. If a trigger remains active, the TESLA LITE stops recording once 
the Maximum Record Length limit is reached. If a subsequent trigger occurs 
while a record is being created, it will be combined with the first trigger using 
a logical OR operation as long as it is not near to the maximum record length 
limit. If the trigger is processed near the end of the record, a new overlapping 
record will be created instead of combining the triggers. Records with com-
bined High Speed and Low Speed data can only be combined during the High 
Speed data capture portion of the record.

Duration Recording mode captures all the data during the fault trigger, but 
tends to create larger records that may contain unimportant data.

To enable record auto-extension for multiple triggers, the Maximum 
record Length must be larger than the Normal Record Length.

At least small amount of pre-trigger time is recommended to ensure 
the triggering event is included in the records.
7-6 TESLA LITE User Manual  D03283R01.02



7 Recorder Setup Utilities
Table 7.3:  Recording Settings

High Speed Recording

Trigger Mode Select Edge or Duration mode. See above for descriptions.

Sample Rate Displays the configured high speed sample rate of 96 samples per 
cycle.

Pre-trigger Time The length of data that is recorded prior to the trigger time. At least 
0.1 seconds of pre-trigger time is recommended to ensure the trig-
gering event is included in the records.

Normal Record 
Length

Normal Record Length (Edge Mode) is the total length of the record, 
including pre-trigger data, without any record extension.

Post-Trigger Time Post Trigger Time (Duration Mode) is the length of data that is cap-
tured after the falling edge of trigger event. 

Maximum Record 
Length

Edge Mode: The maximum length of the record including pre-trigger, 
post-trigger and extensions. To enable record auto-extension for mul-
tiple triggers, the Maximum record Length must be larger than the 
Normal Record.

Duration Mode: The maximum length of the record including pre-trig-
ger, trigger and post-trigger.

Low Speed Recording

Sample Rate Samples at 50 or 60 samples/second (1 sample/cycle) producing 
record lengths of a few minutes to capture slower system dynamic 
swings. The sample rate for low speed recording is based on the 
recorder’s system frequency which is a factory setting.

Pre-trigger Time The length of data prior to the trigger time that is included in the 
recording.

Normal Record 
Length

The total duration of each recording under single trigger conditions. 
Includes the pre-trigger time. 

Max. Extended 
Record Length

The maximum length of the record including pre-trigger, post-trigger 
and extensions. To enable record auto-extension for multiple trig-
gers, the Maximum Record Length must be larger than the Normal 
Record.

Trend Recordings

Sample Rate Read-only display of the trending interval in seconds. The trend log-
ging rate is configured in the recorder’s setting file (see “Trend Log-
ging” on page 8-44).
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7 Recorder Setup Utilities
Storage

High/Low Speed 
Accumulation Mode

Selects whether to overwrite the oldest transient or swing records 
when the storage space is full or the 150 record limit has been 
reached or to stop storing new records. The Storage Alarm can be 
used in conjunction with the Stop setting to provide notification in 
advance of the full condition.

High/Low Speed 
Storage Alarm Limits

When enabled, you can enter a limit giving the percentage of record-
ing space that causes an alarm. Enter a number between 60 and 99. 
The storage alarm condition is indicated by flashing the front panel 
“Record Storage” LED and activating a selected alarm contact. Note: 
the alarm contact assigned to this is displayed as a read-only value. 
It’s set as part of the recorder’s configuration (see “Storage Alarms” 
on page 8-6).

Trend Accumulation 
Mode

Selects whether to overwrite the oldest trend data when the 15 day 
storage limit has been reached or to stop trend. The Storage Alarm 
can be used in conjunction with the Stop setting to provide notifica-
tion in advance of the full condition.

Trend Storage Alarm 
Limits

When enabled, you can enter a limit giving the number of days of 
accumulated trend information that causes an alarm condition. Enter 
a number of days between 10 and 15. The storage alarm condition is 
indicated by flashing the front panel “Record Storage” LED and acti-
vating a selected alarm contact. Note: the alarm contact assigned to 
this is displayed as a read-only value. It’s set as part of the recorder’s 
configuration (see “Storage Alarms” on page 8-6).

Table 7.3:  Recording Settings
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7 Recorder Setup Utilities
7.4 Time Display and Settings
The Time Control tab displays the recorder’s current time and provides con-
trols to describe the IRIG-B time signal input. In the absence of an IRIG-B in-
put there is a facility to set the time manually.

Figure 7.6: Recorder Setup Utilities - Time Control 

When the time is changed manually or by the application of IRIG-B, any ex-
isting trend and continuous disturbance recording data will be compromised. 
You should erase this data after performing the time change.

Displayed Time Time is maintained in UTC format on the recorder (i.e. without a time zone off-
set or daylight savings time applied). If the clock feeding the IRIG-B time sig-
nal to the recorder is sending local time, the recorder converts it to UTC 
internally.

The time displayed in the Time Control screen above is determined by the ad-
jacent time display settings. The recorder will automatically convert from its 
internal UTC time as required. The Recorder Time Zone Setting determines 
the offset between Local time and UTC. DST will automatically add 1 hour to 
the offset if appropriate.

Event and 
Record 
Timestamps

Event timestamps in the recorder’s Event Log are also controlled by the above 
time display settings. They will be displayed as UTC or local times as config-
ured here.

Record timestamps shown in Control Panel’s Records tab are handled a bit dif-
ferently. Record times are converted from UTC using the Windows Time and 
Date settings of the PC running Control Panel. This enables records from mul-
tiple time zones to be normalized to a common time zone and format.
D03283R01.02 TESLA LITE User Manual 7-9



7 Recorder Setup Utilities
Table 7.4:  Time Settings

IED Time is displayed as

UTC Sets the time display and the Event Log timestamps to 
Universal Coordinated Time (UTC). Note that UTC time 
is not affected by the Recorder Time Zone setting or 
Daylight Savings Time. 

Local Time Sets the time display and the Event Log timestamps to 
Local Time. Local time is converted to UTC using the 
Recorder Time Zone setting.

Local Time with DST Same as Local Time, except Daylight Savings Time 
(DST) is factored into the time conversion. Daylight Sav-
ings Time is assumed to be in effect from 2 AM on the 
first Sunday in April until 2 AM on the last Sunday in 
October. 

Present Time
Display

When connected to a recorder, the recorder’s present 
time is shown and continually updated. The specified 
time settings (e.g. Local Time) are applied to the dis-
played time.

Sync/No Sync
Display

Indicates that the recorder is synchronized to an IRIG-B 
time signal input.

Incoming IRIG Signal Properties These settings determine how the recorder responds to 
IEEE 1344 information in the IRIG-B time signal and 
manually define the format of the incoming time if IEEE 
1344 data is not available.

Use IEEE 1344 If Present If Use IEEE 1344 if Present is checked and the source 
clock generates IEEE 1344 data, the recorder: 

• Uses the time zone offset from the IEEE 1344 data 
embedded in the IRIG-B time signal.

• Reads the IEEE 1344 data to determine the mode of 
the incoming IRIG signal (UTC, Local, Local with 
DST).

Otherwise, the recorder uses the manually entered time 
zone offset and clock source mode settings.

Do not use IEEE 1344 If Do Not Use IEEE 1344 is selected, the recorder will 
ignore any IEEE 1344 data in the IRIG-B signal and use 
the manually entered time zone offset and clock source 
mode settings.

IRIG Source Specifies the mode of the incoming clock signal. Ignored 
if IEEE 1344 data is present in the IRIG-B time signal 
and the Use IEEE 1344 If Present setting is enabled. 

Manually Set IED Time Allows the recorder’s clock to be manually set if an IRIG-
B signal is not present. If an IRIG-B signal is present, but 
does not contain IEEE 1344 data, the year can be set 
manually. 

Recorder Time Zone Setting Provides the offset from local time to UTC in hours. For 
example, Central Time has a +6 hour offset from UTC. 
This setting is ignored if IEEE 1344 data is present in the 
IRIG-B time signal and the Use IEEE 1344 If Present 
setting is enabled. 
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7 Recorder Setup Utilities
7.5 Analog Input Calibration
The Calibration Utility provides a means of calibrating the recorder’s analog 
input channels. It is accessed through the TESLA Control Panel’s Utilities tab 
as Analog Input Calibration.

Figure 7.7: Analog Input Calibration
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AC Channel 
Calibration 
Process

To calibrate a channel (Main Menu>Utilities>Analog Input Calibration):

1. Select the channel or channels from the list. More than one channel of volt-
age or current can be chosen using the Control/Shift + left-click.

2. Enter the voltage or current magnitude that is applied to the channel. The sig-
nal magnitude level should be measured with a precision calibrated instru-
ment. 

3. Press the Calibrate Offset and Gain button. If a channel has not yet been con-
figured, only Calibrate Offset will be displayed.

4. Under the Offset and Gain columns the line of the channel being calibrated 
OK or No will be displayed (see “Analog Input Calibration” on page 7-11).

5. Repeat for all other channels being used.

6. Use the Save button to load the new calibration to the recorder.

Out of Range An error message is displayed if the applied signal as seen by the recorder dif-
fers from the value entered in the Applied Signal field by more than 10%. This 
helps to prevent erroneous calibration.

It is possible to calibrate multiple channels simultaneously by using 
the mouse to select a set of channels from the list. Multiple channels 
can be selected using standard Windows selection methods. 
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7.6 Notify
The TESLA LITE recorder can call a ERLPhase RecordBase Central Station 
via modem or LAN to notify it of selected events. 

Notification is used for two purposes:

1. To initiate cross-triggering of dynamic swing records on other recorders.

2. To initiate record transfer to RecordBase when a new record is created. 

The Notify tab of the Utilities screen contains settings to control the dial-out 
process and the initiation of record transfers. 

Automatic 
Record Transfer

You can control which records are automatically transferred to the RecordBase 
Central Station by specifying the required record priority. The setting ranges 
from 0 (all records) to 3 (highest priority only) and provides an option to dis-
able automatic record transfers completely. 

Record priority is determined by the highest priority trigger included in the re-
cord. Trigger priority is set as part of each channel’s configuration.

Cross-Trigger 
Notification

A notification call to RecordBase to trigger swing recordings on other record-
ers can be initiated by any of the recorder’s triggers. Cross-trigger notification 
is selected as part of each channel’s configuration. 

Figure 7.8: Notify Communication Strategy
D03283R01.02 TESLA LITE User Manual 7-13
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Table 7.5:  Notify Settings

Connect Using The TESLA recorder can be set to notify a RecordBase Central Station 
via modem or LAN, or to not notify at all. These 3 options are mutually 
exclusive. Note that the availability of these controls is dependent on 
the hardware options and configuration of the recorder.

Modem If Modem is selected, enter the telephone number of the RecordBase 
call-in modem. All standard modem dialing characters are supported 
(e.g. a comma is used to specify a pause in the dialing sequence).

LAN If LAN is selected, enter the IP address of the computer running 
RecordBase Central Station. 

Do Not Connect If Do Not Connect is selected, the TESLA recorder will not notify 
RecordBase Central Station of new records or cross triggers. This is a 
global setting and can be used to temporarily disable notification.

Retry Attempts These rules are applied when the TESLA recorder fails to establish 
communication with RecordBase Central Station (i.e. if the phone line is 
busy, or if the network is down).

Maximum 
Attempts

When the TESLA recorder fails to establish contact with RecordBase 
central station, this is the maximum number of attempts it will make 
before giving up.

Delay Between 
Attempts

Specifies the delay, in seconds, that the TESLA will wait before making 
another notification attempt.

Notify on creation 
of new Recording 
if Priority is at 
least

Controls which records, if any, are automatically transferred to the 
RecordBase Central Station. When a record is created with a priority 
equal to or greater than the specified value, the recorder sends a New 
Record Created notification message to RecordBase. 
The setting can range from 0 (all records) to 3 (highest priority only). 
Selecting Do Not Notify disables automatic record transfers completely. 
Record priority is determined by the highest priority trigger included in 
the record. Trigger priority is set as part of each channel’s configuration.
7-14 TESLA LITE User Manual  D03283R01.02
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7.7 Password Protection
Access to various TESLA LITE functions can be protected through the use of 
passwords. 

Figure 7.9: Passwords

There are three user access levels: VIEW, CHANGE and SERVICE. 

Setting 
Passwords

Passwords can be viewed and set through the Passwords tab of TESLA Con-
trol Panel’s Utilities screen.

You have the option of explicitly disabling the password protection for each 
access level. Leaving the VIEW access level password disabled, for example, 
will allow free use of the TESLA LITE for read-only operation. 

The Password tab can only be accessed when connected via direct 
serial link through the recorder’s service port (Port 450). This pro-
vides protection from unauthorized remote access while ensuring 
that onsite staff can freely use the recorder.
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Table 7.6:  Setting Passwords

Function Required Access Level

Records Display Record List from IED VIEW

Delete Record from IED CHANGE

Create Fault or Swing Record VIEW

Rename Local Record None

Display Local Record List None

Delete Local Record None

Trends Delete Trends (local) None

Delete Trends on IED CHANGE

Download Trends VIEW

Display Trends None

Event Log VIEW

Events Display Event Log VIEW

Erase Event Log CHANGE

Metering Metering Display VIEW

Utilities Display Unit Identification VIEW

Set Unit Identification CHANGE

Display Communication Settings VIEW

Set Communication Settings CHANGE

Display Recording Settings VIEW

Set Recording Settings CHANGE

Display Time & Settings VIEW

Set Time & Settings CHANGE

Display Calibration VIEW

Save Calibration Changes SERVICE

Change and save passwords SERVICE

Configuration Display Configurations (Online) VIEW

Display Configurations (Offline) None

Load Configuration to IED CHANGE

Save Local Configuration None

Delete Local Configuration None
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Edit Local Configuration None

Rename Local Configuration None

Import Local Configuration None

Save as Local Configuration None

Copy from other IED None

New Configuration None

Table 7.6:  Setting Passwords
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8  Configuring the Recorder

Where the Setup Utilities of the previous chapter specify the recorder’s global 
characteristics, it is the recorder’s Configuration File that defines its individual 
channels and recording triggers. 

The configuration file identifies and adjusts the recorder’s input channels, de-
rived (calculated) channels, record triggers, metering displays and trend logs. 
It also specifies how the recorder handles record storage and excessive trigger 
conditions. Configuration files are created and managed by TESLA Control 
Panel and loaded into the recorder’s non-volatile memory through the commu-
nications link.

8.1 Managing Configuration Files
TESLA Control Panel’s Configuration Manager creates and manages config-
uration files and handles transfer to and from the recorder. To open the Con-
figuration Manager screen, double-click the Configuration line in the left pane 
of the Main Menu screen.

The configurations shown in the Configuration Manager screen are specific to 
the selected Current IED. To work with configurations from another recorder, 
you must first select that unit as the Current IED (from the Main Menu). 

Figure 8.1:  Configuration Manager

If a communication link to the Current IED is available, you can work directly 
with the recorder’s configuration by either double-click on the Present Settings 
item in the list or by selecting Present Settings and using the Edit button. This 
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8 Configuring the Recorder
will read the configuration from recorder and displays it in the Configuration 
Editor.

Editing a 
Recorder’s 
Present 
Configuration

Figure 8.2: Present Configuration

 When you close the Configuration Editor, you are given the option of loading 
the configuration back into the recorder. This gives you a quick way to make 
changes on the fly.

You can also transfer the recorder’s present configuration to a saved file in 
Control Panel using the Get from IED button. When transferred, the configu-
ration appears in the Saved Settings list.

Saved 
Configuration 
Files 

Figure 8.3: Saved Configurations

Saved configuration files are shown under the Saved Settings heading in the 
list. Control Panel can store many saved configuration files, limited only by 
hard disk and Windows operating system constraints. 

Present Settings

Saved Settings
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8 Configuring the Recorder
Saved configuration files can be created, displayed and modified, copied, re-
named, deleted or loaded into the recorder. Click the desired configuration 
from the Saved Settings list, then select the appropriate action button on the 
right of the screen. Double-clicking on a configuration is equivalent to clicking 
the Edit button.

Loading a 
Saved 
Configuration

To load a configuration file from the Saved Settings list into the Current IED, 
you must be communicating with the recorder. Initiate the load by selecting the 
desired configuration file and clicking the Load to IED button. The recorder 
will immediately load and run the new configuration. Complex configurations 
can take a few minutes to transfer and load, depending in part on communica-
tions rate. The recorder will acknowledge the new settings back to Control 
Panel. 

Creating a New 
Configuration

Use the New button to create a new configuration file. New configuration files 
are compatible with the latest Setting Version by default. The Setting Version 
can be changed if desired to create new configuration files for older recorders.

The fixed information in the Device Configuration screen is derived from the 
IED Definition (“Adding/Editing a Recorder Workspace Definition” on 
page 5-3).

It is recommended that you maintain a copy of each recorder’s cur-
rent configuration as a Saved Setting for a backup. It can be loaded 
into a replacement recorder if the unit ever needs to be serviced. 

Note: A configuration file must be compatible with the firmware on the 
recorder in order to be loaded. Compatibility is defined by the Set-
tings Version, a number which identifies the version of configuration 
file a given version of firmware requires.

Control Panel will either prevent incompatible configuration files from 
being loaded or will offer to make the configuration compatible before 
it loads it. 

Note: The recorder will automatically go through a reset when loaded 
with a configuration that changes its sample rate. This will add ap-
proximately two minutes to the load time.
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8 Configuring the Recorder
8.2 Configuration Editor
The Configuration Editor provides the means to create, display and modify 
configurations for the recorder. To start the editor from the Configuration 
Manager screen, either double-click on a configuration file or select it and click 
on the Edit button.

The sample screens shown are from the TESLA LITE Demo configuration.

Figure 8.4: TESLA LITE Configuration Editor

Navigation Tree

The left-side pane of the Configuration Editor window provides a navigation 
tree to access the various sections of the configuration. Selecting an item in the 
tree shifts the large right pane view to the appropriate topic.Double-clicking on 
a tree branch in the left pane that has a small “+” to its left or selecting on the 
“+” itself expands or collapses the tree.

Right-Click Menu

A right-click in the editor provides you with options appropriate to your pres-
ent context. For example, you can create a new element by selecting the appro-
priate channel group, right-clicking and selecting Add Element. Alternatively, 
the same function is in the Config menu.

Closing

The Close button is available to you when you are finished viewing or making 
changes to the Settings. If you made changes, the text on the Close button 
changes to Save/Close as a reminder that Control Panel gives you an opportu-
nity to save your changes to a file (or send them to the IED) before closing the 
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8 Configuring the Recorder
Configuration Editor. To close without saving changes, use the Save/Close 
button and then select Exit Without Saving and Discard on the subsequent 
screens.

8.3 Identification

Device 
Configuration

The Device Configuration screen is displayed when you select the Identifica-
tion item in the Navigation Tree (“TESLA LITE Configuration Editor” on 
page 8-4). It provides information about the selected IED and the particular 
configuration file being edited. Most of the information is drawn from the IED 
Definition and identifies the target recorder (“Adding/Editing a Recorder 
Workspace Definition” on page 5-3).

The Device Configuration screen has three configuration variables that are de-
tailed below.

Settings 
Version

The Settings Version required by a TESLA recorder is shown on the Unit Iden-
tification screen of the Utilities menu (“Unit Identification” on page 7-2). You 
must be connected to the recorder to view this information. Settings Version 
requirements are also listed in the compatibility table at the front of this User 
Manual and are identified in each version’s Release Notes.

The version of a configuration file is controlled through the Settings Version 
field in the main identification screen (see: “TESLA LITE Configuration Edi-
tor” on page 8-4). Changing the setting automatically converts the configura-
tion file to the selected Settings Version. If the conversion results in the loss of 
settings from the file (i.e. the target version does not support functions which 
were enabled in the original), a list of the affected settings is displayed and you 
have the choice of cancelling the conversion or continuing. If the conversion 
results in the addition of new functionality, the settings for the new functions 
will be in a default or disabled state. If you choose to close the configuration 
file without saving, the conversion is also abandoned. 

A new configuration file is set to the latest Setting Version by default. 

TESLA Control Panel can work with configuration files of any Setting Ver-
sion, including those for TESLA 4000, 3000 and 2000 recorders, creating, ed-
iting, storing and transferring them to and from a recorder as needed.

The Sample Rate, the rate at which the TESLA LITE reads its analog and dig-
ital input channels and is the number of samples per second stored in high 

TESLA Control Panel should be updated as needed whenever you 
update the firmware on your recorders. This will ensure it can gener-
ate configuration files with the latest Settings Version. 

Since Control Panel can work with back versions of configuration 
files and can communicate with recorders with older firmware, the 
newest version of Control Panel can always be safely installed.
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speed fault records and used to display calculated high speed channels. The 
sample rate does not affect the data rate of “downstream” calculations that gen-
erate data for low speed swing recordings, low speed calculated channels, the 
metering display update rate or the trending rate. 

The Sample Rate also determines the frequency response of the front-end anti-
aliasing filters and therefore the bandwith of the analog channels. See the fol-
lowing tables.

TESLA LITE sample rate is 96 samples per cycle (5760 samples per second in 
a 60 hz frequncy system or 4800 samples per second for 50 Hz frequency). It 
can calculate upto the 25th Harmonic at this sample rate.

Comments In the Comments section you can enter a description of the configuration for 
reference purposes. This description is also displayed in the configuration 
management screen to identify saved configuration files.

Chatter Limits The Limits screen, accessed by expanding the Identification branch in the Nav-
igation tree, lets you define how the recorder behaves when dealing with nu-
merous, repetitive triggers.

The chatter limit settings specify the time window (Chatter Detection Window) 
in which the chatter detector works. The detector limits the number of triggers 
that can occur - on the same channel and of the same trigger type -within the 
window. Four External Input triggers and two analog or calculated channel 
triggers are allowed in the window. If this number is exceeded, the trigger is 
automatically disabled until the trigger rate falls to less than that number for 
the specified number of seconds (Recovery Time). This prevents the recorder 
from being overloaded by triggers and automatically re-enables the trigger 
when conditions return to normal. 

Note: Although an External Input triggers may be disabled by a chatter limit 
function, the recording will contain the original External Input data.

Storage Alarms The Storage Alarms screen, accessed by expanding the Identification branch in 
the Navigation tree, lets you select the output contact to be closed when the 
memory for triggered records or long term trend logs is nearly full. The accu-
mulation mode (recycle of stop-when-full) and the level at which to alarm are 
set in the Recording tab of the Utilities screen (“Recording Control Settings” 
on page 7-5.

The record and trend storage alarm condition can also be accessed via the 
SCADA protocols. 

8.4 Channels and Triggers
The Channels and Triggers branch of the Navigation tree is where you define 
the recorder’s input channels, calculated channels and triggers. It is significant 
tool with a variety of views and displays to help manage complex recorder’s 
configurations. 
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8 Configuring the Recorder
Channel 
Grouping and 
Naming

This section describes how the record handles channel names.

An effective way to organize the many channels available on the recorder is to 
group them by the power system element they are monitoring. With the Con-
figuration Editor, you can identify each monitored element and use its name to 
group and identify the analog, digital and calculated channels associated with 
it. 

For example, if you have a transmission line named #1, you can define an ele-
ment and name it “Line #1.” The channels associated with that element might 
then be: 

Line #1:Va 

Line #1:Vb 

Line #1:Vc 

Line #1:Ia 

Line #1:Ib 

Line #1:Ic 

External (digital) inputs can also be reasonably associated with the Line #1: 

Line #1:EI:BRKR1_a 

Line #1EI:21N_Trip 

Calculated channels fit the model as well: 

Line #1:W/V (watts and vars) 

Line #1:Iseq (current channel sequence components)

Channel Types and Naming 

Channel names consist of three parts: the Element Name, the Channel Type 
and an optional Descripton field. These fields are combined to produce the full 
channel name in the format: 

Element:Type:Description

e.g. Line #1.EI.BRKR1_a

This is the name that will appear beside a channel when it is displayed in a 
graph or a log. For example the recorder’s Event Log might contain this entry 
for a change in state of a external input:

2005 Jan 12 20:44:33.672 Line #1.EI.BRKK1_a open.

Details on the channel name components are given in the following table.

Table 8.7:  

Element Name (10 chars) 

Free-form text describing the power system element associ-
ated with this channel (e.g. Line #1). Channels that are logi-
cally related can be grouped through the use of the same 
element name.
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Channel Type Standardized channel type descriptors are automatically gen-
erated when you select the channel type. 

Examples

Va Phase A voltage

Ic Phase C current

In Neutral current 

Vac Generic AC voltage 

dc dc voltage or current

EI External inputs 

Vseq Sequence component set (pos, 
neg, zero)

VaSum Summation of Phase A voltages 

W/V Watts/vars set

PF Power factor

Z1 Impedance

Logic Logic function

FLoc Fault locator

Frequency Frequency (one per channel 
group)

Description (optional) 
(12 chars)

Often the combination of the Element Name and the Channel 
Type is sufficient to fully identify a channel (e.g. Line #1:Va). In 
other cases, the Description is required to clarify the channel 
name. (e.g. You might name an external input channel as 
“Line #1:EI:BRKR1_a).

Table 8.7:  
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Element and 
Channel Tree 
Views

The Config Editor can display recorder channels in two distinct views - Ele-
ment View and Channel View. The title at the top of the tree panel indicates 
the present viewing mode. The button at the bottom of the tree pane lets you 
switch to the other viewing mode.

Element Tree 

The Element Tree View organizes channels by the element names you create. 
In the following figure, Element “Line #1” has been expanded to show some 
of the channels associated with it, such as Va.

Figure 8.5: Element Tree View

Channel View

The Channel Tree View displays the same configuration organized by channel 
type. You can use this view to gain an overview of channel usage. Although 
you can chose to work in either view, the Element View is recommended for 
most operations as it provides an automatic way of grouping related channels.

Figure 8.6: Channel Tree View

Present viewing mode - 
Element Tree.

Switch between Channel
Tree and Element Tree.

Switch between Channel
Tree and Element Tree.
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Element 
Overview 

Figure 8.7: Element Overview Screen

An overview of the configured elements is available by selecting an element or 
the channel group heading in the Navigation tree. The last row of the display 
shows the channels and functions that are unassigned and available.

Phase Angle 
Reference 
Channel

The Element Overview screen, displayed by selecting Channel 
Group 1 in the Navigation tree, is where you select the analog input 
channel to be used as the reference channel for angle measure-
ments. All channels use the same reference to provide relative angle 
calculations. Typically, a phase A voltage channel is used as the ref-
erence.
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Channel 
Overview

An overview of the configured channels is available by selecting the associated 
channel type heading from the Navigation tree. For example, selecting Analog 
Inputs displays a table of all defined analog channels.

Figure 8.8: Channel Overview Screen

The column width can be adjusted on the overview tables to optimize the lay-
out for the particular configuration.

Channel settings can be edited in the Channel Overview display, pro-
viding an alternate way to enter channel settings that helps maintain 
consistency between channels. 
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Individual 
Channel 
Screens

Detailed channel configuration is displayed on an individual channel basis. 
The settings for each channel can be displayed in individual screens by select-
ing the specific channel in the Navigation. Each channel type has its own con-
figuration screen with parameters appropriate for its type.

Figure 8.9: Individual Channel Configuration Screen
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Adding an 
Element

To create a new element you must be in the Element Tree view (“Element and 
Channel Tree Views” on page 8-9):

1. Right-click and select Add Element or Insert Element from the shortcut 
menu. Add Element creates the new element at the end of the present Ele-
ment list. Insert Element creates the new element above your current selec-
tion.

2. Type the element name and Enter. The typed text replaces the New Element 
text.

Figure 8.10: Add an Element

Deleting an 
Element

To remove an element from the tree, select it and press the <Del> key or right-
click and select Delete Element from the shortcut menu.

Adding a 
Channel

Channels can be created in either the Element Tree view or the Channel Tree 
View (“Element and Channel Tree Views” on page 8-9). 

To create a new channel in the Element Tree view

1. Select the desired element in the tree.

2. Right-click and select the desired channel type. If appropriate, choose the 
type that matches the input you are monitoring (e.g. Va). For an ac signal 
that has no specific phase designation you can select New AC Voltage or 
New AC Current. If you chose New Ia, Ib, Ic or New Va, Vb, Vc, three en-
tries are created and the configuration screen for the first is displayed. The 
new channel(s) will be inserted automatically in the list.

To create a new channel in the Channel Tree view

1. Select the desired element in the tree.

2. Expand the branches in the tree to show the channels for each group.

Step 1 - Right-click and

select  Add Element.

Step 2 - Name element

and select Enter. 
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3. Select the channel number and an input screen appears on the right side.

4. Type in the information required to configure the channel.

5. When you close the screen, you are asked to save the configuration to the 
recorder. Select Save to Recorder.

Figure 8.11: Adding Analog Input Channels from the Element Tree

Deleting a 
Channel

To remove an channel from the tree, select it and press the <Del> key or right-
click and select the appropriate Delete entry from the shortcut menu.

Step 1 - Select  Analog
Input.

Step 2 - Right-click and
select New Analog Input.

Step 3 - Choose type.
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8.5 Analog Input Channels

Description Basic recording channels for the recorder’s analog input signals.

Input The recorder’s physical analog input channels.

Calculation The rms amplitude of the fundamental is calculated using a DFT function. The 
resultant phasors are used for rate and level triggers, metering, low speed re-
cording, trending and sag/swell detection. The single harmonic and THD de-
tectors are calculated directly from the input samples.

Triggers    •  High & low magnitude

   •  Negative and positive rate of change

   •  Single harmonic magnitude 

   •  THD magnitude

   •  Sag and swell

To prevent multiple triggers on threshold conditions, an hysteresis of 2% of 
setting is applied to magnitude triggers.

Recording High Speed: records the samples generated from the A/D converters at 96 sam-
ples per cycle. 

Low Speed: records the calculated phasors at a rate of one phasor per cycle.

Number of 
Channels

Up to 18 Analog Input Channels can be defined, one for each physical input.

Types Specific: Va, Vb, Vc, Ia, Ib, Ic, In (use where appropriate)

Generic: Vac, Iac

Notes The Analog Input Channel also produces THD and Single Harmonic readings 
that are available to the metering display, SCADA and the long term trending 
function.
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Settings

Figure 8.12: Analog Input Channel Configuration Screen

Table 8.8:  Analog Input Channel Settings

Element Identifies the group to which this channel belongs. The Element forms 
the first part of the channel name. The Element is selected when the 
channel is created and is fixed once assigned when you are working 
in the Element Tree view.

Type Identifies the type of signal being applied to this input channel. The 
Type forms a part of the channel name (Element:Type:Description). 
Selecting the appropriate Type can simplify channel naming by elimi-
nating the need for the optional Description field (e.g. Line #1:Va 
uniquely defines the channel). Initially set when the channel was cre-
ated, the Type can be changed to refer to a different phase as 
needed. 

Description Optional field (12 characters). Provides an additional description of 
the channel that forms part of the channel name. Use if Element 
Name and channel Type do not sufficiently identify the channel. 
(“Channel Grouping and Naming” on page 8-7).

Channel Identifies the physical input used by this channel. This number is iden-
tified on the rear of the TESLA LITE chassis. The list shows only 
inputs not assigned to other channels.
To get an overview of channel assignments, switch to the Channel 
Tree view and look at the Analog Channel list.

View/Set Scale Sets the primary to secondary scale factor. See details below.
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Angle Offset Specifies a phase angle offset to be applied to the channel. The offset 
is included in:

• Meter readings
• Trigger calculations
• Low speed recordings (phasors)
• Trend channels 
• Output to calculated channels (watts, vars, Impedance, Summa-

tions, Sequence components, etc.) that use this channel as their 
input.

High speed recordings of this channel will not have the phase angle 
applied as they are basic representations of the individual sampled 
points.
When the Angle Offset is used on a channel that has been designated 
as the reference channel, it affects the angle measurement of all other 
channels. (See: “Phase Angle Reference Channel” on page 8-10).

Trigger Settings

Rate of Change 
Interval

Specifies the period of time over which both positive and negative rate 
of change is measured. 0.5 to 8.0 cycles.

Single Harmonic 
Number

Selects the harmonic of fundamental frequency that will be used by 
the Single Harmonic trigger. 2 to the highest harmonic allowed, which 
is the 25th harmonic.

Nominal Level Provides a nominal level for the sag and swell detectors. Available on 
voltage channels only. See sag and swell detector details below.

Limit Specifies the trigger levels for the magnitude, single harmonic, THD, 
sag and swell triggers. Specifies the magnitude portion of the rate for 
rate of change triggers.

 Delay Specifies how long the trigger condition must be present before a trig-
ger is declared. 
Magnitude and Rate of Change triggers: 0 to 1,200 seconds in half-
cycle increments. 
Single harmonic and THD triggers: 1 to 10,000 seconds in 1 second 
increments.

Trigger Actions

Enable Enables or disables the associated trigger. A trigger can be disabled 
without altering the rest of its settings.

Fault Initiates a fault (high speed) recording when triggered.

Swing Initiates a swing (low speed) recording when triggered. 
If both Fault and Swing are enabled, the recorder will attempt to cre-
ate a combined record.

Log Logs a message in the Event Log when triggered.

Notify Contacts the RecordBase Central Station when triggered. Can be 
used to initiate wide area swing recordings and/or automated record 
transfer (“Notify” on page 7-13)

Cross Trigger Activates the cross-trigger contact (#4) to trigger another device.

Priority Specifies the priority to be assigned to records created by this trigger. 
The priority is used to determine Central Station notification.
1 - 3 (3 is the highest priority). (“Notify” on page 7-13). 

Table 8.8:  Analog Input Channel Settings
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Scaling Input 
Channels

AC Scaling

When you select the View/Set Scale button on the Analog Input form for an ac 
channel, Control Panel displays the Scaling dialog box for details see Figure 
8.13: AC Scaling on page 18. The scaling factor represents the turns ratio of 
the primary transducer (CT or PT). The nominal secondary value is used as the 
default calibration level for the channel. 

Figure 8.13: AC Scaling

Sag and Swell 
Detectors

Sag and Swell detectors are available on voltage channels. There are three re-
lated fields in the Configuration screen controlling Sag and Swell detectors. 
The definition of a Sag or Swell depends on a Nominal Level of voltage. The 
Sag and Swell thresholds are expressed as a percentage of the Nominal Level. 
The Sag threshold is configurable between 50% and 90% of Nominal. The 
minimum Sag level is fixed at 10% of Nominal. The Swell threshold is config-
urable between 110% and 150% of Nominal. The maximum Swell level is 
fixed at 180% of Nominal.

The duration of a Sag or Swell is fixed at any value between 0.5 cycle and 1 
minute.

Alarm Contact Specifies a rear panel contact to be closed when triggered. Contacts 
are closed momentarily for one second. Contact assignment is not 
exclusive, allowing multiple triggers to activate the same contact. 
Contacts assigned for storage alarms (“Storage Alarms” on page 8-6) 
will not be available for use here. 

Table 8.8:  Analog Input Channel Settings
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8.6 External Input Channels

Description Recording channels for the recorder’s external (digital) input signals.

Input The recorder’s physical external input channels.

Calculation The binary state of each external input is read at the selected high speed sample 
rate. A filter is applied to the samples to prevent triggering on spurious state 
changes, requiring that a state change be present continuously for a minimum 
of approximately 700 microseconds to be considered valid for triggering pur-
poses.

Triggers    •  Active state

   •  Inactive state

Recording Records the state of all external input channels at the selected high speed sam-
ple rate. The input filter is not applied to the recorded data; all state changes 
are included in the records.

Number of 
Channels

Up to 38 External Input Channels can be defined, one for each physical input.

Types EI

Settings

Figure 8.14: External Input Channel Configuration Screen

Table 8.9:  External Input Channel Settings

Element Identifies the group to which this channel belongs. The Element forms 
the first part of the channel name. The Element is selected when the 
channel is created and is fixed once assigned when you are working 
in the Element Tree view.
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Description Optional field (12 characters). Provides an additional description of 
the channel that forms part of the channel name. Should always be 
used with External Input channels to uniquely name the channel. 
(“Channel Grouping and Naming” on page 8-7).

Channel Identifies the physical External Input used by this channel. This 
number is identified on the rear of the TESLA LITE chassis. The list 
only shows inputs which have not been assigned to other channels. 
To get an overview of channel assignments, switch to the Channel 
Tree view and look at the External Channel list.

Trigger Settings

Definite Delay Specifies how long the trigger condition must be present before a trig-
ger is declared. Settable from 0 to 5,000 ms in eighth cycle incre-
ments. 
The delay setting is in addition to the pickup delay imposed by the 
input “glitch” filtering, which is approximately 700 microseconds.

Label Text to designate the active and inactive states. Default is "on" and 
"off". Maximum 8 characters. 

Trigger Actions

Enable Enables or disables the associated trigger. A trigger can be disabled 
without altering the rest of its settings.

Fault Initiates a fault (high speed) recording when triggered.

Swing Initiates a swing (low speed) recording when triggered. 
If both Fault and Swing are enabled, the recorder will attempt to cre-
ate a combined record.

Log Logs a message in the Event Log when triggered.

Notify Contacts the RecordBase Central Station when triggered. Can be 
used to initiate wide area swing recordings and/or automated record 
transfer (“Notify” on page 7-13).

Cross Trigger OC #6 is Cross Trigger, OC #7 is Recorder Functional

Priority Specifies the priority to be assigned to records created by this trigger. 
The priority is used to determine Central Station notification.
1 - 3 (3 is the highest priority). (“Notify” on page 7-13). 

Alarm Contact Specifies a rear panel contact to be closed when triggered. Contacts 
are closed momentarily for one second. Contact assignment is not 
exclusive, allowing multiple triggers to activate the same contact. 
Contacts assigned for storage alarms (“Storage Alarms” on page 8-6) 
will not be available for use here. 

Table 8.9:  External Input Channel Settings
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8.7 Summation Channel

Description Summation Channels combine up to three analog inputs to create a summed 
channel. Each input can be scaled and rotated before it is summed. Previously 
combined summation channels can be used as an input to a new summation 
channel.

Input Analog Input Channels or other Summation Channels can be used as inputs to 
a Summation Channel. The summation can have two or three inputs. If a Sum-
mation Channel is used as an input, it must have a lower Summation Index.

Calculation Each input is converted to a phasor using a DFT function and is scaled and ro-
tated using the Scale Factor and Angle Offset settings.The resulting phasors are 
added to form the summation. 

The high speed recording of a Summation Channel is created by adding the in-
dividual data points from the input channels. The Scale Factor is applied to 
each channel before the addition.

Triggers    •  High & low magnitude

   •  Negative and positive rate of change

To prevent multiple triggers on threshold conditions, an hysteresis of 2% of 
setting is applied to magnitude triggers.

Recording High Speed: generates a channel that is the sum of the individual data samples 
with the Scale Factor applied. A high speed channel is not generated if a non-
zero Angle Offset has been specified on any of the summation’s input channels. 

Low Speed: generates a channel that is phasor sum of the input channels at a 
rate of one phasor per cycle.

Number of 
Channels

10 Summation Channels are available. 

Types Specific: Va, Vb, Vc, Ia, Ib, Ic, In (use where appropriate)

Generic: Vac, Iac

Note: Summation Channels are handled as phasor sums for trigger-
ing, metering, low speed recording and trending. Both the Scale Fac-
tor and Angle Offset settings are applied for these uses.

For high speed recording, Summation Channels are displayed as a 
the sum of the individual data samples with only the Scale Factor set-
ting applied. High speed Summation channels are not recorded if a 
non-zero Angle Offset has been specified. 
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Notes The primary to secondary scale factor used by the Summation Channel is the 
same as that of its first input channel.

Settings

Figure 8.15: Summation Channel Configuration Screen

Table 8.10:  Summation Channel Settings

Element Identifies the group to which this channel belongs. The Element forms 
the first part of the channel name. The Element is selected when the 
channel is created and is fixed once assigned when you are working 
in the Element Tree view.

Type Identifies the type of signal being applied to this input channel. The 
Type forms a part of the channel name (Element:Type:Description). 
Selecting the appropriate Type can simplify channel naming by elimi-
nating the need for the optional Description field (e.g. Line #1:IaSum 
uniquely defines the channel). Initially set when the channel was cre-
ated, the Type can be changed to refer to a different phase as 
needed. 

Description Optional field (12 characters). Provides an additional description of 
the channel that forms part of the channel name. Use if Element 
Name and channel Type do not sufficiently identify the channel. 
(“Channel Grouping and Naming” on page 8-7).

Summation Index Identifies the summation channel. Unlike the analog and external 
input channels, this is not associated with a hardware input, but sim-
ply identifies which of the internal virtual summation channels will be 
used. 
You can select any available channel; the only restriction is that 
nested summations require the input summation to have a lower 
Summation Index. If the only option is “undefined”, you have already 
used all available channels.

Input 1, Input 2, 
Input 3

Identifies the channels to be used in the summation. The available list 
includes all previously defined analog channels and any summation 
channel with a lower summation index number. The list grows auto-
matically as you define new channels. 
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Scale Factor Specifies a multiplier for each of the inputs. The scale factor is applied 
in the secondary domain. 

Angle Offset Specifies a phase angle shift to be applied to each of the inputs.
Note that when an offset is specified, a high speed summation record-
ing - which uses sample by sample addition rather than phasor addi-
tion - is not generated. All other functions, including low speed 
recording, are available and will reflect the offset.

Trigger Settings

Rate of Change 
Interval

Specifies the period of time over which both positive and negative rate 
of change is measured. 0.5 to 8.0 cycles.

Limit Specifies the trigger levels for the magnitude triggers and the magni-
tude portion of the rate for the rate of change triggers. The period por-
tion of the rate is specified by the Rate of Change Interval.

 Delay Specifies how long the trigger condition must be present before a trig-
ger is declared. 0 to 1,200 seconds in half-cycle increments. 

Trigger Actions

Enable Enables or disables the associated trigger. A trigger can be disabled 
without altering the rest of its settings.

Fault Initiates a fault (high speed) recording when triggered.

Swing Initiates a swing (low speed) recording when triggered. 
If both Fault and Swing are enabled, the recorder will attempt to cre-
ate a combined record.

Log Logs a message in the Event Log when triggered.

Notify Contacts the RecordBase Central Station when triggered. Can be 
used to initiate wide area swing recordings and/or automated record 
transfer (“Notify” on page 7-13)

Cross Trigger Activates the cross-trigger contact (#6) to trigger another device.

Priority Specifies the priority to be assigned to records created by this trigger. 
The priority is used to determine Central Station notification.
1 - 3 (3 is the highest priority). (“Notify” on page 7-13). 

Alarm Contact Specifies a rear panel contact to be closed when triggered. Contacts 
are closed momentarily for one second. Contact assignment is not 
exclusive, allowing multiple triggers to activate the same contact. 
Contacts assigned for storage alarms (“Storage Alarms” on page 8-6) 
will not be available for use here. 

Table 8.10:  Summation Channel Settings
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8.8 Sequence Component Channels

Description Sequence Component Channels calculates positive, negative, and zero se-
quence components in one step. The positive sequence component may also be 
used as an input to a watts/vars or impedance function. 

Input Analog Input Channels or Summation Channels can be used as inputs to a Se-
quence Component Channel.

Calculation The sequence component algorithm is applied to produce positive, negative 
and zero sequence components. 

Triggers    •  Positive sequence high and low magnitude

   •  Positive sequence negative and positive rate of change

   •  Negative sequence high magnitude

   •  Zero sequence high magnitude

To prevent multiple triggers on threshold conditions, an hysteresis of 2% of 
setting is applied to magnitude triggers.

Recording High Speed: Positive, negative and zero sequence values at a rate of eight val-
ues per cycle (regardless of the system sample rate).

Low Speed: Positive, negative and zero sequence values at a rate of one value 
per cycle.

Number of 
Channels

6 Sequence Component Channels are available. 

Types Vseq, Iseq

Notes The primary to secondary scale factor used by the Sequence Component Chan-
nel is the same as that of the selected Phase A channel.
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Settings

Figure 8.16: Sequence Channel Configuration Screen

Table 8.11:  Sequence Component Channel Settings

Element Identifies the group to which this channel belongs. The Element forms 
the first part of the channel name. The Element is selected when the 
channel is created and is fixed once assigned when you are working 
in the Element Tree view.

Type Identifies the type of signal being applied to this input channel. The 
Type forms a part of the channel name (Element:Type:Description). 
Selecting the appropriate Type can simplify channel naming by elimi-
nating the need for the optional Description field (e.g. Line #1:VSeq 
uniquely defines the channel). Initially set when the channel was cre-
ated, the Type can be changed to refer to a different phase as 
needed. 

Description Optional field (12 characters). Provides an additional description of 
the channel that forms part of the channel name. Use if Element 
Name and channel Type do not sufficiently identify the channel. 
(“Channel Grouping and Naming” on page 8-7).

Sequence Index Identifies the Sequence Component channel. Unlike the analog and 
external input channels, this is not associated with a hardware input, 
but simply identifies which of the internal virtual summation channels 
will be used. 
You can select any available channel without restriction. If the only 
option is “undefined”, you have already used all available channels.

Phase A, Phase B, 
Phase C

Identifies the channels used to create the sequence set. The list is 
limited to channels of the correct type (voltage or current) and 
includes analog input or summation channels which have already 
been defined. The list grows automatically as you define new chan-
nels.

Trigger Settings

Rate of Change 
Interval

Specifies the period of time over which both positive and negative rate 
of change is measured. 0.5 to 8.0 cycles.
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Limit Specifies the trigger levels for the magnitude triggers and the magni-
tude portion of the rate for the rate of change triggers. The period por-
tion of the rate is specified by the Rate of Change Interval.

 Delay Specifies how long the trigger condition must be present before a trig-
ger is declared. 0 to 1,200 seconds in half-cycle increments. 

Trigger Actions

Enable Enables or disables the associated trigger. A trigger can be disabled 
without altering the rest of its settings.

Fault Initiates a fault (high speed) recording when triggered.

Swing Initiates a swing (low speed) recording when triggered. 
If both Fault and Swing are enabled, the recorder will attempt to cre-
ate a combined record.

Log Logs a message in the Event Log when triggered.

Notify Contacts the RecordBase Central Station when triggered. Can be 
used to initiate wide area swing recordings and/or automated record 
transfer (“Notify” on page 7-13).

Cross Trigger Activates the cross-trigger contact (#6) to trigger another device.

Priority Specifies the priority to be assigned to records created by this trigger. 
The priority is used to determine Central Station notification.
1 - 3 (3 is the highest priority). (“Notify” on page 7-13). 

Alarm Contact Specifies a rear panel contact to be closed when triggered. Contacts 
are closed momentarily for one second. Contact assignment is not 
exclusive, allowing multiple triggers to activate the same contact. 
Contacts assigned for storage alarms (“Storage Alarms” on page 8-6) 
will not be available for use here. 

Table 8.11:  Sequence Component Channel Settings
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8.9 Impedance Channels

Description Impedance Channels calculate impedance from voltage and current inputs. The 
channel can produce either single phase or three phase values. Triggering is 
based on the rate of impedance within a defined impedance circle centered 
around the origin. 

Input Analog Input Channels, Summation Channels or Sequence Component chan-
nel can be used as inputs to an Impedance Channel. Using Sequence Compo-
nent as an input results in a three-phase impedance. 

Calculation The impedance calculation continuously recalculates the apparent impedance 
from the selected voltage and current signals, then subtracts an earlier calculat-
ed value (determined by the “Rate of Change Interval” setting). The impedance 
trigger operates if the difference is between the “Minimum Change” and 
“Maximum Change” settings, and the calculated impedance is within “Circle 
Radius” of the origin.

Triggers Rate of impedance within a defined impedance circle.

Recording Low Speed: Impedance magnitude at a rate of one value per cycle.

Number of 
Channels

5 Impedance Channels are available. 

Types Z1 (impedance)

Notes The impedance magnitude and angle readings are also available to the meter-
ing display, SCADA and the long term trending function.
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Figure 8.17: Impedance Channel Configuration Screen

Table 8.12:  Impedance Channel Settings

Element Identifies the group to which this channel belongs. The Element forms 
the first part of the channel name. The Element is selected when the 
channel is created and is fixed once assigned when you are working 
in the Element Tree view.

Description Optional field (12 characters). Provides an additional description of 
the channel that forms part of the channel name. Use if Element 
Name and channel Type do not sufficiently identify the channel. 
(“Channel Grouping and Naming” on page 8-7).

Impedance Index Identifies the Impedance channel. Unlike the analog and external 
input channels, this is not associated with a hardware input, but sim-
ply identifies which of the internal virtual impedance channels will be 
used. 
You can select any available channel without restriction. If the only 
option is “undefined”, you have already used all available channels.

Voltage Input, Cur-
rent Input

Identifies the channels to be used to create the impedance. If you 
select analog or summation channels as inputs, the impedance chan-
nel calculates single-phase impedance; if you select sequence chan-
nels, it calculates three-phase impedance.The list is limited to 
channels of the correct type (voltage or current) and includes analog 
input or summation channels which have already been defined. The 
list grows automatically as you define new channels.

Trigger Settings

Rate of Change 
Interval

Specifies the period of time over which both positive and negative rate 
of change is measured. 0.5 to 8.0 cycles.

Circle Radius Specifies the radius of the impedance circle in secondary ohms.

Minimum Change Specifies the minimum impedance change to be detected.
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Maximum Change Specifies the maximum impedance change to be detected.

Definite Delay Requires the element to be energized before an active state is deter-
mined. Settable from 0 to 1,200 seconds in half-cycle increments.

Trigger Actions

Enable Enables or disables the associated trigger. A trigger can be disabled 
without altering the rest of its settings.

Fault Initiates a fault (high speed) recording when triggered.

Swing Initiates a swing (low speed) recording when triggered. 
If both Fault and Swing are enabled, the recorder will attempt to cre-
ate a combined record.

Log Logs a message in the Event Log when triggered.

Notify Contacts the RecordBase Central Station when triggered. Can be 
used to initiate wide area swing recordings and/or automated record 
transfer (“Notify” on page 7-13)

Cross Trigger Activates the cross-trigger contact (#6) to trigger another device.

Priority Specifies the priority to be assigned to records created by this trigger. 
The priority is used to determine Central Station notification.
1 - 3 (3 is the highest priority). (“Notify” on page 7-13). 

Alarm Contact Specifies a rear panel contact to be closed when triggered. Contacts 
are closed momentarily for one second. Contact assignment is not 
exclusive, allowing multiple triggers to activate the same contact. 
Contacts assigned for storage alarms (“Storage Alarms” on page 8-6) 
will not be available for use here. 

Table 8.12:  Impedance Channel Settings
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8.10 Watts and Vars Channels

Description The Watts/Vars Channels calculate apparent power (volt-amps), real power 
(watts) and reactive power (vars) from voltage input and current inputs. The 
channel can produce either single phase or three phase values.

Input Analog Input Channels, Summation Channels or Sequence Component chan-
nel can be used as inputs to a Watts/Vars Channel. Using a Sequence Compo-
nent as an input results in three-phase Watts and Vars.

Calculation Voltage and current are multiplied to calculate apparent power, real power and 
reactive power.

Triggers    •  Watts: high and low level (2) 

   •  Watts: positive and negative rate of change (2)

   •  Vars: high and low level 

   •  Vars: positive and negative rate of change

   •  Dual triggers for Watts allows fault and swing recordings to be triggered 
by different settings (e.g. Rate of Change Interval), if desired.

To prevent multiple triggers on threshold conditions, an hysteresis of 2% of 
setting is applied to magnitude triggers.

Recording High Speed: Watt and Var values at a rate of eight values per cycle (regardless 
of the system sample rate).

Low Speed: Watt and Var values at a rate of one value per cycle.

Number of 
Channels

5 Watts/Vars Channels are available. 

Types W/V

Notes The primary to secondary scale factor used by the Watts/Vars Channel is based 
on those of its voltage and current input channels. 

Watts, Vars, and Volt-Amp magnitudes are also available to the metering dis-
play, SCADA and the long term trending function.
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Figure 8.18: Watts/Vars Channel Configuration Screen

Table 8.13:  Watts/Vars Channel Settings

Element Identifies the group to which this channel belongs. The Element forms 
the first part of the channel name. The Element is selected when the 
channel is created and is fixed once assigned when you are working 
in the Element Tree view.

Description Optional field (12 characters). Provides an additional description of 
the channel that forms part of the channel name. Use if Element 
Name and channel Type do not sufficiently identify the channel. 
(“Channel Grouping and Naming” on page 8-7).

Watts/Vars Index Identifies the watts/vars channel. Unlike the analog and external input 
channels, this is not associated with a hardware input, but simply 
identifies which of the internal virtual watts/vars channels will be used. 
You can select any available channel without restriction. If the only 
option is “undefined”, you have already used all available channels. 

Voltage Input Identifies the voltage channels to be used to create the watts and 
vars. These can be either analog input channels, summations or posi-
tive sequences. If you select analog or summation channels as inputs, 
single phase watts and vars will be calculated; if you select sequence 
channels, three-phase watts and vars will be calculated.

Current Input Identifies the current channels to be used to create the watts and 
vars. These can be either analog input channels, summations or posi-
tive sequences. If you select analog or summation channels as inputs, 
single phase watts and vars will be calculated; if you select sequence 
channels, three-phase watts and vars will be calculated.

Trigger Settings

Watts 1, Watts 2, 
Watts 3

Period of time over which both positive and negative rate of change 
for each Watts Detector is measured. 0.5 to 8.0 cycles.

Vars Period of time over which both positive and negative rate of change 
for Var Detector is measured. 0.5 to 8.0 cycles.
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Limit Specifies the trigger levels for the magnitude triggers and the magni-
tude portion of the rate for the rate of change triggers. The period por-
tion of the rate is specified by the Rate of Change Interval.

 Delay Specifies how long the trigger condition must be present before a trig-
ger is declared. 0 to 1,200 seconds in half-cycle increments. 

Trigger Actions

Enable Enables or disables the associated trigger. A trigger can be disabled 
without altering the rest of its settings.

Fault Initiates a fault (high speed) recording when triggered.

Swing Initiates a swing (low speed) recording when triggered. 
If both Fault and Swing are enabled, the recorder will attempt to cre-
ate a combined record.

Log Logs a message in the Event Log when triggered.

Notify Contacts the RecordBase Central Station when triggered. Can be 
used to initiate wide area swing recordings and/or automated record 
transfer (“Notify” on page 7-13).

Cross Trigger Activates the cross-trigger contact (#6) to trigger another device.

Priority Specifies the priority to be assigned to records created by this trigger. 
The priority is used to determine Central Station notification.
1 - 3 (3 is the highest priority). (“Notify” on page 7-13). 

Alarm Contact Specifies a rear panel contact to be closed when triggered. Contacts 
are closed momentarily for one second. Contact assignment is not 
exclusive, allowing multiple triggers to activate the same contact. 
Contacts assigned for storage alarms (“Storage Alarms” on page 8-6) 
will not be available for use here. 

Table 8.13:  Watts/Vars Channel Settings
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8.11 Frequency Channels

Description The Frequency Channels measure the frequency on their assigned input chan-
nel.

Input Any Analog Input Channel. A voltage channel is recommended for best re-
sults.

Calculation Frequency is measured over a multi-second time window to improve resolu-
tion and accuracy. The frequency measurement operates in a band that is ap-
proximately +/-15% of the nominal frequency.

Triggers    •  High & low magnitude

   •  Negative and positive rate of change

To prevent multiple triggers on threshold conditions, the frequency magnitude 
triggers have a fixed 0.02 Hz hysteresis.

Recording Low Speed: Frequency measurements at a rate of one value per cycle.

Number of 
Channels

1 Frequency Channels is available. 

Types Freq

Notes Frequency channel is not associated with particular Elements. 
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Figure 8.19: Frequency Channel Configuration Screen

Table 8.14:  Frequency Channel Settings

Frequency derived 
from

Identifies the analog input channel on which to measure frequency. A 
voltage channel is recommended for best results.

Trigger Settings

Rate of Change 
Interval

Specifies the period of time over which both positive and negative rate 
of change is measured. 0.5 to 8.0 cycles.

Limit Specifies the trigger levels for the magnitude triggers and the magni-
tude portion of the rate for the rate of change triggers. The period por-
tion of the rate is specified by the Rate of Change Interval.
The high magnitude limit is 7/6 x nominal frequency, low magnitude 
limit is 5/6 x nominal frequency.

Delay Specifies how long the trigger condition must be present before a trig-
ger is declared. 0.0333 (2 cycles) to 1,200 seconds in half-cycle incre-
ments. 

Trigger Actions

Enable Enables or disables the associated trigger. A trigger can be disabled 
without altering the rest of its settings.

Fault Initiates a fault (high speed) recording when triggered.

Swing Initiates a swing (low speed) recording when triggered. 
If both Fault and Swing are enabled, the recorder will attempt to cre-
ate a combined record.

Log Logs a message in the Event Log when triggered.

Notify Contacts the RecordBase Central Station when triggered. Can be 
used to initiate wide area swing recordings and/or automated record 
transfer (“Notify” on page 7-13.)

Cross Trigger Activates the cross-trigger contact (#6) to trigger another device.
8-34 TESLA LITE User Manual  D03283R01.02



8 Configuring the Recorder
8.12 Logic Functions

Description Logic Functions are boolean logic statements that can be applied to External 
Input Channels and trigger detectors from other channels. You can choose up 
to 5 inputs, each of which may be inverted, and specify a chain of logic oper-
ations to be performed on each.

Input Up to 5 inputs. Each can be an External Input Channel or the output of a trigger 
detector from any channel, including other Logic Functions with lower Index-
es.

Calculation Boolean logic is applied to each input in succession.

Triggers    •  Active state

   •  Inactive state

Recording Logic Functions are not recorded. 

Number of 
Channels

15 Logic Functions are available.

Types Logic

Notes The output of the Logic functions is available to the metering display, SCADA 
and the long term trending function.

Priority Specifies the priority to be assigned to records created by this trigger. 
The priority is used to determine Central Station notification.
1 - 3 (3 is the highest priority). (“Notify” on page 7-13). 

Alarm Contact Specifies a rear panel contact to be closed when triggered. Contacts 
are closed momentarily for one second. Contact assignment is not 
exclusive, allowing multiple triggers to activate the same contact. 
Contacts assigned for storage alarms (“Storage Alarms” on page 8-6) 
will not be available for use here. 

Table 8.14:  Frequency Channel Settings
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Figure 8.20: Logic Function Configuration

Table 8.15:  Logic Function Settings

Element Identifies the group to which this channel belongs. The Element forms 
the first part of the channel name. The Element is selected when the 
channel is created and is fixed once assigned when you are working 
in the Element Tree view.

Description Optional field (12 characters). Provides an additional description of 
the channel that forms part of the channel name. Use if Element 
Name and channel Type do not sufficiently identify the channel. 
(“Channel Grouping and Naming” on page 8-7).

Logic Function 
Index

Identifies the logic funtion.You can select any available function; the 
only restriction is that nested logic functions require the input logic to 
have a lower Logic Function Index. If the only option is “undefined”, 
you have already used all available channels.

Inputs 1–5 Selects the source of the input state for each stage of the boolean cal-
culation. External Input Channels, trigger detectors from other chan-
nels and previously-defined Logic Functions are available.

Inversion Blocks Allows the input state to be inverted. Click to activate and move 
mouse to select option before releasing.

Logic Gates NOT, AND, NAND, OR, NOR, Exclusive OR, and Exclusive NOR. 
Click to activate, scroll window to display, click icon to select

Delay Module Assert: delays the output for the specified time. 
Deassert: locks in the output state for the specified time.
0 to 1,200 seconds in half-cycle increments.

Trigger Action

Enable Enables or disables the associated trigger. A trigger can be disabled 
without altering the rest of its settings.

Fault Initiates a fault (high speed) recording when triggered.
8-36 TESLA LITE User Manual  D03283R01.02



8 Configuring the Recorder
Swing Initiates a swing (low speed) recording when triggered. 
If both Fault and Swing are enabled, the recorder will attempt to cre-
ate a combined record.

Log Logs a message in the Event Log when triggered.

Notify Contacts the RecordBase Central Station when triggered. Can be 
used to initiate wide area swing recordings and/or automated record 
transfer (“Notify” on page 7-13.)

Cross Trigger Activates the cross-trigger contact (#6) to trigger another device.

Priority Specifies the priority to be assigned to records created by this trigger. 
The priority is used to determine Central Station notification.
1 - 3 (3 is the highest priority). (“Notify” on page 7-13). 

Alarm Contact Specifies a rear panel contact to be closed when triggered. Contacts 
are closed momentarily for one second. Contact assignment is not 
exclusive, allowing multiple triggers to activate the same contact. 
Contacts assigned for storage alarms (“Storage Alarms” on page 8-6) 
will not be available for use here. 

Table 8.15:  Logic Function Settings
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8.13 Fault Locator Functions

Description Fault Locator Functions produce distance-to-fault informations based on the 
impedance measured on the specified voltage and current channels. The infor-
mation is logged and available through SCADA.

Input Initiating Event: any External Input Channel or trigger detector from any other 
channel or function. 

Voltage Channels: must be Analog Input Channels monitoring voltage. 

Current Channels: can be Analog Input Channels or Summation Channels 
monitoring current. 

The correct phases must be selected to achieve the desired results.

Calculation When a user-configurable event occurs, the fault locator assesses the distance 
to fault using the user-supplied line parameters. If one or more of the imped-
ances is consistent with a fault on the line, fault identification (e.g. B-G) and 
location information is generated in the form of an event message.

Triggers N/A

Recording Fault Locator Functions are not recorded.

Number of 
Channels

5 Fault Locator Functions are available.

Types FLoc

Notes When a Fault Locator Function is triggered, it writes a message into the Event 
Log identifying the time, the Element, the faulted type (e.g. A-B, B-G...) and 
the distance to fault. 

The output of the Fault Locator Function is available through SCADA. It can-
not be metered or trended.

In most cases, the Initiating Event input should be delayed by 1.5 cy-
cles to obtain accurate fault location information. The delay can be 
set in the source detector or a Logic Function can be used as an in-
termediary to insert the delay. 
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Figure 8.21: Fault Locator Function Configuration

Table 8.16:  Fault Locator Function Settings

Element Identifies the group to which this channel belongs. The Element forms 
the first part of the channel name. The Element is selected when the 
channel is created and is fixed once assigned when you are working 
in the Element Tree view.

Description Optional field (12 characters). Provides an additional description of 
the channel that forms part of the channel name. Use if Element 
Name and channel Type do not sufficiently identify the channel. (Ref: 
“Channel Grouping and Naming” on page 8-7).

Fault Locator Index Identifies the Fault Location function. You can select any available 
function. If the only option is “undefined”, you have already used all 
available channels.

Initiating Event Any External Input Channel or trigger detector from any other channel 
or function. Note that the initiating Event typically requires a 1.5 cycle 
delay to obtain accurate fault location information.
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8.14 Power Factor Functions

Description Power Factor Functions monitor the real and reactive power values calculated 
by a Watts/Vars Channel and trigger depending on total power level. Inductive 
power factor is defined as a situation where the calculated reactive power is 
positive. Capacitive power factor is defined as a situation where the reactive 
power is negative. 

Input A previously-defined Watts/Vars Channel.

Calculation The Power Factor Detector monitors the watts, vars, and volt-amps values 
computed by its input channel and operates when the power factor is less than 
a user-specified threshold. Separate detectors allow separate thresholds for lag-
ging (inductive) and leading (capacitive) power factors. To reduce the inci-
dence of nuisance operations, you may specify a minimum volt-amps setting.

Triggers Inductive power factor – Low magnitude

Capacitive power factor – Low magnitude

To prevent multiple triggers on threshold conditions, the power factor triggers 
have a fixed hysteresis of 0.05.

Recording Power Factor Functions are not recorded.

Number of 
Channels

5 Power Factor Functions are available.

Types PF

Notes Power factor readings are available to the metering display, SCADA and the 
long term trending function.
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Figure 8.22: Power Factor Function Configuration

Table 8.17:  Power Factor Function Settings

Element Identifies the group to which this channel belongs. The Element forms 
the first part of the channel name. The Element is selected when the 
channel is created and is fixed once assigned when you are working 
in the Element Tree view.

Description Optional field (12 characters). Provides an additional description of 
the channel that forms part of the channel name. Use if Element 
Name and channel Type do not sufficiently identify the channel. 
(“Channel Grouping and Naming” on page 8-7).

PF Detector Index Identifies the Power Factor funtion.You can select any available fun-
tion. If the only option is “undefined”, you have already used all availa-
ble channels.

Watts/Vars function 
to monitor

Specifies which Watts/Vars channel to use as input. Must be previ-
ously defined.

Trigger Settings

Disable detector if 
VA less than

Allows the trigger to be supervised by a minimum VA level. Can be set 
in primary or secondary units.

Limit Power factor trigger level. 0 to 1 in 0.001 increments.

Delay Requires the element to be energized before an active state is deter-
mined. Settable from 1 to 10,000 seconds in 1 second increments.

Trigger Action

Enable Enables or disables the associated trigger. A trigger can be disabled 
without altering the rest of its settings.

Fault Initiates a fault (high speed) recording when triggered.
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Swing Initiates a swing (low speed) recording when triggered. 
If both Fault and Swing are enabled, the recorder will attempt to cre-
ate a combined record.

Log Logs a message in the Event Log when triggered.

Notify Contacts the RecordBase Central Station when triggered. Can be 
used to initiate wide area swing recordings and/or automated record 
transfer (“Notify” on page 7-13).

Cross Trigger Activates the cross-trigger contact (#6) to trigger another device.

Priority Specifies the priority to be assigned to records created by this trigger. 
The priority is used to determine Central Station notification.
1 - 3 (3 is the highest priority). (“Notify” on page 7-13). 

Alarm Contact Specifies a rear panel contact to be closed when triggered. Contacts 
are closed momentarily for one second. Contact assignment is not 
exclusive, allowing multiple triggers to activate the same contact. 
Contacts assigned for storage alarms (“Storage Alarms” on page 8-6) 
will not be available for use here. 

Table 8.17:  Power Factor Function Settings
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8.15 Meter Groups

Figure 8.23: Meter Group Configuration Screen

A Meter Group is a collection of measured and calculated values that are pre-
sented as a group by the Control Panel’s Metering function. Metering Groups 
are referred to by a user-specified name, and the name of the Metering Group 
appears on the tab in the Metering display.

There are two default metering groups and ten user-defined groups for a total 
of twelve metering groups.

The Metering display has fixed displays for analog and external input chan-
nels. You may add additional displays containing any set of channels, orga-
nized as you wish.

1. To create a meter group, right-click on the Meter Groups entry in the Con-
figuration menu. 

2. Select Add Meter Group. A New Meter Group line appears, and the New 
Meter Group text is selected. 

3. Type the Meter Group name, then Enter. The text you type replaces the New 
Meter Group text.

4. In the meter group screen, you can place any defined channel in any cell. The 
resultant meter group display will show the desired channels in the speci-
fied place on the screen.

Phase angle readings displayed in meter groups are based on the 
configured Phase Angle Reference Channel “Phase Angle Refer-
ence Channel” on page 8-10.
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8.16 Trend Logging

Figure 8.24: Trend Log Configuration 

The TESLA LITE recorder can log periodic measurements over an extended 
period of time. Up to 45 values can be logged at intervals ranging from 10 sec-
onds to one hour. 

All recorder channels and calculated values are available for trending. Event 
messages can also be stored in the trend log, allowing them to be saved from 
the normal circular overwrite of the Event Log. 

The trend log accumulates data for up to 15 days. When it is full, it can either 
be set to automatically overwrite the oldest data or to stop logging. A “near 
full” alarm function is available. The accumulation settings are defined in the 
recorder’s Utilities menu (see “Recording Control Settings” on page 7-5).

To configure trend logging select either New Trend from the Config menu or 
New Trend from the right-click context menu in either the Channel Tree or El-
ement Tree. 

The Scan Interval determines the frequency of data logging. It can be set from 
10 seconds to 3,600 seconds (one hour).
8-44 TESLA LITE User Manual  D03283R01.02



8 Configuring the Recorder
Choose channels to be trended by clicking on one of the (larger) spaces in the 
trend grid. Clicking on the arrow that appears, lists all the available channels 
in the list box that appears adjacent to the space you originally clicked. Alter-
natively, use the selection tree that appears to the immediate left of the trend 
grid. Use the tree’s expansion buttons to locate the desired channel, then drag 
and drop your selection on the grid.

You can control how the data is accumulated between logged values for each 
trended value. The Process Options are as follows: 

You can record the same channel with more than one Process Option, but you 
can not record the same channel with the same Process Option more than once.

When you have defined a trending process, a long-term event log is started au-
tomatically. 

If you wish to have the long-term event log without trending any data, define 
a trend without any channels in it. A daily limit of 1000 events can be stored in 
the trend log.

Table 8.18:  Trend Accumulation Modes:

Damped (default) Logs a value representative of the measurements dur-
ing the interval.

Undamped Logs the last value measured during the interval.

Avg Logs the average measured value over the interval.

Min Logs the minimum measured value over the interval.

Max Logs the maximum measured value over the interval.
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8.17 Printing

Printing a 
Configuration

Figure 8.25: Print a Configuration

Generate a Configuration print at any time by selecting Print Settings from the 
File menu. The printed output follows the same general layout as the Element 
Tree. Where applicable, the settings are given in secondary units. The excep-
tion is the Fault Location parameters which are given in primary units.

You can preview the printed output by selecting Print Preview from the File 
menu.

Print Config function is also available under the Config menu.

Printing a 
SCADA 
Address List

MODBUS

The MODBUS address equivalents shows all of the functions defined in the 
TESLA LITE recorder (see “Modbus Functions” in Appendix D). Selecting 
the Print MODBUS settings item from the File menu generates a listing that is 
configurable - listing the full function names in Element-Function-Description 
format along with the equivalent MODBUS addresses.

You can preview the printed output by selecting Print MODBUS Preview from 
the File menu.

Print MODBUS function is also available under the Config menu.

DNP

The DNP point list shows all of the functions defined in the TESLA LITE re-
corder, (see “DNP3 Device Profile” in Appendix E) Selecting the Print DNP 
settings item from the File menu generates a listing that is configurable - listing 
the full function names in Element-Function-Description format along with the 
equivalent DNP points.



8 Configuring the Recorder
You can preview the printed output by selecting Print DNP Preview from the 
File menu.

Print DNP function is also available under the Config menu.
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9 Record and Log Management

9.1 Records
The Record management services are available from the Records tab, accessi-
ble from the Main Menu.

Figure 9.1:  Record Listing 

Record Lists The left side of the Records tab shows lists of records for the current IED or-
ganized by date. Expanding a date entry shows On IED and Local headings. 
Records presently on the recorder are shown under the On IED heading. Re-
cords that have been previously transferred to TESLA Control Panel are shown 
under the Local heading.  Records on the IED that have not been transferred to 
Control Panel are shown in bold-face. If working offline, only local records are 
shown.

Record Filter The list of records displayed is controlled by the Record Filter control. The fil-
ter applies to both On IED and Local record lists. The time taken to access the 
directory can be controlled by selecting an appropriate number of records in 
the Record Filter.

Note that if additional recordings are created through the Trigger Fault, Trig-
ger Swing or Trigger Both buttons, these new records do not displace the ear-
liest fetch/displayed file records in the tree.

Record timestamps are received from the recorder are in UTC and 
are converted to local time using the Time Zone and Daylight Saving 
settings of the computer running TESLA Control Panel
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9 Record and Log Management
Record 
Summary

The right side of the Records tab shows summary information on the selected 
record. The summary includes the list of events which occurred during the 
time-span of the record from the recorder’s event log.

For cooperative group records, the event list cannot be displayed until the re-
cords have been transferred to TESLA Control Panel and combined.

Get Remote 
Summaries/Get 
Remote Events

When both Get Remote Summaries and Get Remote Events options are 
checked, Control Panel accesses and displays the corresponding recording in-
formation in the Record Summary and Events sections of the right-hand pane. 
You may eliminate the delay involved in accessing this information by dis-
abling the corresponding check-boxes.

Autopoll/
Autoprint

When Autopoll is checked, Control Panel will periodically (default 60 seconds) 
poll the connected TESLA LITE recorder for new record files and automati-
cally transfer them to the local computer. Newest records will be transferred 
first, and only one new record will be transferred at each poll. Checking Auto-
print will cause each transferred (via Autopoll) record file to be automatically 
printed on the default Windows printer using RecordGraph’s default template. 

Note that the Autopoll and Autoprint states are not persistent; if Control Panel 
is disconnected from the recorder, both Autopoll and Autoprint become un-
checked.

Autopoll and Autoprint are also disabled when the Records screen is closed.

Graph Records can be viewed with RecordGraph, ERLPhase’s interactive graphing 
software. To launch RecordGraph, select one or more local records and select 
the Graph button.

Get from IED Selecting a recorder file under On IED and then selecting the Get from IED 
button causes a record file on the IED to be transferred from the recorder to 
your local computer. More than one file can be transferred at the time using 
Windows file selection function (Control/Shift + left-click). This action will 
not delete the record on the IED.

Get from IED 
and Delete

The Get From IED and Delete button erases the records on the recorder after 
they have been transferred to Control Panel and verified.

When connected to a cooperative group, Get From IED automatically transfers 
the corresponding record from each group member and combines them into a 
single group record (“Record Export Utility” on page 11-1). 

Save As Selecting a local record and selecting the Save As button copies a record to a 
specified file. The .tlr file suffix should be retained. 

Export Selecting a local record and selecting the Export button launches the Export 
Utility. Records can be exported in common formats such as COMTRADE for 
use in other software or playback, “Record Export Utility” on page 11-1.
9-2 TESLA LITE User Manual  D03283R01.02



9 Record and Log Management
Delete The Delete button can be used to delete records on the IED or locally. More 
than one file can be deleted at a time using Windows file selection functions 
(Ctrl/Shift + left-click).

Rename Select Rename to allow a local record file to be renamed.  Records on the re-
corder cannot be renamed.

Refresh Selecting Refresh updates the Recordings screen. It checks the local directory 
and the remote IED (if connected) for new and stored files, updates Control 
Panel’s records database and refreshes the screen.

Trigger Fault/
Swing/Both 

The recorder can be manually triggered to generate different types of records. 
Trigger Fault creates a high speed transient recording.  Trigger Swing creates 
a low speed swing recording.  Trigger Both creates a combined record.

Note the Swing records may take up to 15 minutes to generate depending on 
the recorder’s settings.

Recordings on 
IED

Shows the number of records stored on the recorder and percentage of record-
ing space used.

File>Select 
Remote

This function is available through the On IED menu. If you are online with 
your TESLA LITE, this function selects all of the recording files displayed in 
the record list that have not yet been transferred to your local Recordings di-
rectory. You may then perform whatever command is appropriate for the se-
lection set, such as a Get from IED or a Get and Delete from IED Command. 
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9 Record and Log Management
9.2 Trend Log
The trend manager services are available from the Trend item, accessible from 
the Main Menu.

Figure 9.2: Trend Listing

Range of Dates Set the time range using the two date control boxes, From and To. The initial 
setting is for the previous three days. When you change these settings, the re-
mainder of the display updates to show data pertinent to your chosen period. If 
you are connected to a TESLA LITE, both local and remote data are combined 
in the tree; otherwise, the display shows only data resident on your local com-
puter.

Trended 
Channel

The tree on the left side of the screen shows the channel names of the trended 
data available for the period you have selected. You may select any number of 
channels from the tree for further operations.

Select more than one channel by using the Ctrl and Shift keys in conjunction 
with mouse clicks and arrow keys.

Trend Summary The Trend Summary section of the screen shows statistical information about 
the files you have selected. Local Files indicates the amount of space used by 
the selected trend files on your local computer. Remote Files indicates the 
amount of space used by the selected trend files on the IED. Transfer refers to 
files that are on the IED, but not on your local computer, and represents the to-
tal amount of bytes in stored trend files that would be transferred before further 
processing takes place.
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9 Record and Log Management
Events The Events section of the display shows all the events recorded during the pe-
riod of interest set with the range of dates

Get, Get/Delete When you click Get all of the trends not previously transferred are transferred 
to your computer. If you select Get/Delete, all files successfully transferred 
from the IED will also be deleted from the IED.

Graph The trend data selected in the Trended Channels list is viewed with Record-
Graph, ERLPhase’s interactive graphing software, see “Graphing Records” on 
page 10-1. Any selected trend data not already in your computer is transferred 
prior to graphing.

Delete The trend data selected in the Trend Channel list is removed from your com-
puter. If you are currently connected, you have the option of removing the data 
on the IED  files as well.

Get Events Each time you change the Range of Dates, the list of events on the right side of 
the screen is updated. If you are not interested in this action, remove the check 
mark from the checkbox.

Today’s Trends If the Range of Dates includes data that is currently being recorded, some of 
the data may not be in a form suitable for transfer to Control Panel. If this 
checkbox is selected, Control Panel will send a request to the IED to convert 
the most recent data so that it can be transferred. The time that this takes may 
be significant, and if you do not have a need for this data, the feature may be 
disabled by removing the check mark from the check box.

Print Events The list of events in the Events portion of your screen is printed.
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9 Record and Log Management
9.3 Event Log
The event log services are available from the Events tab, accessible from the 
Main Menu.

Figure 9.3:  Event Log Display

The recorder maintains a log of time-stamped events. Event messages can be 
produced by any of the recorder’s detectors if configured to do so.

Circular 
Storage

The Event Log stores up to 250 events with automatic overwrite of the oldest 
event. For greater event storage, or to prevent automatic overwrite, the record-
er’s trending function can also be used to store event messages.

Event 
Messages

The text of an event message is derived from the configuration of the detector 
that generates it.

The general format for event message is:

Date Time ElementName.Type.Description Detector State

where:

   •  ElementName is the user-assigned name of the element associated with this 
channel

   •  ChannelType describes the member of the element or the type of channel 
which the detector is monitoring

   •  Description is user-assigned text available to further identify the detector

   •  Detector is the type of detector

Event messages can also be viewed in the Record Summary and 
Trend Summary displays
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9 Record and Log Management
   •  State indicates whether the detector is picking up or dropping out. In the 
case of external inputs this text is user-assigned to accommodate different 
external devices.

Example of an event message from an External Input detector 

2005 Jan 12 20:44:33.672 Line #1.EI.BRKRI-a open

Example of an event message from a high analog level detector: 

2005 Jan 12 20:44:33.650 Line #1.Va.High Mag active

Printing Event 
Log

You may print or copy to clipboard all the events that are in the Event Log. 
Right-click or choose from the menu bar to print event logs while connected to 
the IED.

Controls The event display is a static snapshot of the contents of the event log.

You can use the buttons at the bottom or a right-click to access these functions. 
In addition, print commands are available under the File menu, a copy com-
mand is available under the Edit menu, and a refresh command is available un-
der the View menu.

Table 9.19:  

Copy Copies the event list to clipboard for pasting to other programs,

Refresh Updates Event List by getting a new list from remote IED and updates 
the Event List screen.

Erase Removes all events from remote IED.

Print (bottom button only) Prints all the events (up to 250 events) to a local 
printer.
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10 Graphing Records

10.1 Getting Started
RecordGraph is a tool used to display and analyze records from ERLPhase re-
lays and recorders. Use it to graphically view the data recorded during fault, 
swing and trend modes. RecordGraph is integrated with TESLA Control Panel.

Launch 
RecordGraph 
from TESLA 
Control Panel

Method 1: Records

1. Open TESLA Control Panel by double-clicking on the TESLA icon on your 
desktop. If the application is not installed, install the application and then 
proceed.

2. Double-click on the Records item in the tree list or select Records and use 
the Enter key. 

3. Using the Records tab, select a local record from the tree list.

4. Click the Graph button.

Figure 10.1:  Launching RecordGraph from TESLA Control Panel

When the Graph button is clicked from the TESLA Control Panel, Record-
Graph is launched with the selected record.

In the Records tab, select 
a local record from the tree list. Click on Graph button to launch 

RecordGraph. 

Double-click Records 
or use Enter key.
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10 Graphing Records
Method 2: Auto Print

If the Auto Print option is checked (enabled) in the Records list view, then Re-
cordGraph will be automatically launched and prints the channels directly on 
to the Default printer. The layout and channel information is predefined in the 
<Default> or User-defined template.

Method 3: Trends

1. Double-click Trends from the Main Menu.

2. Select the record from the list. To select multiple records, press Ctrl key and 
click on the desired records.

3. Select the Graph button at bottom of screen.

Figure 10.2: Launch from Logging (Trends/Events)

Double-click Logging 

(Trends/Events) from 

Main Menu.
Select a record.

Click the Graph button.

RecordGraph Window
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10 Graphing Records
Launch 
RecordGraph 
from Windows 
Explorer

1. Open Windows Explorer.

2. Select a record. (It should have valid extensions, *.lpr, *.lpl, *.tpr, *.tpt, *.tlr, 
*.bpr, *.bpl, *.fpr.)

3. Right-click the selected record.

4. Choose, the RecordBaseView>Launch Graph option.

Figure 10.3: Launching RecordGraph from Windows Explorer

Select a record (should have
valid extensions: *.lpr, *.lpl, 
*.tpr, *.tpt, *.tlr, *.bpr,*.fpr). 

Right-clicking on the record 
brings up the context menu 
with the RecordBase View 
item.
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10 Graphing Records
 RecordGraph 
Components

   •  Main menu items

   •  Tool bar buttons

   •  A drop-down box lists the templates associated with the current record’s 
IED

   •  A left-hand side pane (LHS) or tree view lists the names of records to be 
displayed or analysed

   •  A right-hand side pane (RHS) displays the graphs in various views. Initially 
a single blank screen appears.

   •  A right-click context menu on both the LHS and RHS panes.

   •  RecordGraph version is displayed in the Help>About RecordGraph.

Figure 10.4: Components of RecordGraph Window

LHS pane 

(Tree View) 

lists records

RHS Pane shows graphic display

Template List

Tool Bar

Main Menu
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Menus

Figure 10.5: Menus

Set Graphs Per Page
Add Analog Graph
Add Digital Graph
Delete Graph
Move
Copy Trace
Paste Trace
Delete All Traces
Copy Trace Data to 
  Clipboard
Change Trace Color...
Active Trace Information...

Save Template
Save Template As...
Template Manager...
Print...
Print Direct
Print All
Print Preview...
Export...
Delete
Show Record Summary.
Import...
Exit

RecordGraph
File     View     Graph     Measure     Scale     Options     Help

File

View
Add...
Delete
Rename Tab
Titles...
Copy to Clipboard
Save as Metafile...
Show Channel List
Line
Toolbar

Graph

Measure
Markers
CrossHairs
Primary
Secondary
Time Alignment
Absolute Time
Fundamental RMS
True RMS
Harmonics
Symmetrical Components

Scale
Zoom X Axis +
Zoom X Axis -
Zoom Y Axis +
Zoom Y Axis -
Undo Zoom
Reset Zoom
Change Scale (Y-Axis)

Options
Calculate Derived Channels Now...
Show Grid
Show X Axis Ticks
Show Legends
Show Trigger Markers
Lock Markers
Extend Print Range
Set Phase Colors...
Set Precision

Help
User Manual
About RecordGraph...
Show Hotkeys...
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10 Graphing Records
10.2 RecordGraph Menu Items

File Menus File>Save Template

Figure 10.6: Save Template

Use this option to save the current graphical layout information to a file (see 
“Templates” on page 10-56 for further explanations on templates and their role 
in graphical analysis).

When this option is chosen and if there are no templates in the template list, 
then a Save As Template dialog box is displayed. Otherwise, the current layout 
information is saved in a file as shown in the template list box.

File>Save Template As…

Figure 10.7: Save Template As
10-6 TESLA LITE User Manual  D03283R01.02



10 Graphing Records
Save the current graphical layout information in a different file. A dialog box 
is displayed to choose the template file name. The check box, save as default 
template, if checked, saves the current template as a user-defined default tem-
plate (see “Templates” on page 10-56).

File>Template Manager

Figure 10.8: Template Manager

Rename, duplicate, save as, import or delete template files. A dialog box is dis-
played to manage the template files (see “Templates” on page 10-56).

File>Print

Figure 10.9: Print
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10 Graphing Records
Print the active (visible) view. Use this option to select the type of the printer 
and other configurations associated with it through the standard print dialog 
box options.

File>Print Direct

Figure 10.10: Print Direct

Send the active view directly to the default printer. When this option is chosen, 
the standard print dialog box is not displayed. The active view is sent directly 
to the default printer for printing, but you can cancel the printing if the print 
status dialog box is displayed.

File>Print All

Figure 10.11: Print All

Send all the pages of all the views to the default printer. Select this option to 
print multiple views (visible and invisible) to the default printer. 

Multiple Views
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10 Graphing Records
File>Print Preview

Figure 10.12: Print Preview

Display the print preview window of the active view page.

File>Export

Figure 10.13: Export

Export the selected record to a user-defined format, “Record Export Utility” on 
page 11-1.

File>Delete

Delete the currently selected record from the tree view. This option does not 
clear the view associated with the record.
D03283R01.02 TESLA LITE User Manual 10-9
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File>Show Record Summary

Figure 10.14: Show Record Summary

Display the record summary and the event list of the active record in a dialog 
box.

File>Import

Figure 10.15: Import

Choose this option to import a COMTRADE file and display a standard open 
file dialog box to select *.cfg COMTRADE files.

File>Exit

Exit the RecordGraph application. Save your graphical layout information be-
fore selecting this option.
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View Menus View>Add

Create a new view and add it to the existing layout (see “Views” on page 10-
32).

View>Delete

Figure 10.16: Delete

Delete an active view from the layout. When you select this option, a dialog 
box appears to confirm the deletion of the view. If accepted, the current view 
is deleted from the layout.

View>Rename Tab

Figure 10.17: Rename Tab

Replaces the name on the active view tab with one of your choices. A dialog 
box appears to enter the name.

Renames this tab
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10 Graphing Records
View>Titles

Figure 10.18: Titles

Select graph and view titles options to compile titles and various options (see 
“View and Graph Titles” on page 10-62).

View>Copy to Clipboard

Copy an active view to the clipboard for import to another program such as MS 
Word or Excel, “Record Export Utility” on page 11-1.

View>Save As Metafile

Save an active view page as a Windows metafile, see “Record Export Utility” 
on page 11-1.
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10 Graphing Records
View>Show Channel List

Figure 10.19: Show Channel List

Hide or show the channel list displayed in the tree view.

View>Line

Figure 10.20: Line

Place a reference line on the graph (for Impedance and Differential views on-
ly). Use Line in conjunction with the CrossHair measurement for quick read-
outs. When you choose this option free form zooming is disabled. Clear the 
line to enable free form zooming.

View > Tool Bar

Show or hide tool bar from the main window.
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Graph Menus Graph>Set Graphs Per Page

Figure 10.21: Set Graphs Per Page

Set up the number of graphs per view; up to eight graphs are allowed using the 
Set Graphs Per Page option. Timeline, Overlay and Trend Views allow a max-
imum of 36 graphs. Use Add Analog Graph or the Insert key to add one graph 
at a time.

Graph>Add Analog Graph

Figure 10.22: Add Analog Graph

Add an analog graph to the existing view or use the Insert key.
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10 Graphing Records
Graph>Add Digital Graph

Figure 10.23: Add Digital Graph

Add a digital graph to the existing view. This graph shows the digital status in-
formation in the form of thick or thin stacked traces. You can plot up to 32 trac-
es in a single graph.

Graph>Delete Graph

Figure 10.24: Delete Graph

Delete an active graph (click any graph to make it active) from the existing 
view or use the Delete key.
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10 Graphing Records
Graph>Move

Figure 10.25: Move

Rearrange the relative position of the graphs in the active view page. First se-
lect the graph and use either the Move>Up or Move>Down option to change 
the position of the graph. 

Graph>Copy Trace

Figure 10.26: Copy Trace

Copy an active trace from the selected graph. Use this option in conjunction 
with the paste trace option. You need at least one channel on a graph to use the 
copy operation.

Copies this trace
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Graph>Paste Trace

Figure 10.27: Paste Trace

Add or replace an existing trace in the selected graph. In Timeline View an an-
alog graph supports one trace per graph. In an Overlay View you can select up 
to 32 traces per graph. If you use the paste operation in Timeline View, and if 
the graph has a trace, it is replaced with the one just copied or adds the trace if 
there is no trace. In Overlay View it adds the trace to the existing graph.

Graph>Delete Trace

Figure 10.28: Delete Trace

Select a graph and the trace to be deleted and use Delete Trace to delete from 
the active graph. In the case of Overlay View a graph can have multiple traces. 
You can select a trace by clicking on the channel name and use delete trace op-
tion to delete the selected trace. 

Trace copied

Trace pasted

Delete Trace removes 
this trace from the graph
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Graph>Delete All Traces

Figure 10.29: Delete All Traces

Deletes all the traces from the active graph. In an Overlay view this action re-
moves all the traces.

Graph>Copy Trace Data to Clipboard

Copy trace data from the active graph to the clipboard (see “Exporting Channel 
Data” on page 10-73).

Graph>Change Trace Color

Figure 10.30: Change Trace Color

Change the trace color of the selected trace. In the Overlay View this option 
only changes the color of the active trace.

All traces are removed 
from the graph

Color of this trace is changed
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Graph>Active Trace Information

Figure 10.31: Active Trace Information

Display the trace information of the active graph.

Measure Menus Measure>Markers

Figure 10.32: Markers

Set or clear markers X and O on all graphs in the active view. If the markers 
are out of range, double-click the time axis to bring them back into the view. 
When markers are placed, depending on the type of measurements option, 
readouts appear on the right hand side as shown corresponding to the positions 
of X and O markers. In case of multiple traces, the readout refers to the current-
ly active (selected) trace. 

Amplitude readouts 
corresponding to X & O

Time display corresponding 
to X & O
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Measure>CrossHair

Figure 10.33: CrossHair

Set or clear crosshair cursor measurement by dragging the mouse (left-click 
and move) anywhere on the graph to display the readout. The difference be-
tween the marker and crosshair readout is that the marker values correspond to 
the data values, whereas the crosshair measurement corresponds to the x and y 
coordinates. When this option is selected, you can measure coordinates of any 
graph in the active view.

Measure>Primary

Figure 10.34: Primary

Set scale to primary values (depending on the scale factors CT/PT ratios) on all 
the graphs in the currently active view. The current choice (primary or second-
ary) is displayed on the status bar.

CrossHair 
measurements

Primary Scale
10-20 TESLA LITE User Manual  D03283R01.02



10 Graphing Records
Measure>Secondary

Figure 10.35: Secondary

Set scale to secondary values (depending on the scale factor of CT/PT ratios) 
on all the graphs in the currently active view. The current choice (primary or 
secondary) is displayed on the status bar.

Measure>Time Alignment

Offset X axis (trigger time alignment) for the currently active trace on the 
graph (see “Readouts and Measurements” on page 10-64).

Measure>Absolute Time

Display absolute time (actual recorded time) measurements for the active trace 
of the graph (see “Readouts and Measurements” on page 10-64).

Measure>Fundamental RMS

Display fundamental rms measurement for the active trace of the graph (see 
“Readouts and Measurements” on page 10-64).

Measure>True RMS

Display true rms measurement for the active trace of the graph (see “Readouts 
and Measurements” on page 10-64).

Measure>Harmonics

Display harmonics measurement – up to 5th order and THD expressed in per-
cent with reference to the fundamental (the highest order harmonic included in 
THD depends on the sample rate). See tables 7.1 and 7.2 on page 7-6) for the 
active trace of the graph (see “Readouts and Measurements” on page 10-64).

Secondary Scale
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Measure>Symmetrical Components

Display symmetrical components measurement for the active graph. You must 
select a, b and c phase quantities in Overlay View to enable this option (see 
“Readouts and Measurements” on page 10-64).

Scale Menus Scale>Zoom X Axis +

Figure 10.36: Zoom X Axis +

Select this option to decrease the x axis range by 25% of the current zoom 
range.

Scale>Zoom X Axis -

Figure 10.37: Zoom X Axis -

Select this option to decrease the x axis range by 25% of the current zoom 
range.
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Scale>Zoom Y Axis +

Figure 10.38: Zoom Y Axis +

Select this option to decrease the y axis range by 25% of the current zoom 
range.

Scale>Zoom Y Axis -

Figure 10.39: Zoom Y Axis -

Select this option to increase the y axis range by 25% of the current zoom 
range.
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Scale>Undo Zoom

Figure 10.40: Undo Zoom

Display the previous zoom level.

Scale>Reset Zoom

Figure 10.41: Reset Zoom

Reset the graphs to the initial zoom level.

Reset zoom levels
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Scale>Change Scale (Y Axis)

Figure 10.42: Change Scale (Y Axis)

Change Y axis to a desired minimum and maximum value using the dialog box 
to set the new values. If the manual scale option is checked, the y axis is not 
rescaled to new data values; the trace is displayed within the selected range. 
You can set the desired scaling, save the options in the template and recall the 
template for other recordings (see “Templates” on page 10-56).
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Options Menus Options>Calculate Derived Channels Now

Use this option to calculate the derived channels and append to the record as 
virtual channels. For TESLA LITE records the data is written back to the orig-
inal record so that the next time the record is viewed all the derived channel 
information is readily available (see “Calculated Channels” on page 10-71).

Options>Show Grid

Figure 10.43: Show Grid

Turn grid on or off on all graphs.

Options>Show X Axis Ticks

Figure 10.44: Show X Axis Ticks

Show X axis ticks on all graphs.
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Options>Show Legends

Figure 10.45: Show Legends

Show or hide legends on all the graphs.

Options>Show Trigger Marker

Figure 10.46: Show Trigger Marker

Show or hide trigger marker on the active graph and active curve.
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Options>Lock Markers

Figure 10.47: Lock Markers

Lock or unlock X and O markers.

Options>Extend Print Range

Figure 10.48: Extend Print Range

Print all the channels of the view for the entire data range in the current zoom 
level.

X and O markers 
are locked

Entire data is printed in multiple 
pages at the current zoom level
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Options>Set Phase Colors

Figure 10.49: Set Phase Colors

Use this option to select user-defined colors for A, B and C phase voltages and 
currents. When the colors are selected, the channels are automatically identi-
fied based on the color. The default values for A, B and C phase quantities are 
red, blue and green respectively.

Options>Set Precision

Figure 10.50: Set Precision

Set the precision (number of decimal places) for the readouts. In Symmetrical 
Component and Harmonic Views, the phase angle readout precision is always 
zero (no decimal places are used).

These readouts have 
4 decimal places
D03283R01.02 TESLA LITE User Manual 10-29



10 Graphing Records
Help Menus Help>User Manual

Select to display an electronic version of the user manual.

Help>About RecordGraph

Display program information, version number and copyright.

Help>Show Hot Keys

Lists the available hot keys or short cuts.

Tool Bar 
Buttons

Figure 10.51: Tool Bar Buttons

In the Tree View, you can expand a loaded record to identify the recorded and 
calculated channels (if configured). A right-click menu is available to manip-
ulate the tree items. Most of the tool bar buttons work in a similar way to that 
of the menu items explained in the previous sections.

RecordGraph

File View Graph Measure Scale Options Help

<Default>

Save Template

Show Record Summary

Export...

Print

Add a View

Titles

Add Digital Graph

Add Analog Graph

Set Graphs Per Page

Show/Hide Trigger Marker

Markers

Move Graph Down

Move Graph Up

Zoom X Axis +

Zoom X Axis -

Time Alignment

Zoom Y Axis +

Zoom Y Axis -

Reset Zoom

Show/Hide Legends 

Trace Information

Show/Hide Tree View (Channel List)

Paste Trace

Copy Trace

Change Scale (Y-Axis)

Increase Left Margin

Decrease Left Margin

Line

CrossHair

Recorder Data and Impedance Options

Delete Graph
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Table 10.20:  Tool Bar Buttons

Save Template Save template file on the disk.

Show Record Summary Displays record summary (events, trigger time, etc.)

Export Brings up export module.

Print Prints record.

Add a View Adds a graph view that displays the fault information.

Titles Places a title above graph for all views (see Figure 10.88: View 
Title Options).

Impedance Creates an R-X plot before, during and after fault.

Markers Displays vertical lines "x" and "o" to find the coordinate values 
on the graph.

Show/Hide Trigger Marker Displays/hides zero trigger marker.

Set Graphs Per Page Sets number of graphs per page.

Add Analog Graph Add an analog graph.

Add Digital Graph Add a digital graph.

Delete Delete a graph.

Zoom X Axis + Enlarges the trace range on X axis.

Zoom X Axis - Reduces the trace range on X axis.

Zoom Y Axis + Enlarges the trace range on Y axis.

Zoom Y Axis - Reduces the trace range on Y axis.

Reset Zoom Resets zoom control.

Move Graph Up Vertically moves graph upwards.

Move Graph Down Vertically moves graph downwards.

Time Alignment Offset X axis time value. 

Change Scale (Y Axis) Scale Y axis minimum and maximum range.

CrossHair Displays X and Y coordinate values.

Line Available only for impedance view, draws a reference line.

Copy Trace Copies a trace to another location.

Paste Trace Pastes a trace.

Show/Hide Legends Displays/hides legends the traces. 

Trace Information Displays/hides channel information: Date, Station Name, 
RecordName, Channel Name.

Show/Hide Tree View 
Channel List

Expands and minimizes RHS of the screen.

Decrease Left Margin Decreases left margin.

Decrease Right Margin Decreases right margin.
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10 Graphing Records
10.3 Views 
The view screen graphically displays information from the record. A view is 
associated with a tab at the bottom of the screen which can be renamed using 
the Rename tab. You can create a maximum of 30 view tabs.

 Add a View Add new view to layout.

1. Select the View>Add... from the top menu bar or the Add... button from the 
tool bar.

2. Select the desired view from the shortcut menu.

3. Click OK.

Figure 10.52: Add a View

Delete a View Clears active view from layout.

1. Select the View>Delete from top menu bar. A shortcut menu asks you to con-
firm the deletion. 

2. Click OK to confirm. Click Cancel to stop deletion.

The Add View… option lists Impedance View only if the selected 
record is from an L-PRO, TESLA or COMTRADE record.

Select View>Add... or 

click the Add button 

to create a view type.

Select desired view 

and select OK.

View Tabs
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Rename a View Use this option to rename the active tab which is displayed at the bottom of the 
view.

1. Select the View>Rename Tab from top menu bar or right-click on the graph 
to bring up the context menu and select Rename Tab.

2. A dialog box appears with the old name. Modify and click OK to rename the 
view.

Figure 10.53: Rename Dialog Box

Show Channel 
List

Displays or hides the channel list on the left-hand side of the screen to allow 
more space for the graphs.

Toolbar Displays or hides the toolbar on the left-hand side of the screen to allow more 
space for the graphs.
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10.4 Graphs
The graph is an area or space in a view where each channel of analog or digital 
information is shown. The information is shown as X-Y data with X = time and 
Y = magnitude. 

Adding Graphs 1. Select Graph>Set Graphs Per Page or right-click on the graph to bring up 
the context menu and select Set Graphs Per Page to add selected number 
of graphs to the Timeline View.

2. Select Graph>Add Analog Graph or right-click on the graph to bring up the 
context menu and select Add Analog Graph to add an analog graph to the 
Timeline View.

3. Select Graph>Add Digital Graph or right-click on the graph to bring up the 
context menu and select Add Digital Graph to add an digital graph to the 
Timeline View.

Adding 
Channels

1. Click the desired channel to be displayed on the graph.

OR

2. Drag a channel and drop it onto the desired graph.

3. Depending on the view type following action takes place:

   •  In a Timeline View the existing channel is replaced and only one channel 
is allowed per graph.

   •  In an Overlay View up to 32 traces can be placed per graph.

   •  In a Trend View the existing channel is replaced and only one channel is 
allowed per graph.

   •  External or digital channel should be placed on a digital graph to stack the 
traces. A maximum of 32 traces can be specified per graph.

Channel Tool-
tip

When the cursor is moved over the channel name, following information is dis-
played in the tool-tip window.

   •  Device – name of the device (example, TESLA LITE)

   •  Record – name of the record

   •  Channel – name of the channel

   •  Max – channel maximum value along with the unit 

   •  Min – channel minimum value along with the unit

   •  X – Offset-whether the x-axis has offset (time alignment)

   •  Samples – number of samples 

   •  Sample rate –samples /second

   •  IRIG-B status indicator
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Figure 10.54: Tool-Tip

Zoom Using the 
Mouse

1. Left-click on any graph and drag to form a small box around the graph area.

2. When you release the mouse, the trace assumes new zoom position deter-
mined by the area of the zoom coordinates. 

Figure 10.55: Select a Section of the Graph to Zoom

Tool-tip window

Drag a box around the 

graph area to be 

zoomed.
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Figure 10.56: Portion of Zoomed Graph

Follow the procedure 1 and 2 for further zooming.

Zoom Using the 
Tool Buttons

You can also use Zoom X axis +, Zoom X axis -, Zoom Y axis + and Zoom Y 
axis - on the tool bar buttons to quick zoom in and zoom out (25%).

Repeat step 1 to zoom further.

Zoom only X or 
Y Axis

To zoom only the X axis, select Ctrl key and use the mouse to draw a box on 
the graph.

To zoom only the Y axis, select shift key down and use mouse to draw a box 
on the graph.

Undo Zoom on 
Graphs

1. Right-click on the graph to the context menu.

2. Select the UndoZoom option.

3. Graphs are redrawn to the previous zoom level.

4. Select Reset Zoom option to reset the graphs to the initial zoom level. This 
can be chosen at any stage.
10-36 TESLA LITE User Manual  D03283R01.02



10 Graphing Records
Pan Graph Zoom the graph (if not zoomed) to a required zoom level.

You should hold the “Thumb track” and move it along the scroll bar. To have 
fine control click on the right arrow scroll bar button or press Shift and click on 
the right arrow scroll button.

Figure 10.57: Thumb Track

Keyboard 
Functions

The keyboard is also available for zooming, setting markers and positioning 
graphs. To display the keyboard hot key menu right-click on the graph and 
bring up the context menu, select Show Hotkeys option.

Figure 10.58: Hot Keys

Thumb Track - move right/left to pan graph
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Right-click 
Context Menu

Figure 10.59: Right-Click Context Menu
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Timeline View

Figure 10.60: Timeline View

   •  Timeline View is designed to “stack” channels and has single time line axis 
common for all the graphs. 

   •  Each analog graph in this view can hold only one trace. 

   •  Each digital graph in this view can hold 32 traces (8 traces are preferred). 

   •  Selecting a channel from the LHS tree view while the same graph is active 
replaces the existing channel with the currently selected one. 

   •  A maximum of 32 graphs (analog and digital) can be added per view. 

   •  You can mix and match channels from different records and/or IEDs. 

   •  Time line view displays read-out (if markers are on) on the RHS and chan-
nel information on its LHS. 

   •  Read-out corresponds to the currently selected channel type and the scale 
(primary/secondary) which is displayed on the status bar. 

Channel Information

Tool Tip

Record Information

Read-out Markers
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Overlay View

Figure 10.61: Overlay View

   •  Overlay View is designed to “overlay” channels and has single time line 
common axis for all the graphs. 

   •  Each analog graph in a overlay view can hold 32 traces (3 traces are pre-
ferred). 

   •  Each digital graph in this view can hold 32 traces (8 traces are preferred). 

   •  Selecting a channel from the LHS tree view while the same graph is active 
overlays the channel on the selected graph. 

   •  A maximum of 32 graphs can be added per view. 

   •  You can mix and match channels from different records and/or IEDs. Time 
line view displays read-out (if markers are on) on the RHS and channel in-
formation on its LHS. 

   •  Read-out corresponds to the currently selected channel type and the scale 
(primary/secondary) which is displayed on the status bar. 

Channel Information
Record Information
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s

t

Symcom View

Figure 10.62: Symcom View

   •  Symcom View is designed to analyse symmetrical components of voltage 
or current channels.

   •  You must load 3 voltage or current channels to view the components and 
associated phasor plots from the same record.

   •  The view displays: analog channels, positive, negative, zero sequence 
phasors and corresponding table which contains numerical values of these 
components and phase angle.

   •  All the components are calculated in rms values.

   •  Channel instantaneous values are displayed on the RHS of the analog 
graph.

   •  Markers are permanently set on the graph one-cycle apart.

   •  Grab the marker and move (on the time line axis) to display new set of com-
ponents and phasor values.

A, B, C Phase Analog Channel

Phasor and Symmetrical

Component Graph

Diplay of Phases (A, B, C)

Channel Names

Record Title

Markers locked one cycle apar

Time Display

Instantaneous Channel 

Amplitude Display
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rt
Harmonic View

Figure 10.63: Harmonic View

   •  Harmonic View is designed to analyse harmonics associated with analog 
channels. In order to view harmonics, markers should be enabled by select-
ing Measure>Markers.

   •  A maximum of 3 traces can be analysed per view.

   •  The view displays: analog channels, a bar graph of harmonics and a table 
which contains rms values of the harmonics with phase angle.

   •  The harmonics (order) displayed is as selected on the input channel. This 
can be up to the 25th harmonic if desired and selected.

   •  Channel instantaneous values are displayed on the RHS of the analog 
graph.

   •  Markers are permanently set on the graph one-cycle apart.

   •  Grab the marker and move (on the time line axis) to display a new set of 
harmonics.

All harmonic phase angles are referenced with respect to A-phase 
voltage in a configured channel in TESLA recorder. For COMTRADE 
records the first A-phase voltage is considered as the reference 
phase.

Analog Graph

Bar Graph of

Harmonics

Amplitude

Table displays

Harmonic Amplitude

with corresponding 

Phase Angles 

Channel Names

Record Title

Markers locked one cycle apa

Time Display

Instantaneous Channel

Amplitude
10-42 TESLA LITE User Manual  D03283R01.02



10 Graphing Records
Impedance 
View

Impedance View is an R-X plot. The R-X quantities are calculated over the en-
tire data range from the recorded analog voltage and current channels. R-X plot 
is useful in analyzing the performance of L-PRO relays and swing disturbances 
from the TESLA recorders. Since the information to be displayed involves 
time as a third dimension, this view provides meticulous cursor and zoom con-
trol over the data points being viewed. Optionally it supports superposition of 
the relay characteristics (Zone 1, Zone 2, Line, Blinders, etc.) from L-PRO re-
cords or files generated from any L-PRO Offliner settings program. 

The following table summarizes the types of channels from which impedance 
(R and X values) is derived along with the supported product. RecordGraph 
displays these channels on the left hand side in the tree view. Depending on the 
product, the following basic quantities are used the respective impedance chan-
nels.

In an impedance calculation, a threshold limit is used based on the fundamental 
rms value of the current to include or exclude the R and X values for plotting.  
For 1A CT model or unit, 0.02 A is the limit whereas for a 5A CT model or 
unit, 0.1 A is used as the limit. When the data is copied to the clipboard, the 
discarded values of R and X values are not exported.

To add an Impedance view select View>Add. or the Add a View tool bar but-
ton. From the dialog box select Impedance View.

Table 10.21:  

Sl. No. Channel Types Quantities Supported Products

1 High Speed (HS) Voltage and Current L-PRO, TESLA, 
COMTRADE

2 High Speed (HS) Positive Sequence Voltage 
and Current

TESLA

3 Low Speed (LS) Voltage and Current TESLA

4 Low Speed (LS) Watts, Vars and Voltage 
(Phase and Sequence)

L-PRO, TESLA

5 Low Speed (LS) Positive Sequence Voltage 
and Current

L-PRO, TESLA

6 Low Speed (LS) Impedance (Phase and 
Sequence)

L-PRO, TESLA
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Figure 10.64: View>Add> Impedance

When the Impedance View option is selected, the Impedance screen is dis-
played. The components and controls associated with this screen are described 
below.

Figure 10.65: Opening Impedance Screen

The Add View… dialog box lists the Impedance View only if the se-
lected record is from L-PRO or TESLA or COMTRADE records de-
pending on the record type.

(1) View Title 

(2) Basic channel names 
and derived impedance type 

(5) Time Window width 
and position control (4) Time Window 

(6) X and O markers 

(3) Graph Zoom control 
(x-y axis zooming) 
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Components and Controls

   •  A text component displays the title at the top of the Impedance View shown 
in Figure 10.65: Opening Impedance Screen. The title is compiled from 
items in the Title Options dialog box. Default title is the file name and trig-
ger event.

   •  The basic channel names are displayed below the title.

   •  The 4 zoom is controlled using the sliding control on the right side of the 
window. The R-X plot aspect ratio is maintained under all zooming tools. 
The graph zoom control offers a 10x zoom factor between minimum and 
maximum amplitude of the data (R and X coordinates). 

   •  The Time Window control provides a means to select the range of data for 
better presentation of R-X values. For example, if the voltage and current 
channels are recorded from 0.0 to 0.2 seconds with 1000 data points, using 
this control, you can choose to view only 0.1 second data (500 points). 

   •  Time window width and position control can be used for the precise data 
analysis. 

   •  Control the X and O markers.

Create Impedance View with an TESLA LITE Record

1. Launch RecordGraph with an TESLA LITE high speed (fault) record and 
expand the channels in the tree view. 

2. Create an Impedance View using View>Add… or use the tool bar option.

3. Select line voltages A, B and C, and corresponding line currents A, B and C 
from the tree view. Impedance (R and X) corresponding to Zab, Zbc and 
Zca phase-phase are calculated internally and displayed.

Figure 10.66: Create Impedance View with a TESLA LITE Record

Actual channel names 
(as selected from the 
tree view)

Phases of the  basic 
voltage and currents

Resolved impedance 
name

Time Window

Graph Zoom
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Each channel name is divided into three parts:

   •  The basic quantity (voltage or current) used in the calculation of the im-
pedance.

   •  The name of the actual channel selected.

   •  The resolved impedance name with the configuration (phase-phase or 
phase-ground).

The Time Window control shows the minimum and maximum time of the data 
viewed. In the above example, the full range data is viewed.

Use the graph zoom control to zoom the x and y axis.

Figure 10.67: Example of Graph Zoom Control

When you move the mouse near the edge of the Time Window control, the cur-
sor shape changes from normal arrow to two headed arrow as shown in the di-
agram. Now you can resize the thumb track to a desired level of data range. In 
the example, the data starts at position -0.200 and ends at (-0.200 + 1.383), 
where 1.383 is the width (total data range). Therefore, only small portion of the 
data can be viewed. 

The thumb track is moved 
from top to the position 
indicated and the traces 
are zoomed in.
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Figure 10.68: Example of Using Time Window Control

If you move the thumb track (not resize) to the extreme end, then the traces are 
rendered in the new data range.

Figure 10.69: Time Window Control Moved to New Location

Time Window control 
is resized to include 
only portion of the data

Time Window enlarged

Time Window control is 
moved to include 
different range of the data

Time Window enlarged
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In the above case, the data is included from range 0.007 to 0.007 + 1.176, 
where 1.176 is the data width. The 1.176 width remains same. If you resize the 
thumb track, then the width can be controlled; or you can double-click near the 
number 1.176 to get a dialog box to enter the data range precisely.

Figure 10.70: Indicate Data Range

A dialog box appears to enter the width or data range, which is indicated by the 
size of the thumb track. The scale indicates the step by which the data is incre-
mental. For example, when the spin control arrow is clicked (after closing the 
dialog box), if an up arrow is clicked, the data is incremental from present po-
sition to present position + 5%. On the other hand, if the down arrow is clicked, 
the data is decremented by 5%.

Example to Superimpose the L-PRO Relay Characteristics

Figure 10.71: Superimpose the L-PRO Relay Characteristics

A dialog box pops-up to enter
the width or data range
indicated by the size of the 
thumb track. The scale
indicates the step by which 
the data is incremented.

Click this button to 
apply L-PRO relay
characteristics through
the impedance options 
dialog box
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When you select the Relay data & impedance options button, a dialog box ap-
pears. The parameter required, such as k0 factor, the line sequence impedance 
values, the system voltage data and the other required information is initialized 
through this dialog box initialization. All these values are read from the set-
tings file opened through the impedance option dialog box.

In the Relay data and impedance options dialog box check the Zone 1 to Zone 
4 boxes and select the Apply button. All the four zone characteristics are super-

Table 10.22:  

Relay data and impedance options

L-PRO settings file Radio button to select relay characteristics from the current 
record. If an L-PRO record is selected, this button is enabled. 

Current record  If a TESLA LITE or COMTRADE record is selected, this button 
is enabled.

File Displays the settings file (full path name) from which the relay 
data is extracted to plot the impedance characteristics.

Browse Gives an option to select the settings file from any other location. 
The file type filter reads or selects only *.lps file type, if L-PRO 
setting file is selected.

Impedance Options Impedance configuration option includes a number of other 
options, such as, Phase-Phase, Phase-Neutral, radio button. 
Depending on this option and the type of channel, different 
impedance options (check buttons) are enabled.

Configuration Zpos (positive sequence impedance 3 phase basis).

Zan, Zbn or Zcn.

Zab, Zbc, or Zca.

Other Impedance

Z-Line Displays the line angle (can be checked or unchecked).

Z-Load Displays the coordinate of the load impedance (can be checked 
or unchecked).

Blinders Available only if the Phase-Phase option is chosen.

Directional Displays the directional characteristics.

Zones to display Phase-Ground or Phase-Phase.

Zone 1 to 4 Zone1-Zone4 displays the respective zones impedance charac-
teristics (can be checked or unchecked).

Apply Redraws the display with the currently selected options.

Launch Launches the setting file through the Offliner settings program. 
Note that the L-PRO Offliner setting program should be installed 
for this to work successfully.

Close Closes the dialog box.
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imposed on the calculated phase impedances (note that the characteristics are 
zoomed using free-form zoom to get a better resolution).

Figure 10.72: Example Superimposing the Zone Characteristics

In the above example phase-phase impedances Zab, Zbc and Zca are selected, 
indicated by a check mark, but only Zca is in the zoom range. 

All the four zones mho characteristics are superimposed. You can see that the 
Zca impedance has entered the Zone 2 and Zone 3. You can use a combination 
of zoom and time window control to analyze the precise time at which the im-
pedance enters the zones.

Figure 10.73: Example Showing the Line and Blinder Impedances

Check the Z-Line and Blinder boxes; then select the Apply button to superim-
pose the line and blinder impedances.

Line Impedance

Blinder Impedance
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Figure 10.74: Example Illustrating the Use of the CrossHair Measurement

Select the CrossHair button. When you drag the mouse (left button down and 
move) on any point on the trace, the R, X and the Z corresponding values are 
displayed.

You can move the cursor anywhere on the graph to get the measurement. When 
this feature is enabled, free form zooming is disabled; but you can use the 
graph zoom control to get a closer look at the trace.

Figure 10.75: Example of the Line Feature

Set a reference line to measure the data using the Line feature. This line is a 
reference line and not associated with the data values.

Select this button to 
enable CrossHair 
measurement feature

CrossHair 
measurements

Select this button to 
set an arbitrary line

Arbitrary line for the
reference purpose
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When the line option is enabled, the free form box zooming is disabled. Dis-
able the CrossHair measurement to resize and move the reference line; then en-
able the CrossHair option to measure the values. Select the line option again to 
remove the line from the graph.

Figure 10.76: Example of the Legends Feature

Use the legend feature to distinguish relay characteristics from the calculated 
impedances. You can move the legend box and resize to the desired level. You 
can hide the legend box by re-selecting the legend option again.

Figure 10.77: Legends Features Moved and Enlarged

Legend feature button

Legend box with all the 
relay characteristics 
impedance names

Resized legend box showing
all the relay characteristics 
impedance names
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Figure 10.78: Example Illustrating the Use of Data Markers

Select the marker option to set the markers. Select the desired channel name 
for the required measurement. For example, the channel associated with Zca is 
chosen (click this channel name for the selection). Move the marker by sliding 
it to the desired location. When you change the data range (using Time Win-
dow control), the cursors may disappear from the traces indicating that the 
markers are always associated with the data.

Figure 10.79: Example of TESLA LITE Swing Record Choosing Positive Sequence 
Voltage and Current

Select a TESLA LITE swing record and expand the channels. Click the posi-
tive sequence voltage and current; RecordGraph automatically calculates and 
displays the positive sequence impedance.

Cursor corresponding 
to marker O

Marker button

Cursor corresponding 
to marker X

Marker X and O Marker X and O 
readouts

Select channel name

Positive sequence 
impedance trajectory
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Figure 10.80: Example of TESLA LITE Swing Record Choosing Watt, Var and Positive 
Sequence Voltage Channels

Select an TESLA LITE swing record and expand the channels as shown. Click 
the watt, var and positive sequence voltage; RecordGraph automatically eval-
uates and displays the positive sequence impedance.

Figure 10.81: Example of TESLA LITE Swing Record Choosing Impedance Channel

Select an TESLA LITE swing record and expand the channels as shown. Click 
the impedance channel; RecordGraph automatically displays the positive se-
quence impedance trajectory.

As you select the desired channels, the impedance (R-X characteristics) are su-
perimposed on the existing relay characteristics. To select new set of voltage 
and current channels use the Delete trace(s) option from the right-click context 
menu and select new channels. If desired, you can modify or re-apply the im-
pedance options.

Positive sequence 
impedance trajectory

Positive sequence 
impedance trajectory
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Drag the thumb track on the scroll bar to zoom in or zoom out the axis range. 
In the Time Window control + click the arrow buttons or drag the thumb track 
to scroll the window of visible data in the time domain.

To place the X and O markers use the tool bar or the right-click context menu 
or the View>Markers option, dragging a marker to the right or left moves cor-
responding marker. If the Time Window control does not show the data, then 
the markers are shown as small triangles on the left or right sides. If you click 
the triangle, corresponding data cursor is displayed and the time range is auto-
matically adjusted.

You can save all the impedance display options to a template file (File> Save 
template

Trend View

Figure 10.82:  Trend View

   •  Trend View is designed to display “trend” data.

   •  It has a special x-axis, common to all the graphs to display the data in the 
“date” format. When zoomed, the scale automatically changes depending 
on the date range. (For example: years/months or months/days or days/
hours or hours/minutes or minutes/seconds).

   •  Each analog graph in a trend view can display one trace.

   •  A maximum of 32 graphs can be added per view.
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10.5 Templates

Figure 10.83: Template List

Template contains user-defined layout information including:

   •  Views – graphs and their location along with the traces (channels)

   •  Markers position (X, O and trigger marker, T)

   •  Views and graphs title options

   •  X axis scaling (zooming information)

   •  Y axis scaling (zooming information)

   •  X axis shift (time alignment) of each channel

   •  Measurement (readout) options

   •  Left Margin

Template stores the easy-to-manage layout information in a file based on prod-
uct type (B-PRO, F-PRO, L-PRO, T-PRO, TESLA, TESLA LITE, COM-
TRADE).

When the template information is stored, it can be applied to any recording 
(normally from same IED or product) for which the template is valid. For ex-
ample, if a template has 3 views with 3 graphs per view, and has 1, 2 and 3 an-
alog channels displayed with various options, this information can be applied 
to any record with that common framework. The concept is to re-use the com-
mon layout information and update the data information with the new recorded 
channels thus reducing the graph re-creation processing time.

Templates associated with a record.

Left Margin
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These flexible and user-defined templates can be shared among different users. 
Normally (under default installation options), templates are stored on the local 
hard disk in a sub-folder where the RecordGraph application resides, for exam-
ple, c:\Program Files\NxtPhase\RecordGraph\template

The template graphical layout file contains information about fixed views, 
graphs, traces, marker positions, read-out, scaling and zoom range. You can 
analyze a system disturbance recorded at different times and at different loca-
tions using the template.

When a template is opened, the predefined layout information is automatically 
applied based on the new record (or set of records). You can save time by view-
ing the data recorded without manually loading the traces again. Templates are 
the first step in generating a visual report.

You automatically form a template when you create views and graphs. To re-
apply the template to a different recording from the same or different recorder, 
you must save this layout information in a file. You can extend or alter tem-
plates by manipulating views, graphs and traces.

Templates are not saved automatically, but must be saved using the File>Save 
Template option. Template files can be shared and customized. The list of tem-
plates is dynamically created and displayed in the tool bar. When a record is 
added to RecordGraph, an automatic scan search is done to list the templates 
corresponding to the record loaded. This list may have both single or multi-re-
cord templates, if the record loaded is a part of multi-recorder template. If no 
match is found, a <Default> template is loaded. You can define any number of 
templates based on a single recorder or multiple recorders.

Default 
Templates

Hard coded, static default templates are created whenever you open the Re-
cordGraph application. These are not stored in the file, but are dynamically 
created and displayed as <Default> in the list box.

You can override this <Default> template by saving any other template as a de-
fault template. 

The user-defined default template path is stored in the registry key based on the 
product and the type of recording (applicable for all products).

For example:

   •  TESLA LITE/HS - high speed

   •  TESLA LITE/LS - low speed

   •  TESLA LITE/Trend - slow recordings
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Managing 
Template Files

Whenever a new record file is loaded into the RecordGraph, it automatically 
loads the relevant template file names in a list box attached to the main tool bar. 
The template files are filled or updated based on certain rules:

   •  Templates are stored based on product type.

   •  If a user-defined default template is available, it is loaded as the first item 
in the list box, otherwise, a static <Default> template is listed as the first 
item.

Template files are matched based on IED (serial number) in the case of TESLA 
LITE recorders and are common in case of relay products (B-PRO, F-PRO, L-
PRO, T-PRO.

If template files for a TESLA LITE recorder are created and stored (for exam-
ple, with serial number TESLA- 4001-110518-03), these template files can not 
be applied to another recorder with different serial number such as TESLA-
4000-091103-08. On the other hand, if template files are created for relay prod-
ucts such as L-PRO, this template can be applied to any relay IED B-PRO, F-
PRO, L-PRO or T-PRO). Hence, templates are IED-based (serial number-
based) in case of recorders and product-based in case of relays.

Double-click (or use the Enter key) on the currently active record in the Re-
cordGraph tree list (displayed in bold) to apply the template or pick any desired 
template from the template list box. 

Templates can be renamed, duplicated or deleted using template manager from 
within the RecordGraph.

There is no limitation on the number of template files used (as long as the hard 
disk space is available).

Create New 
Template File

1. Modify the existing template layout information and save the modified tem-
plate into a new file.

2. Create new views and graphs by deleting the views from the existing layout 
and saving new ones into a new the template file.

If the template file is created from multiple records, all the records should be 
pre-loaded into RecordGraph to successfully apply the layout information.

Layout information is applied one at a time. If the template involves more than 
one record, apply template (double-click on each record) to fill respective 
channels. The name of the recorder IED in the template file are displayed in the 
tool-tip list box window when the mouse cursor is moved over it. The tool-tip 
also displays the product name and the user-defined default template file name, 
if one exists.
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Templates 
Menus

Save Template 

Displays a dialog box only if <Default> template is currently displayed in the 
template list box. Since <Default> template name is reserved for hard coded 
templates, you must save the template information with a new name. If any 
other template file name is displayed, other than <Default>, the layout infor-
mation is updated without the dialog box being displayed.

Save Template As...

Displays a dialog box to save the template. The option Save as default tem-
plate, if checked, saves the template as user-defined default template. Refer 
previous section for more explanation on the user defined default template.

Template Manager...

Figure 10.84: Template Manager

Brings up the template manager dialog box which lists all the templates cur-
rently available.

Rename

Renames the currently selected template. 

Duplicate

Copies the contents of the selected template into another file.

Delete

Deletes currently selected template.

Save As…

Saves the selected template file from the template files list to the desired loca-
tion.
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Import…

Imports a file from any location to the current template location and registers 
the template as a high, low speed or trend default template (if one of the option 
is chosen).

Browse…

Sets the new template location. This folder stores all the template files avail-
able for the analysis based on the recorder (refer Templates section under 
Graphing Records for detailed explanations).

Close

Saves the current information of the template manager, refresh the template list 
box and exit the session.

Template - Tool 
Tip 

Figure 10.85: Template Tool Tip Information Displays:

   •  IED name

   •  User-defined default template associated with that IED

   •  Serial number of the IED which is used as the unique feature to match the 
templates.

Template - 
Single IED

1. Open a record from the desired IED (B-PRO, F-PRO, L-PRO, T-PRO, 
TESLA or TESLA LITE).

2. Create or modify the existing layout information.

3. Use Save Template as... option to save the new layout information with a de-
sired template name.

Template Tool Tip
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Template - 
Multiple IED

Figure 10.86: Multiple IEDs

1. Open records from two or more desired IEDs (different TESLA LITEs or 
different relays).

2. Create or modify the existing layout information (create graphs by selecting 
channels from different IEDs).

3. Use Save Template as... option to save the new layout information with a de-
sired template name.

A single IED Template is saved/matched based on its serial number.
Any record from the IED with the same serial number can use or
share the template (layout) information. A single IED template is
saved/matched based on the product (not on the serial number) and
hence once the template file is created for one of the IED, it can be
shared by all the IEDs irrespective of whether they have the same or
different serial number or from different recordings

When all IED records are pre-loaded into the RecordGraph, multiple 
IED templates are saved/matched based on serial number. If the 
record is loaded one at a time, then double-clicking on each record 
reapplys the template filling the respective channels.
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10.6 View and Graph Titles
When a new record is loaded, the information corresponding to the options se-
lected is compiled and the updated information is displayed in the View Title. 

Figure 10.87: View and Graph Titles

View Title View Title is the title on the top of each record view. When a new record is 
loaded, the information corresponding to the options selected is compiled and 
the updated information is displayed in the View Title. You can choose any of 
four options by clicking the arrows to move the items in the list. The option is 
saved into the template. This option is not available for the Symcom or Har-
monic Views. 

The option choices are:

   •  Record Name

   •  Station Name

   •  Location

   •  Trigger Time

   •  UnitID of Recorder

   •  Product Type

   •  Serial Number

   •  Trigger Event

   •  System Frequency

   •  Priority

View TitleGraphTitle
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Figure 10.88: View Title Options

Graph Title Graph Title is the information that appears on the left margin of each graph. 
Graph Title is a combination of various options. When a new record is loaded, 
the information corresponding to the options selected is compiled and the up-
dated information is displayed in the Graph Title dialog box. You can choose 
any four options by clicking the arrows to move the items in the list. The option 
is saved into the template. This option is not available for the Overlay View.

The option choices are:

   •  Channel name

   •  Trigger time

   •  Station name

   •  Record name

   •  Location

   •  UnitID or recorder

   •  Sample rate

   •  Equipment ID

Figure 10.89: Graph Title Options
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10.7 Readouts and Measurements
The Measure menu consists of the following:

   •  Markers

   •  Primary/Secondary

   •  Time Alignment

   •  Absolute Time

   •  Fundamental RMS

   •  True RMS

   •  Harmonics

   •  Symmetrical Components

Figure 10.90: Readouts and Measurements

Markers Selecting Measure>Markers or using the tool bar button places the “X” and 
“O” markers on the graph, as well as, automatically placing markers on all new 
graphs. If the markers are out of view range, double-click on the timeline graph 
to bring back the markers to the desired location. Marker positions are saved 
into the template. Readout corresponding to the option chosen is displayed on 
the right side of the graph. Selecting trigger marker, T, displays the trigger time 
of the record.

Fundamental RMS

Time Alignment

Absolute Time

True RMS

Trigger

Harmonics

Markers
10-64 TESLA LITE User Manual  D03283R01.02



10 Graphing Records
Primary Selecting Measure>Primary multiplies the channel data by the primary scal-
ing factor and redraws the y-axis for all graphs.

Secondary Selecting Measure>Secondary multiplies the channel data by the secondary 
scaling factor and redraws the y-axis of all graphs.

Time Alignment Use this option to offset or align the trigger time of channels (normally from 
different locations) or shift the x-axis time. This feature offsets the x-axis time 
data by a precise value as desired.

1. A trace (channel) must first exist on the graph. Click the graph that you want 
to show time alignment.

2. Select the Measure>Time Alignment menu option or the Time Alignment 
button on the tool bar.

3. Use the “spin” control (up and down arrows) to increase or decrease the off-
set.

4. Double-click the value to bring up a dialog box to enter the new offset value 
and offset scale. Offset scale is the percent by which the increment is re-
quired.

5. Clear this option, by a second click on the Time Alignment button on the tool 
bar or by selecting the Graph>Time Alignment menu option a second time.

Figure 10.91: Time Alignment

Spin control to quickly
vary the offset value

Time alignment toolbar button

Edit box to change the offset value.
Note: Double-click here to change 
the offset value and the offset 
scale (increment)
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Absolute Time This option displays the absolute time - the actual time of the recorded chan-
nels.

1. A trace (channel) must first exist on the graph. Click the graph that you want 
to show absolute time measurement.

2. Select the Measure>Markers menu option or the Markers button on the tool 
bar to place the markers on the graph. Markers are automatically placed if 
not selected.

3. Select Measure>Absolute Time menu option.

4. Readout corresponding to the markers is displayed on the right-hand side of 
the graph including:

   •  Year, Month, Day of the recording (yyyy/mm/dd)

   •  Absolute Time corresponding to marker X

   •  Absolute Time corresponding to marker O

   •   Difference in the Absolute Time between marker X and marker O

9

Figure 10.92: Absolute Time

Absolute Time
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Fundamental 
RMS

This option displays the rms measurement of the fundamental (60 or 50 Hz) 
between the two markers (X and O) of the selected channel.

1. A trace (channel) must first exist on the graph. Click the graph that you want 
to show absolute time measurement.

2. Select the Measure>Markers menu option or the Markers button on the tool 
bar to place the markers on the graph. Markers are automatically placed if 
not selected.

3. Select Measure>Fundamental RMS menu option.

4. Readout corresponding to the markers is displayed on the right-hand side of 
the graph including:

   •  RMS (fundamental frequency) Title

   •  Minimum rms

   •  Maximum rms

   •  Average rms

Figure 10.93: Fundamental RMS

Fundamental RMS
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True RMS This option displays true rms measurement values of all the harmonics (includ-
ing the fundamental), depending on the sample rate of the recorded channel. 

1. A trace (channel) must first exist on the graph. Click the graph that you want 
to show absolute time measurement.

2. Select the Measure>Markers menu option or the Markers button on the tool 
bar to place the markers on the graph. Markers are automatically placed if 
not selected.

3. Select Measure>True RMS menu option.

Readout corresponding to the markers is displayed on the right-hand side of the 
graph including:

   •  True RMS Title

   •  Minimum True RMS

   •  Maximum True RMS

   •  Average True RMS

Figure 10.94: True RMS

True RMS
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Harmonics This option displays the harmonic contents (magnitude) of the desired channel 
along with the Total Harmonic Distortion (THD) in percentage. 

1. A trace (channel) must first exist on the graph. Click the graph that you want 
to show absolute time measurement.

2. Select the Measure>Markers menu option or the Markers button on the tool 
bar to place the markers on the graph. Markers are automatically placed if 
not selected.

3. Select Measure>Harmonics menu option.

4. Readout corresponding to the markers is displayed on the right-hand side of 
the graph including:

   •  Harmonics Title

   •  2nd Harmonic

   •  3rd Harmonic

   •  4th Harmonic

   •  5th Harmonic

   •  THD% of fundamental (the number of harmonics included in THD) 
depends on the sample rate.

Figure 10.95: Harmonics

Harmonics
D03283R01.02 TESLA LITE User Manual 10-69



10 Graphing Records
Symmetrical 
Components

This measurement option displays the magnitudes of the positive, negative and 
zero sequence components of 3-phase voltage or current channel. 

1. Create an Overlay View— you must have a 3-phase voltage or current chan-
nel.

2. Place three phase voltage or current channels on the graph.

3. Select the Measure>Symmetrical Components menu option.

4. Readout corresponding to the markers is displayed on the right-hand side of 
the graph including:

   •  SymCom Title

   •  Positive sequence component magnitude

   •  Negative sequence magnitude

   •  Zero sequence magnitude

Figure 10.96: Symmetrical Components

Symmetrical Components
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10.8 Calculated Channels
Calculated channels are virtual channels derived from the original recorded 
channels. They are calculated based on the configuration information. In the 
TESLA LITE recorder, all the calculated channels are added to the original re-
cord only once, but are available any time to view with the RecordGraph ap-
plication. Calculated channels differ widely depending on the product. They 
are classified under high and low speed categories. 

High Speed Calculated channels

   •  Summation

   •  Positive sequence

   •  Negative sequence

   •  Zero sequence

   •  Watts (single and three phase)

Low Speed Calculated channels

   •  Summation

   •  Positive sequence

   •  Watts (single or three phase)

   •  Vars (single or three phase)

   •  Impedance

   •  External

Type and number of channels available for the view depends on the configura-
tion information. 

Choose Options>Calculate Derived Channels Now to add the calculated chan-
nels. If this option is disabled, then the calculated channels are already avail-
able.
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Figure 10.97: Calculated Channels

10.9 Exporting Views
Export active visible views to windows standard clipboard or to an enhanced 
metafile. Following options are available:

   •  Copy To ClipBoard

   •  Save As MetaFile

Figure 10.98: Export Views

Calculated Channels

Copy to Clipboard

Save to Metafile
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Copy to 
Clipboard

Copies view to the clipboard in order to copy into another document, for ex-
ample Microsoft Word.

1. To copy to clipboard select View>Copy to Clipboard or right-click on the 
graph to bring up the context menu and select Copy to Clipboard.

2. Open any other software package, which supports the “pasting” facility from 
the clipboard (for example Excel or Microsoft Word) and paste the view.

Save View as 
Metafile

Saves the view to a Metafile format *.emf.

1. To save to as a Metafile select View>Save to Metafile... or right-click on the 
graph to bring up the context menu and select Save to Metafile. 

2. A dialog box appears prompting you to save the file in a selected folder.

Figure 10.99: Save to Metafile

10.10 Exporting Channel Data
Any channel data can be exported to the clipboard from the active view. If a 
graph has multiple channels, all the channel data is exported to the clipboard.

This option copies the trace data to the clipboard and using Edit>Paste to paste 
into other applications like Microsoft Word or Excel.

Figure 10.100: Copy Trace to Clipboard

Copy Trace Data to Clipboard
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Pasting exported data using Microsoft Excel

1. Open Microsoft Excel.

2. Choose Edit>Paste Special.

Figure 10.101: Paste Special Using Excel

Pasting exported data using Microsoft Excel

Choose CSV (comma separated variable) format and click OK.

Figure 10.102: Choose CSV
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Pasting exported data using Microsoft Excel

Domain: normally time data, it can be date YYYY/mm/dd in case of trend data.

Figure 10.103: Paste to Excel

10.11 Record Summary
1. Click the record name to enable this feature.

2. Choose File>Show Record Summary… to display the record summary.

Figure 10.104: Show Record Summary
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10.12 Digital Channel Status Indicator
Highlight digital channel which change state (with different icons), and list 
only configured channels in the tree view. A mimic screen shot of the icons is 
shown below. The <default> template automatically displays the digital chan-
nels which changes the state.

5

Figure 10.105: Digital Channel Status Indicator

10.13 IRIG-B Input Status
IRIG-B input status (synchronized, unsynchronized or not available) is dis-
played in the tool tip window when you place the mouse on the channel name 
or use Active Trace Information.

Figure 10.106: IRIG-B Input Status Indicator

Icon with changes
in the digital status

Icon with no changes
in the digital status

IRIG-B status indicator
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10.14 Derived Digital Swing Channels for TESLA LITE 
Swing Recordings

TESLA LITE recordings do not record External Input channels for the swing 
records. A facility to view these channels in the RecordGraph is provided. Re-
cordGraph automatically displays these channels (if configured) under low 
speed channel group. Events with the same element are grouped together to 
form a channel. This facility is backward compatible.

10.15 COMTRADE Import
COMTRADE (Common Format for Transient Data Exchange) is an industry 
standard record format used to share data between tools and to replay faults 
through a test set. The import utility supports viewing of both ASCII and bina-
ry COMTRADE formats (1991, 1999 and 2000). When the COMTRADE file 
is imported into the RecordGraph, all its functionality can be seamlessly used 
to analyze the record.

1. RecordGraph application must be running to access this facility. If not, 
launch RecordGraph via TESLA Control Panel, RecordBase View or Win-
dows Explorer.

2. Choose File>Import.

3. Browse to select desired file.

4. Double-click on the COMTRADE record to apply <Default> template or se-
lect it from the templates list box.

Figure 10.107: Import COMTRADE File

Import file
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Figure 10.108: Select COMTRADE File

Figure 10.109: Apply <Default> Template

Choose COMTRADE File
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10.16 Print Options
The following options are available:

   •  Print... – pops-up a print option dialog box to select paper size, orientation 
and other options.

   •  PrintDirect – sends active view directly to the default printer.

   •  PrintAll – sends all the views directly to the default printer.

   •  Print Preview…– displays standard preview window.
D03283R01.02 TESLA LITE User Manual 10-79





11 Record Export Utility

The record export utility lets you convert records into different formats for use 
with other software tools.

COMTRADE

Common Format for Transient Data Exchange (COMTRADE) is an industry 
standard record format used to share data between tools and to replay faults 
through a test set. The export utility supports both ASCII and binary COM-
TRADE formats and creates output that complies with the latest (2000 and 
1999) or older version (1991) of the standard.

PTI

Power Technologies Incorporated (PTI) produces widely used power system 
modelling tools. TESLA records can be exported in a PTI-compliant format for 
import into PTI tools. The export utility supports ASCII format and creates 
output that complies with PTI version 1 or version 2 formats.

Excel (CSV)

TESLA LITE records can be exported in basic comma separated values (also 
known as comma-delimited) ASCII format suitable for importing into standard 
tools such as Microsoft Excel.
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Launch the 
Export Utility

To launch the export utility:

1. Double-click Records from the Main Menu.

2. Select a local record from the record list.

3. Select the Export button to launch the Export window.

4. Select the desired export output format and select OK.

Figure 11.1:  Select Export File Type

Step 2: Select a record 

from the list.

Step 3: Click on the

Export button to 

launch export window.

Step 4: Choose export

type and OK.

Step 1: Double-click 

Records from the 

Main Menu
11-2 TESLA LITE User Manual  D03283R01.02



11 Record Export Utility
11.1 COMTRADE Format

Figure 11.2: COMTRADE Settings

The COMTRADE format (IEEE C37.111) defines a common format for stor-
ing digital data records of transient and dynamic swing events. It consists of up 
to four output files with the same base name and different file extensions: con-
figuration files (.cfg), header files (.hdr), data files (.dat) and optional informa-
tion files (.inf). The COMTRADE Export Utility produces the configuration, 
header and data files.

With reference to Figure 11.2: COMTRADE Settings,

Table 11.1:  COMTRADE Export Settings

Name Function

Export to... The base filename and directory of the output files are set using the 
Export to. option. 
By default the base filename is the same as the record you are 
exporting. 
You can edit this or use the Browse button to set a new directory 
and/or base filename.

Station Name and 
Identification 

The Station Name and Identification fields are set by default using 
information from this recorder. They are written as the first line in 
the.cfg output file. 

Header Text The Header Text field contains the text written into the COMTRADE 
header (.hdr) file. By default, the field contains the Location, Name, 
Number and the Unit ID of the unit that produced the record. 
This text can be modified, deleted or extended as desired.
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Version The Version field lets you select the revision of COMTRADE stand-
ard to produce. COMTRADE has been an evolving standard and a 
number of changes have been made over the years. 
1991, 1999 and 2000 COMTRADE versions are supported.

Format The Format field specifies that the data in the COMTRADE file 
(ASCII or BINARY format).
ASCII data has the advantage of being usable by simple text editor 
and spreadsheet programs, but results in a significantly larger 
record relative to binary format. 
BINARY format is therefore recommended if the software package 
you will be using the data in supports binary format COMTRADE.

Selecting Channels 
(Exported Channels)

You must select the channels from the record that you want to 
include in the output file. 
For convenience, the digital data recorded is classified into:
• High Speed: Analog and external digital input channels sampled 

at the high speed transient data rate.
• High Speed (480/sec): Analog and internal logic channels pro-

duced 8 times per cycle.
• Low Speed (60/sec): Analog input channels sampled at the low 

speed swing data rate.
Select the desired channel from the list with a left-click. 
Multiple channels can be selected using standard Windows selec-
tion actions (click + Ctrl or Shift keys).

>  Place selected channels in the Exported Channels list box. 

>> Place all channels into the Exported Channels list box. 

< Delete a channel from the Exported Channel list box.

<< Delete all channels from the Exported Channel list box.

Offset negative start 
times to begin at zero

When checked, this option shifts the negative time to start from 
zero.

Table 11.1:  COMTRADE Export Settings
11-4 TESLA LITE User Manual  D03283R01.02



11 Record Export Utility
11.2  PTI Format 

Figure 11.3: PTI Settings

The PTI file format is used to import records into the Power Technologies In-
corporated system modelling software.

Output File PTI export produces a single output file with an .asc extension.

Table 11.2:  PTI Settings

Name Title

Export to... The base filename and directory of the output files are set 
using the Export to.. option. 
By default the base filename is the same as the record you are 
exporting. 
You can edit this or use the Browse button to set a new direc-
tory and/or base filename.

Station Name and Identifi-
cation

The Station Name field is set by default using the unit’s Station 
Name setting. It is written as the third line in the output file.
If desired, you can edit this text. 
The Identification field is not written to the PTI output file.

Header Text The Header Text field contains the text that is written as a sin-
gle line in the fourth line in the output file. 
By default, the field contains the Location, Name, Number and 
Unit ID of the recorder that produced the record. 
This text can be modified, deleted or extended as desired.

Version The Version field lets you select between PTI version 1 and 
version 2. Please refer to PTI documentation for details on the 
differences of these versions. 
Format Only ASCII format output files are available.

Format ASCII is the only format option for PTI.
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11 Record Export Utility
Channel Selection Use Channel Selection to select channels to export. 
You must select the channels from the record that you want to 
include in the output file. 
For convenience, the digital data recorded is classified into:
• High Speed: Analog and external digital input channels sam-

pled at the high speed transient data rate.
• High Speed (480/sec): Analog and internal logic channels 

produced 8 times per cycle.
• Low Speed (60/sec): Analog input channels sampled at the 

low speed swing data rate.
Select the desired channel from the list with a left-click.
Multiple channels can be selected using standard Windows 
selection actions (click + Ctrl or Shift keys).

>  Place selected channels in the Exported Channels list box. 

>> Place all channels into the Exported Channels list box. 

< Delete a channel from the Exported Channel list box.

<< Delete all channels from the Exported Channel list box.

Offset negative start times 
to begin at zero

When checked, this option shifts the negative time to start from 
zero.

Table 11.2:  PTI Settings
11-6 TESLA LITE User Manual  D03283R01.02



11 Record Export Utility
11.3 Excel (CSV) Format

Figure 11.4: Excel (CSV) Settings

The Excel CSV (Comma Separated Value) format is used to import records 
into a Microsoft Excel spreadsheet. This format is also known as comma de-
limited ASCII and can generally be used by most programs that import data ar-
rays.

Excel CSV export produces a single output file with a.csv extension, which is 
recognized by Excel. Excel is automatically launched when you double-click 
on file. 

Table 11.3:  CSV Export Settings

Name Function

Export to... The base filename and directory of the output files are set 
using the Export to... option. 
By default the base filename is the same as the record you are 
exporting. 
You can edit this or use the Browse button to set a new direc-
tory and/or base filename.

Station Name and Unit ID The Station Name and Identification fields are not written to the 
Excel CSV format output file. 

Header Text There is no header text written to the Excel CSV format output 
file.

Version There are no version options for the Excel CSV output.

Format ASCII is the only format options for the Excel CSV output.
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11 Record Export Utility
Channel Selection You must select the channels from the record that you want to 
include in the output file. 
For convenience, the digital data recorded is classified into:
• High Speed: Analog and external digital input channels sam-

pled at the high speed transient data rate.

• High Speed (480/sec): Analog and internal logic channels 
produced 8 times per cycle.

• Low Speed (60/sec): Analog input channels sampled at the 
low speed swing data rate.

Select the desired channel from the list with a left-click. Multiple 
channels can be selected using standard Windows selection 
actions (click + Ctrl or Shift keys).

>  Place selected channels in the Exported Channels list box. 

>> Place all channels into the Exported Channels list box. 

< Delete a channel from the Exported Channel list box.

<< Delete all channels from the Exported Channel list box.

Offset negative start times 
to begin at zero

When checked, this option shifts the negative time to start from 
zero.

Table 11.3:  CSV Export Settings
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12 Maintenance Menu and Error 
Handling

12.1 Maintenance Menu
TESLA LITE has a set of utilities that provide diagnostic, recovery and TCP/
IP services. These utilities are available through the Maintenance Menu ac-
cessed with a VT-100 terminal connection to the recorder’s serial port, modem, 
Ethernet LAN or USB port. For security purposes any utilities that can modify 
the TESLA LITE are disabled when connecting remotely. To access these util-
ities you must connect to the recorder using Port 450 on the unit’s front panel.

Any terminal program that fully supports VT-100 emulation and provides z-
modem file transfer services can be used. HyperTerminal, which is included in 
Windows XP and is also available separately as HyperTerminal PE, is used 
here as an example.

1. Determine how you want to connect to the recorder. 

   •  USB connection.

   •  A direct serial link connects your computer’s serial port to the recorder’s 
rear panel Port 405. Port 405 is set up so that a standard, straight-through, 
male-to-female serial cable can be used.

   •  If both the recorder and your computer have modems, you can access the 
Maintenance Menu through the telephone system.

   •  If both the recorder and your computer are on the same LAN or WAN, you 
can access the Maintenance Menu through your network.

2. Configure your terminal program as described in the table below. 

   •  For the front. 

   •  For a USB or direct serial link, the baud rate must be same as that of the 
recorder’s port. Port 450 USB link the default baud rate is 115,200. Serial 
Port 405 default baud rate is 38,400. The baud rate can be viewed and 
changed in the Utilities>Communication tab of TESLA Control Panel. 

   •  For a modem link, the baud rate and other communication parameters only 
determine how your computer talks to your modem. Usually, the fastest 
possible baud rate is chosen to maximize your modem's compression ca-
pabilities. 

   •  For a network link, only the Emulation and Font settings from the table are 
relevant. 
D03283R01.02 TESLA LITE User Manual 12-1



12 Maintenance Menu and Error Handling
3. Select the device on your PC you will communicate through. In HyperTer-
minal, this is done in the Connect Using field of its Properties control. 

   •  For a USB link select port 450

   •  For a direct serial link, select port 405

   •  For a modem link, select the appropriate modem

   •  For a network link, select “TCP/IP (Winsock)” (available with Hyper-
Terminal v1.2 or greater) 

4.  Initiate the connection. The TESLA LITE will respond with a login prompt

   •  In HyperTerminal, use the Call button or menu command to initiate the 
connection.

5. At the login prompt, log in as “maintenance”

   •  Lower case

   •  No password is required. If you are asked for one, there is a mistake in 
the login name. Press Enter to get another Login prompt and try again.

Table 12.1:  Terminal Program Setup

Baud rate For a USB or direct serial link, the baud rate must match that of the 
recorder’s port. USB Port 450 default baud rate is 115,600 N81. Serial 
Port 405 default baud rate is 38,400 N81.
For a modem link, the baud rate refers only to the link between your 
computer and its own modem. 

Data bits 8

Parity None

Stop bits 1

Flow control Hardware or Software. 
Hardware flow control is recommended. The recorder automatically 
supports both on all its serial ports.

Function, arrow 
and control keys

Terminal keys

Emulation VT100

Font A font that supports line drawing (e.g. Terminal or MS Line Draw).
If the menu appears outlined in odd characters, the font you have 
selected is not supporting line drawing characters.
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12 Maintenance Menu and Error Handling
Figure 12.1:  Maintenance Menu

Maintenance 
Menu 
Commands Table 12.2:  Menu Commands

1. Modify IP Addresses, sub-
net mask and default gate-
way

Modify the LAN IP addresses, default subnet mask and 
default gateway.

2. View system diagnostic Displays the TESLA LITE’s internal status log.

3. Retrieve system diagnos-
tics

Automatically packages up the internal status log plus setting 
and setup information and downloads it in compressed form 
to your computer. This file can then be sent to ERLPhase 
customer support to help diagnose a problem.

4. Restore ALL default set-
tings

Restores ALL factory defaults including settings, calibration 
and setup parameters.

5. Restore only default 
recorder configuration set-
tings 

Restores the default settings that define channels, sample 
rates and triggers.

6. Restore only default sys-
tem setup

Restores the default values for the setup parameters includ-
ing communication settings, record controls, time controls 
and passwords.

7. Force hardware reset Manually initiates a hardware reset. Note that the communi-
cation link is immediately lost and cannot be re-established 
until the unit completes its start-up.

8. Network utilities Enter network utilities sub-menu. 

9. Monitor SCADA Shows real time display of Modbus or DNP 3 data.

10. Save recent trend data Saves any accumulated Trend Data that hasn’t yet been 
saved to disk. This should be executed prior to [7] Force 
Hardware Reset if trend logging is enabled.
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12 Maintenance Menu and Error Handling
11. Enter safe shutdown 
mode

Suspends TESLA LITE application.

12. Modify point-to-point IP 
addresses

Modify point-to-point addresses used for TCP/IP communi-
cation over serial or modem connection.

13. Calibrate DSP clock Performs DSP clock calibration.

14. Exit Logs off as Maintenance user.

Table 12.3:  Network Utilities Menu Commands

View protocol statistics View IP, TCP and UDP statistics.

View active socket states View current states of active sockets.

View routing tables View routing tables.

View MAC address View MAC address.

Flush gateway entries Flush the routing tables of all gateway entries.

Ping Check network connection to given point.

Enable/disable packet for-
warding

Enable or disable TCP packets forwarding.

Exit network utilities Exit network utilities menu and return to maintenance menu 
commands.

Table 12.2:  Menu Commands
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12 Maintenance Menu and Error Handling
12.2 Error Handling
The recorder has hardware and software self-check capabilities that work to 
keep it operational and provide an indication if a failure occurs.

Failure Contact Output Contact #7 on the rear panel is a normally open contact that closes to 
indicate a problem with the device. The contact is controlled by a hardware 
watchdog circuit, ensuring a failure is reported even if the unit’s processors are 
not functional. The state of the Failure Contract is mirrored by the front panel 
Recorder Functional LED.

Failure 
Handling

Supervisory software continually checks all system processes. If a failure is de-
tected an attempt is made to correct the problem through a software restart. A 
software restart takes place quickly and does not activate any external indica-
tors.

If the failure persists, the unit will initiate a hardware reset to attempt to clear 
the problem. A hardware reset takes approximately a minute and half to com-
plete. If the problem is not cleared after four consecutive reset attempts, the 
unit enters the Persistent Error state. In this state, the recorder activates its fail-
ure indicators and stops initiating resets to avoid interfering with any diagnos-
tic investigation. 

If the Supervisory software subsequently determines that the problem has been 
cleared, it automatically returns the unit to its normal operating state, clearing 
the failure indicators.

Figure 12.2: Error Handling

Normal 

Operation

Software 

Restart

Hardware 

Reset

Persistent 

Error Mode

First Detected Error

Problem Cleared

Problem Still Present
Problem Persists After

 Repeated Reset Attempts

Problem Cleared

Problem Cleared
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12 Maintenance Menu and Error Handling
State Indicators

Diagnostic 
Tools

The recorder has an internal log file to aid in problem diagnosis. The log can 
be viewed from the Maintenance Menu (see below). As well, a full diagnostic 
information package can be generated and uploaded to your PC, where it can 
be e-mailed to ERLPhase customer support for analysis.

The Maintenance menu also has tools to help diagnose SCADA problems and 
network communication problems. 

Table 12.4:  State Indicators

Recorder State Indicators

Normal Recorder Functional LED ON
Failure Contact OPEN

Software Reset Recorder Functional LED ON
Failure Contact OPEN

Hardware Reset Recorder Functional LED ON
Test Mode LED ON
Failure Contact OPEN

Persistent Error Recorder Functional LED OFF
Alarm LED ON
Failure Contact CLOSED
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Appendix A  Specifications

TESLA LITE Power System Recorder

Item Quantity/Specs Notes

General

Weight 11.9 lbs 32.0 lbs

Dimension 17.7 cm
48.3 cm rack mount
30.5 cm deep

 6.93"
19" rack mount
12" deep

Nominal Frequency 50 or 60 Hz

Power Supply Full operating range: 43 - 275 Vdc, 90 - 265 Vac Power Consumption: 25 - 35 VA(ac)
                                   25 - 35 W (dc)

Alarm Contacts 7 

Sample Rate Samples per cycle and per second (60/50 Hz):
96 samples / cycle (5,760 / 4,800 Hz)

Measurement Accuracy Current Measurement Accuracy:
± 2.5% of inputs from 0.1 to 1.0 x nominal current (In)

± 1.0% of inputs from 1.0 to 40.0 x nominal current (In)

Voltage Measurement Accuracy:
± 1.0% of inputs from 0.01 to 2.0 x nominal current (Vn)

Frequency Measurement Accuracy: 
± 0.001 Hz at system frequency

Frequency Response The following are the highest harmonics of the funda-
mental frequency (60 Hz/50 Hz) that can be passed at 
the available sample rates:
Sample Rate:                  Harmonic:

5,760 / 4,800 Hz            25th (1500/1250HZ)

Sample Skew All channels sampled simultaneously

A/D Resolution: 16 bits, 65536 counts full scale
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Appendix A Specifications
Recording and Logging

Transient Fault Record length 10 seconds  0 to 1 sec pre-trigger time

Dynamic Swing Record length900 seconds to 15 minutes 1 sample per cycle, 
0 to 60 secs pre-trigger time

Event Logging 250 Events in the regular log, up to 1000 events per day 
in long trend log

Long term event logging is part of the 
trending function.

Record Storage Up to 150 records

Trending

Available trend channels Any of the recorder’s existing configured analog chan-
nels (input or calculated) can be trended. 

Evaluated phasor magnitude and angle 
quantities will be recorded as separate 
channels.

Accumulation mode Minimum, maximum, average, damped or undamped.

Sample Interval User selectable sample interval from 10 seconds to 1 
hour in 1 second increments. 

All channels produce trend data simulta-
neously at the selected rate.

Maximum number of 
channels

Up to 45 channels can be trended simultaneously. A channel with multiple accumulation 
modes is treated as multiple channels 
(e.g. the trending of minimum, maximum 
and average readings of a selected input 
would require 3 trend channels). 

Trend storage The recorder can store 15 days of data from each trend 
channel, regardless of the number of configured trend 
channels.

This is a non-configurable parameter. 

Channels and Triggers

Analog Inputs High and low threshold, positive and negative rate of 
change, harmonic level, THD level, sags, swells

All triggers have independent controls for 
delay, logging, transient or swing record 
initiation, alarm contact activation and 
cross triggering.

Summations High/low threshold, +/- rate of change 2 or 3 input channels

Positive Sequence High/low threshold, +/- rate of change

Negative Sequence High level

Zero Sequence High level

Watts/Vars High/low threshold, +/- rate of change

Frequency High/low threshold, +/- rate of change

Impedance Positive sequence circle

External Inputs (digital) Rising edge, falling edge or both

Logic Rising edge, falling edge or both

Fault Locator Triggered by internal or external events

Sags and Swells Sag and swell detection can be enabled on any analog 
input channel configured as a voltage.

Interface & Communication

TESLA LITE Power System Recorder
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Appendix A Specifications
Front Panel Indicators 6 LEDs Recorder Functional, IRIG-B Functional, 
Recorder Triggered, Records Stored, 
Test Mode, Alarm

Front User Interfaces USB port and 100BASE-T Ethernet port

Rear User Interfaces LAN Port1: 100BASE – Copper Copper: RJ-45, 100BASE-T

Serial User Interface Two Serial RS-232 ports to 115 kbd Com port can support an external 
modem

Internal Modem 38.4 Kbps, V.32 bis Optional 

SCADA Interface DNP3 or Modbus Ethernet: DNP3
RS: 232: DNP3 or Modbus

Configurable Alarms 5 contacts per unit Normally open

Cross-trigger 1 contact per unit Normally open

Self Checking/Recorder 
Inoperative

1 contact Normally closed

Time Sync IRIG-B, BNC connector/unit Modulated or unmodulated

Input & Output

Analog Input Channels 12 currents, 3 line and 3 bus voltages

Analog Voltage Inputs
2 sets of 3-phase voltage 
inputs
(6 voltage channels total)

Nominal Voltage
Continuous rating
Maximum over-scale thermal rating
Burden

Vn = 69 Vrms
2x Vn = 138 Vrms
3x Vn = 207 Vrms for 10 seconds
<0.15 VA @ 69 Vrms

Analog Current Inputs
4 sets of 3-phase current 
inputs
(12 current channels)

Nominal Current
Full Scale/Continuous
Maximum full-scale rating
Thermal Rating
Burden

In = 1 Arms or 5 Arms
3x In = 3 Arms or 15 Arms
40x In for 1 second symmetrical
400 A for 1 second
<0.25 VA @ 5 Arms

Sampling Resolution Amplitude measurement accuracy: +/-
0.5% for 54 to 66 Hz

Burden Burden resistance: > 10 k ohms

Analog Input Sampling Sample rate: 96 samples/cycle for recording, 8x/cycle 
for protection

External Inputs 38 isolated inputs Optional 48, 125 or 250 Vdc nominal,
externally wetted

Isolation 2 KV optical isolation

Sample Rate 96 samples/cycle

External Input Turn-on 
Voltage

48 Vdc range = 27 to 40 Vdc
125 Vdc = 75 to 100 Vdc
250 Vdc = 150 to 200 Vdc, 60% to 80% of nominal

Specified voltages are over full ambient
temperature range.

Alarm Contacts Externally wetted
Make: 30 A as per IEEE C37.90
Carry: 8 A
Break: 0.9 A at 125 Vdc resistive
0.35 A at 250 Vdc resistive

TESLA LITE Power System Recorder
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Appendix A Specifications
Environmental

Ambient Temperature 
Range

-40°C to 85°C for 16 hours
-40°C to 70°C continuous

IEC 60068-2-1/IEC 60068-2-2
LCD contrast impaired for temperatures 
below -20°C and above 70° C

Humidity Up to 95% without condensation IEC 60068-2-30

Insulation Test (Hi-Pot) Power supply, analog inputs, external inputs, output con-
tacts - 2 kVrms, 50/60 Hz, 1 minute

IEC 60255-5, ANSI/IEEE C37.90

Electrical Fast Transient Tested to level 4 - 4.0kV 2.5/5 kHz on
Power and I/O lines

ANSI/IEEE C37.90.1, IEC/EN 60255-22-
4, IEC 61000-4-4

Oscillatory Transient Test level = 2.5kV ANSI/IEEE C37.90.1, IEC/EN 60255-22-
1, IEC61000-4-12

RFI Susceptibility 10V/m modulated, 35V/m unmodulated ANSI/IEEE C37.90.2, IEC 60255-22-3, 
IEC 61000-4-3

Conducted RF Immunity IEC 60255-22-6 / IEC 61000-4-6

Shock and Bump 5g and 15g IEC 60255-21-2, IEC/EN 60068-2-27

Sinusoidal Vibration IEC/EN 60255-21-1, IEC/EN 60068-2-6, 
Class 1

Voltage Interruptions 200 ms interrupt IEC 60255-11 / IEC 61000-4-11

TESLA LITE Power System Recorder
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Appendix B  TESLA LITE Hardware 
Description

The TESLA is a modular high-quality power system recording system. It is 
available in 18 and 36 channel models.

Main Processor 
Board

The Main Processor Board consists of a DSP, a power PC processor, serial 
ports, Ethernet ports, an IRIG-B processor, a watchdog and a power supply that 
supplies the other boards. All other boards are connected to the MPB as I/O. 
The MPB has a socket for an optional internal modem.

Digital Input 
Boards (DIB9 
and DIB18)

These board provide 9 and 18 digital input channels respectively. Inputs are 
optically isolated, externally wetted, and factory preset to the customers re-
quested voltage level of 48,125 or 250 Vdc. This board interfaces to the MPB.

Digital Input/
Output Board 
(DIGIO)

The DIGIO provides 11 digital input channels. Inputs are optically isolated, ex-
ternally wetted, and factory preset to the customer's requested voltage level of 
48,125 or 250 Vdc. The DIGIO also provides 7 contact outputs for relaying, 
alarms and control. This board interfaces to the MPB.

Rear Panel 
Comm Board 
(RPCB)

The Comm Board provides the TESLA LITE with two RS-232 ports, IRIG-B 
time synchronization input, one network port and a modem port. The RS-232 
ports are female DB-9S connectors, IRIG-B is a male BNC, the modem jack is 
an RJ-11 and the network port is RJ-45.

AC Analog 
Sensor Boards 
(ASB)

Each TESLA LITE has 3 ASBs. Two ASBs have 3 voltage transformer inputs 
and 3 current transformer inputs while the third ASB has 6 current transformer 
inputs. These boards provide 12 current and 6 voltage ac analog measurement 
inputs. The ASBs interface to the AIB.

AC Analog 
Input Board 
(AIB)

The AIB provides the analog to digital conversion of the 12 ac analog current 
inputs and the 6 ac analog voltage inputs. The sample rate is fixed at 96 sam-
ples/ cycle. Each channel is simultaneously sampled using 16-bit analog to dig-
ital converters. The digitized data is sent to the MPB for processing and 
implementation of the protection algorithms.

Front Panel 
Comm Board 
(FPCB)

The Front Panel Board provides visual indication of the status of the TESLA 
LITE recorder and USB and network ports.
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Appendix C  Glossary
AC Analog Input An ac current or voltage that is obtained from a current transformer or a voltage trans-

former connected to an element on the power system.

AC Analog Summation Configuration of TESLA LITE allows two AC analog quantities to be summed. For exam-
ple, currents from two parallel lines can be summed to produce a set of combined cur-
rents.

COMTRADE Common Format for Transient Data Exchange. IEEE standard C37.111-1991, IEEE 
Standard Common Format for Transient Data Exchange (COMTRADE) for Power Sys-
tems, which describes a common format for exchange of recorded power systems data 
between different manufacturers’ recorders.

DCE Data Communications Equipment, an RS-232 term for modems and similar equipment. 
DCEs generally have a female DB connector.

DST Daylight Savings Time. A seasonal adjustment of time applied in many jurisdictions to 
compensate for varying day lengths. Most often, an hour is added to the system time to 
begin on the second Sunday in March and end the first Sunday in November.

DTE Data Terminal Equipment, an RS-232 term for a terminal or computer. DTEs generally 
have a male DB connector.

DUN Dial-Up Networking, a facility in Windows providing dial-up access to Internet and other 
networks. DUN is provided with the Windows distribution.

EIA RS-232C Electronics Industries Association recommended standard 232, revision C, Interface 
between Data Terminal Equipment and Data Communication Equipment Employing 
Serial Binary Data Interchange. Defines the most popular electrical connection for serial 
binary data interchange, available on almost all computer systems.

Element A component in the power system that conveys bulk power within the power system. 
Control Panel provides for a naming convention that groups real and calculated channels 
with a given element name. Has three voltages and three currents associated with it. For 
example, a transmission line, or a transformer.

External Input A contact status brought into TESLA LITE from the outside world. This contact must be 
externally wetted with a voltage from 30 to 150 Vdc. Correct polarity must be observed.

IED Intelligent Electronic Device, referring to a power system substation device which com-
munications on a substation network, such as Modbus.

IEEE 1344 IEEE 1344 is an enhancement to the basic IRIG-B time code that embeds information 
such as the year, the UTC/local offset (under certain conditions only) and daylight sav-
ings time into the time stream. IEEE standard 1344-95, IEEE Standard for Synchro-
phasors for Power Systems, outlines the implementation and use of accurate time 
standards for power systems relaying and recording. Annex F describes an IRIG-B 
extension (using previously unused control bits in the signal) which provides extensive 
information beyond that of standard IRIG-B.

IRIG-B Inter-Range Instrumentation Group time code format type B, see Range Commanders 
Council Telecommunications and Timing Group, IRIG standard 200-95, IRIG Serial Time 
Code Formats. Describes an implementation for distribution of precise timing informa-
tion, especially to power systems relays and recorders. IRIG-B is typically provided by a 
satellite clock (e.g. GPS or GOES).

Master Recorder A member of a Cooperative Recording Group selected to be the primary interface 
between the recorder group and TESLA Control Panel or RecordBase Central Station.

Modbus Modbus is a network using a master/slave protocol often used in power system substa-
tions. Its function was developed and is defined by Modicon, Inc., North Andover, MA, 
USA. Refer to Modbus Protocol Reference Guide, Modicon document PI-MBUS-300.

PTI Power Technologies Incorporated
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Trigger A situation that can initiate a recording.

UTC Universally Coordinated Time. Approximately equivalent to Greenwich Mean Time 
(GMT). A universal time maintained by time standards bodies worldwide. All local times 
are expressed as an offset from UTC.
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Appendix D  Modbus Functions
The TESLA LITE recorder operates as a slave device on the Modbus network, 
with an address of 1 to 247 (decimal), 0x01 to 0xF7. The Point List can be 
printed through TESLA Control Panel to display the point names as they are 
configured. Please refer to “Printing a SCADA Address List” on page 8-46.

For further information on Modbus, please refer to your Modbus master device 
manual, or obtain Modicon’s Modbus Protocol Reference Guide, document PI-
MBUS-300.

Read Coil Status (Function Code 01, 0X References)

Channel Address Value

Hold Readings 00001 0: Readings not held 1:Readings held

Reserved 00257 Reserved

Contact 1 00513 0: Contact open (inactive) 1: Contact closed (active)

Contact 2 00514 0: Contact open (inactive) 1: Contact closed (active)

Contact 3 00515 0: Contact open (inactive) 1: Contact closed (active)

Contact 4 00516 0: Contact open (inactive) 1: Contact closed (active)

Contact 5 00517 0: Contact open (inactive) 1: Contact closed (active)

Contact 6 00518 0: Contact open (inactive) 1: Contact closed (active)

Logic Detector 1 00769 0: Off (inactive) 1: On (active)

Logic Detector 2 00770 0: Off (inactive) 1: On (active)

Logic Detector 3 00771 0: Off (inactive) 1: On (active)

Logic Detector 4 00772 0: Off (inactive) 1: On (active)

Logic Detector 5 00773 0: Off (inactive) 1: On (active)

Logic Detector 6 00774 0: Off (inactive) 1: On (active)

Logic Detector 7 00775 0: Off (inactive) 1: On (active)

Logic Detector 8 00776 0: Off (inactive) 1: On (active)

Logic Detector 9 00777 0: Off (inactive) 1: On (active)

Logic Detector 10 00778 0: Off (inactive) 1: On (active)

Logic Detector 11 00779 0: Off (inactive) 1: On (active)

Logic Detector 12 00780 0: Off (inactive) 1: On (active)

Logic Detector 13 00781 0: Off (inactive) 1: On (active)

Logic Detector 14 00782 0: Off (inactive) 1: On (active)

Logic Detector 15 00783 0: Off (inactive) 1: On (active)

High/low speed recording 
active

01025 0: Off (inactive) 1: On (active)

High/low speed recording 
space nearly full alarm

01026 0: Off (inactive) 1: On (active)

Trend Recording Active 01281 0: Off (inactive) 1: On (active)
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Trend Recording Accumula-
tion Alarm

01282 0: Off (inactive) 1: On (active)

Read Input Status (Function Code 02, 1X References)

Channel Address Value

External I/P 1 10001 0: Off (inactive) 1: On (active)

External I/P 2 10002 0: Off (inactive) 1: On (active)

External I/P 3 10003 0: Off (inactive) 1: On (active)

External I/P 4 10004 0: Off (inactive) 1: On (active)

External I/P 5 10005 0: Off (inactive) 1: On (active)

External I/P 6 10006 0: Off (inactive) 1: On (active)

External I/P 7 10007 0: Off (inactive) 1: On (active)

External I/P 8 10008 0: Off (inactive) 1: On (active)

External I/P 9 10009 0: Off (inactive) 1: On (active)

External I/P 10 10010 0: Off (inactive) 1: On (active)

External I/P 11 10011 0: Off (inactive) 1: On (active)

External I/P 12 10012 0: Off (inactive) 1: On (active)

External I/P 13 10013 0: Off (inactive) 1: On (active)

External I/P 14 10014 0: Off (inactive) 1: On (active)

External I/P 15 10015 0: Off (inactive) 1: On (active)

External I/P 16 10016 0: Off (inactive) 1: On (active)

External I/P 17 10017 0: Off (inactive) 1: On (active)

External I/P 18 10018 0: Off (inactive) 1: On (active)

External I/P 19 10019 0: Off (inactive) 1: On (active)

External I/P 20 10020 0: Off (inactive) 1: On (active)

External I/P 21 10021 0: Off (inactive) 1: On (active)

External I/P 22 10022 0: Off (inactive) 1: On (active)

External I/P 23 10023 0: Off (inactive) 1: On (active)

External I/P 24 10024 0: Off (inactive) 1: On (active)

External I/P 25 10025 0: Off (inactive) 1: On (active)

External I/P 26 10026 0: Off (inactive) 1: On (active)

External I/P 27 10027 0: Off (inactive) 1: On (active)

External I/P 28 10028 0: Off (inactive) 1: On (active)

External I/P 29 10029 0: Off (inactive) 1: On (active)

External I/P 30 10030 0: Off (inactive) 1: On (active)

External I/P 31 10031 0: Off (inactive) 1: On (active)

External I/P 32 10032 0: Off (inactive) 1: On (active)

External I/P33 10033 0: Off (inactive) 1: On (active)

External I/P 34 10034 0: Off (inactive) 1: On (active)
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External I/P 35 10035 0: Off (inactive) 1: On (active)

External I/P 36 10036 0: Off (inactive) 1: On (active)

External I/P 37 10037 0: Off (inactive) 1: On (active)

External I/P 38 10038 0: Off (inactive) 1: On (active)

External I/P1 Change latch 10257 0: Off (no change) 1: On (change) 

External I/P 2 Change latch 10258 0: Off (no change) 1: On (change) 

External I/P 3 Change latch 10259 0: Off (no change) 1: On (change) 

External I/P 4 Change latch 10260 0: Off (no change) 1: On (change) 

External I/P 5 Change latch 10261 0: Off (no change) 1: On (change) 

External I/P 6 Change latch 10262 0: Off (no change) 1: On (change) 

External I/P 7 Change latch 10263 0: Off (no change) 1: On (change) 

External I/P 8 Change latch 10264 0: Off (no change) 1: On (change) 

External I/P 9 Change latch 10265 0: Off (no change) 1: On (change) 

External I/P 10 Change latch 10266 0: Off (no change) 1: On (change) 

External I/P 11Change latch 10267 0: Off (no change) 1: On (change) 

External I/P 12 Change latch 10268 0: Off (no change) 1: On (change) 

External I/P 13 Change latch 10269 0: Off (no change) 1: On (change) 

External I/P 14 Change latch 10270 0: Off (no change) 1: On (change) 

External I/P 15 Change latch 10271 0: Off (no change) 1: On (change) 

External I/P 16 Change latch 10272 0: Off (no change) 1: On (change) 

External I/P 17 Change latch 10273 0: Off (no change) 1: On (change) 

External I/P 18 Change latch 10274 0: Off (no change) 1: On (change) 

External I/P 19 Change latch 10275 0: Off (no change) 1: On (change) 

External I/P 20 Change latch 10276 0: Off (no change) 1: On (change) 

External I/P 21 Change latch 10277 0: Off (no change) 1: On (change) 

External I/P 22 Change latch 10278 0: Off (no change) 1: On (change) 

External I/P 23 Change latch 10279 0: Off (no change) 1: On (change) 

External I/P 24 Change latch 10280 0: Off (no change) 1: On (change) 

External I/P 25 Change latch 10281 0: Off (no change) 1: On (change) 

External I/P 26 Change latch 10282 0: Off (no change) 1: On (change) 

External I/P 27 Change latch 10283 0: Off (no change) 1: On (change) 

External I/P 28 Change latch 10284 0: Off (no change) 1: On (change) 

External I/P 29 Change latch 10285 0: Off (no change) 1: On (change) 

External I/P 30 Change latch 10286 0: Off (no change) 1: On (change) 

External I/P 31 Change latch 10287 0: Off (no change) 1: On (change) 

External I/P 32 Change latch 10288 0: Off (no change) 1: On (change) 

External I/P 33 Change latch 10289 0: Off (no change) 1: On (change) 

External I/P 34 Change latch 10290 0: Off (no change) 1: On (change) 

External I/P 35 Change latch 10291 0: Off (no change) 1: On (change) 

External I/P 36 Change latch 10292 0: Off (no change) 1: On (change) 
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External I/P 37 Change latch 10293 0: Off (no change) 1: On (change) 

External I/P 38 Change latch 10294 0: Off (no change) 1: On (change) 

Read Holding Register (Function Code 03, 4X References

Channel Address Value Scaled up by

Tesla Clock Time (UTC). Read all in same query to ensure consistent time reading data

Milliseconds Now 40001 0-999 1

Seconds Now 40002 0-59 1

Minutes Now 40003 0-59 1

Hours Now 40004 0-23 1

Day of Year Now 40005 1-365 (up to 366 if leap year) 1

Years since 1900 40006 90-137 1

Sync’d to IRIG-B 40007 0: No, 1: Yes 1

Time of Acquisition (UTC). Read all in same query to ensure consistent time reading data

Milliseconds Acquisition 40008 0-999 1

Seconds Acquisition 40009 0-59 1

Minutes Acquisition 40010 0-59 1

Hours Acquisition 40011 0-23 1

Day of Year Acquisition 40012 1-365 (up to 366 if leap year) 1

Years since 1900 40013 90-137 1

Acquisition Time Sync’d 
to IRIG-B

40014 0: No
1: Yes

1

Offset of UTC to IED 
Local Time

40015 2’s complement half hours, North America is 
negative

1

Analog Magnitude and Angle Metering Channels

Channel Address Value Scaled up by

AI1 Magnitude 40257 0 to 3276.7 units 10

AI1 Angle 40258 -180° to 180° 10

AI2 Magnitude 40259 0 to 3276.7 units 10

AI2 Angle 40260 -180° to 180° 10

AI3 Magnitude 40261 0 to 3276.7 units 10

AI3 Angle 40262 -180° to 180° 10

AI4 Magnitude 40263 0 to 3276.7 units 10

AI4 Angle 40264 -180° to 180° 10

AI5 Magnitude 40265 0 to 3276.7 units 10

AI5 Angle 40266 -180° to 180° 10

AI6 Magnitude 40267 0 to 3276.7 units 10
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AI6 Angle 40268 -180° to 180° 10

AI7 Magnitude 40269 0 to 3276.7 units 10

AI7 Angle 40270 -180° to 180° 10

AI8 Magnitude 40271 0 to 3276.7 units 10

AI8 Angle 40272 -180° to 180° 10

AI9 Magnitude 40273 0 to 3276.7 units 10

AI9 Angle 40274 -180° to 180° 10

AI10 Magnitude 40275 0 to 3276.7 units 10

AI10 Angle 40276 -180° to 180° 10

AI11 Magnitude 40277 0 to 3276.7 units 10

AI11 Angle 40278 -180° to 180° 10

AI12 Magnitude 40279 0 to 3276.7 units 10

AI12 Angle 40280 -180° to 180° 10

AI13 Magnitude 40281 0 to 3276.7 units 10

AI13 Angle 40282 -180° to 180° 10

AI14 Magnitude 40283 0 to 3276.7 units 10

AI14 Angle 40284 -180° to 180° 10

AI15 Magnitude 40285 0 to 3276.7 units 10

AI15 Angle 40286 -180° to 180° 10

AI16 Magnitude 40287 0 to 3276.7 units 10

AI16 Angle 40288 -180° to 180° 10

AI17 Magnitude 40289 0 to 3276.7 units 10

AI17 Angle 40290 -180° to 180° 10

AI18 Magnitude 40291 0 to 3276.7 units 10

AI18 Angle 40292 -180° to 180° 10

Total Harmonic Distortion, Single Harmonic Level Metering Channels

* not supported yet

AI1 THD 40513 0 to 327.67% 100

AI1 SHL 40514 0 to 327.67% 100

AI2 THD 40515 0 to 327.67% 100

AI2 SHL 40516 0 to 327.67% 100

AI3 THD 40517 0 to 327.67% 100

AI3 SHL 40518 0 to 327.67% 100

AI4 THD 40519 0 to 327.67% 100

AI4 SHL 40520 0 to 327.67% 100

AI5 THD 40521 0 to 327.67% 100

AI5 SHL 40522 0 to 327.67% 100

AI6 THD 40523 0 to 327.67% 100

AI6 SHL 40524 0 to 327.67% 100

AI7 THD 40525 0 to 327.67% 100
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AI7 SHL 40526 0 to 327.67% 100

AI8 THD 40527 0 to 327.67% 100

AI8 SHL 40528 0 to 327.67% 100

AI9 THD 40529 0 to 327.67% 100

AI9 SHL 40530 0 to 327.67% 100

AI10 THD 40531 0 to 327.67% 100

AI10 SHL 40532 0 to 327.67% 100

AI11 THD 40533 0 to 327.67% 100

AI11 SHL 40534 0 to 327.67% 100

AI12 THD 40535 0 to 327.67% 100

AI12 SHL 40536 0 to 327.67% 100

AI13 THD 40537 0 to 327.67% 100

AI13 SHL 40538 0 to 327.67% 100

AI14 THD 40539 0 to 327.67% 100

AI14 SHL 40540 0 to 327.67% 100

AI15 THD 40541 0 to 327.67% 100

AI15 SHL 40542 0 to 327.67% 100

AI16 THD 40543 0 to 327.67% 100

AI16 SHL 40544 0 to 327.67% 100

AI17 THD 40545 0 to 327.67% 100

AI17 SHL 40546 0 to 327.67% 100

AI18 THD 40547 0 to 327.67% 100

AI18 SHL 40548 0 to 327.67% 100

Summation Metering Channels

SUM1 Magnitude 40769 0 to 3276.7 units 10

SUM1 Angle 40770 -180° to 180° 10

SUM2 Magnitude 40771 0 to 3276.7 units 10

SUM2 Angle 40772 -180° to 180° 10

SUM3 Magnitude 40773 0 to 3276.7 units 10

SUM3 Angle 40774 -180° to 180° 10

SUM4 Magnitude 40775 0 to 3276.7 units 10

SUM4 Angle 40776 -180° to 180° 10

SUM5 Magnitude 40777 0 to 3276.7 units 10

SUM5 Angle 40778 -180° to 180° 10

SUM6 Magnitude 40779 0 to 3276.7 units 10

SUM6 Angle 40780 -180° to 180° 10

SUM7 Magnitude 40781 0 to 3276.7 units 10

SUM7 Angle 40782 -180° to 180° 10

SUM8 Magnitude 40783 0 to 3276.7 units 10

SUM8 Angle 40784 -180° to 180° 10
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SUM9 Magnitude 40785 0 to 3276.7 units 10

SUM9 Angle 40786 -180° to 180° 10

SUM10 Magnitude 40787 0 to 3276.7 units 10

SUM10 Angle 40788 -180° to 180° 10

Sequence Metering Channels

SEQ1 Positive 41025 0 to 3276.7 units 10

SEQ1 Negative 41026 0 to 3276.7 units 10

SEQ1 Zero 41027 0 to 3276.7 units 10

SEQ2 Positive 41028 0 to 3276.7 units 10

SEQ2 Negative 41029 0 to 3276.7 units 10

SEQ2 Zero 41030 0 to 3276.7 units 10

SEQ3 Positive 41031 0 to 3276.7 units 10

SEQ3 Negative 41032 0 to 3276.7 units 10

SEQ3 Zero 41033 0 to 3276.7 units 10

SEQ4 Positive 41034 0 to 3276.7 units 10

SEQ4 Negative 41035 0 to 3276.7 units 10

SEQ4 Zero 41036 0 to 3276.7 units 10

SEQ5 Positive 41037 0 to 3276.7 units 10

SEQ5 Negative 41038 0 to 3276.7 units 10

SEQ5 Zero 41039 0 to 3276.7 units 10

SEQ6 Positive 41040 0 to 3276.7 units 10

SEQ6 Negative 41041 0 to 3276.7 units 10

SEQ6 Zero 41042 0 to 3276.7 units 10

Watts/Vars Metering Channels

WV1 P 41281 -3276.8 to 3276.7 W 10

WV1 Q 41282 -3276.8 to 3276.7 Var 10

WV1 S 41283 0 to 3276.7 VA 10

WV2 P 41284 -3276.8 to 3276.7 W 10

WV2 Q 41285 -3276.8 to 3276.7 Var 10

WV2 S 41286 0 to 3276.7 VA 10

WV3 P 41287 -3276.8 to 3276.7 W 10

WV3 Q 41288 -3276.8 to 3276.7 Var 10

WV3 S 41289 0 to 3276.7 VA 10

WV4 P 41290 -3276.8 to 3276.7 W 10

WV4 Q 41291 -3276.8 to 3276.7 Var 10

WV4 S 41292 0 to 3276.7 VA 10

WV5 P 41293 -3276.8 to 3276.7 W 10

WV5 Q 41294 -3276.8 to 3276.7 Var 10

WV5 S 41295 0 to 3276.7 VA 10

Frequency Metering Channels
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Channel Group 1 Frequency 41537 5/6 f_nominal to 7/6 nominal fre-
quency

100

Impedance Metering Channels

Impedance 1Magnitude 41793 0 to 3276.7 ohm 10

Impedance 1 Angle 41794 -180° to 180° 10

Impedance2 Magnitude 41795 0 to 3276.7 ohm 10

Impedance 2 Angle 41796 -180° to 180° 10

Impedance 3 Magnitude 41797 0 to 3276.7 ohm 10

Impedance 3 Angle 41798 -180° to 180° 10

Impedance 4 Magnitude 41799 0 to 3276.7 ohm 10

Impedance 4 Angle 41800 -180° to 180° 10

Impedance 5 Magnitude 41801 0 to 3276.7 ohm 10

Impedance 5 Angle 41802 -180° to 180° 10

Event Information (See Accessing 
TESLA Event Information below)

42052 – 42144

Length (in 16 bit registers) of the cur-
rent event message 

42052

Event Identification  42053

Event Message 42054–42137

Fault Locator ID 42138

Fault Type 42139

Fault Distance 42140 10

Fault Time 42141 – 42144

Power Factor Function 1 Level 42305 0.0 to 1.0 100

Power Factor Function 2 Level 42306 0.0 to 1.0 100

Power Factor Function 3 Level 42307 0.0 to 1.0 100

Power Factor Function 4 Level 42308 0.0 to 1.0 100

Power Factor Function 5 Level 42309 0.0 to 1.0 100

High/low speed recording space used 42561 0.0 to 100.0 10

Trend Recording Days Accumulated 42817 0 to 90 1

Read Input Register (Function Code 04)

No input registers supported. Response from IED indicates “ILLEGAL FUNCTION.”

Force Single Coil (Function Code 05)

Only the “hold readings” coil can be forced. When active, this coil locks all coil, input and holding register readings simul-
taneously at their present values. When inactive, coil, input and holding register values will read their most recently avail-
able state.

Channel Type Address Value
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Hold Readings Read/Write 01 0000: Readings update normally (inactive)
FF00: Hold readings (active)
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   •  The TESLA LITE IED model number is 4001.

   •  Version and issue will each be positive integers, say X and Y.

   •  The TESLA LITE is defined as “Model 4001, Version X Issue Y”

Preset Single Register (Function Code 06)

Channel Address Value Scaled Up By

Event Information (See Accessing TESLA Event Infor-
mation, below)

42099 – 42051

Refresh event list 42049 No data required N/A

Acknowledge the current event and get the next event 42050 No data required N/A

Get the next event (without acknowledge) 42051 No data required N/A

Diagnostic Subfunctions (Function Code 08)

Return Query Data (Subfunction 00) This provides an echo of the submitted message.

Restart Comm. Option (Subfunction 01) This restarts the Modbus communications process.

Force Listen Only Mode (Subfunction 04) No response is returned. IED enters “Listen Only” mode. This 
mode can only be exited by the “Restart Comm. Option” com-
mand.

Report Slave ID (Function Code 17/0x11)

A fixed response is returned by the IED, including system model, version and issue numbers.

Channel Type Bytes Value

Model Number Read Only 0 and 1 0x07D00 = 2000 decimal

Version Number Read Only 2 and 3 Version number

Issue Number Read Only 4 and 5 Issue number
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Accessing TESLA LITE Event Information

All TESLA LITE detector event messages displayed in the Event Log are available via Modbus. This includes fault location infor-
mation. The following controls are available.

Refresh Event List (Function Code 6, address 42049): Fetches the latest events from the TESLA's event log and 
makes them available for Modbus access. The most recent event becomes the current event 
available for reading.

Acknowledge Current Event 
and Get Next Event

(Function Code 6, address 42050): Clears the current event from the read registers and 
places the next event into them. An acknowledged event is no longer available for reading.

Get Next Event (Function Code 6, address 42051): Places the next event in the read registers without 
acknowledging the current event. The current event will reappear in the list when Refresh 
Event List is used.

Size of Current Event 
Message

(Function Code 3, address 42052): Indicates the number of 16 bit registers used to contain 
the current event. Event data is stored with two characters per register. A reading of zero indi-
cates that there are no unacknowledged events available in the current set. (NB. The Refresh 
Event List function can be used to check for new events that have occurred since the last 
Refresh Event List.)

Fault Location Event Preset 
When Set to 0x464C

(Function Code 3, address 42053): Identifies fault location events. These events are identified 
by “FL” (0x464C) in this register. Non-fault location events contain “ ” in this location.

Read Event Message (Function Code 3, addresses 42054 - 42137): Contains the current event message. Two 
ASCII characters are packed into each 16 bit register. All unused registers in the set are set to 
0.

Fault Location – Fault Locator 
ID

(Function Code 3, address 42138): If the current event is a fault location event, this register 
contains the ID of the fault locator. The numbers from 1 to 5 are used for 18-channel record-
ers; the numbers from 1 to 10 are used for 36-channel recorders.

Fault Information – Type (Function Code 3, address 42139): If the current event is a fault location event, this register 
contains the type of the fault. 
The following type bitmap:
0x0001 - Phase A
0x0002 - Phase B
0x0004 - Phase C
0x0008 - Ground
Any number of the flags may be set for a given fault. If recorder could not determine the fault 
type, then the register will not have any flags set and will read 0x0000.

Fault Information – Fault 
Distance

(Function Code 3, address 42140): If the current event is a fault location event, this register 
contains the distance to the fault. It is scaled up by a factor of 10. The units are the same as 
the units set in the relay configuration.

Fault Information –Time of 
Fault

(Function Code 3, addresses 42141 and 42144): If the current event is a fault location event, 
these registers contain the time of the fault in seconds since 1970. Each of these 16-bit regis-
ters contains an 8-bit portion of a 32-bit time value. Register 42141 contains the upper 16 bits, 
register 42144 contains the lower 16 bits.
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Register Value Meaning

High Byte Low Byte

42052 0x00 0x1B Event text size = 27 (0x1B hex)

42053 0x46 0x4C ‘F,L’ - Fault locator event

42054 0x32 0x30 ‘2’, ‘0’

42055 0x30 0x30 ‘0’, ‘0’

42056 0x53 0x65 ‘S’, ‘e’

42057 0x70 0x32 ‘p’, ‘2’

42058 0x31 0x20 ‘1’, ‘ ’

42059 0x32 0x30 ‘2’, ‘0’

42060 0x3A 0x31 ‘:’, ‘1’

42061 0x36 0x3A ‘6’, ‘:’

42062 0x31 0x36 ‘1’, ‘6’

42063 0x2E 0x39 ‘.’, ‘9’

42064 0x36 0x36 ‘6’, ‘6’

42065 0x20 0x3A ‘ ’, ‘:’

42066 0x20 0x4C ‘ ’, ‘L’ 

42067 0x69 0x6E ‘i’, ‘n’ 

42068 0x65 0x20 ‘e’, ‘ ‘

42069 0x31 0x36 ‘1’, ‘6’

42070 0x3A 0x46 ‘:’, ‘F’

42071 0x4C 0x6F ‘L’, ‘o’

42072 0x63 0x20 ‘c’, ‘ ‘

42073 0x42 0x47 ‘B’, ‘G’

42074 0x20 0x33 ‘ ’, ‘3’

42075 0x39 0x2E ‘9’, ‘.’

42076 0x37 0x20 ‘7’, ‘ ‘

42077 0x6D 0x69 ‘m’, ‘i’

42078 0x6C 0x65 ‘l’, ‘e’

42079 0x73 0x00 ‘s’
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Device 
Properties

This document shows the device capabilities and the current value of each pa-
rameter for the default unit configuration as defined in the default configura-
tion file. 

1.1 Device Identification Capabilities Current Value
If configurable, 
list methods

1.1.1 Device Function: ○ Master

● Outstation

○ Master

● Outstation

1.1.2 Vendor Name: ERLPhase 
Power Technolo-
gies Ltd.

1.1.3 Device Name: TESLA LITE

1.1.4 Device manufacturer's 
hardware version string:

NA

1.1.5 Device manufacturer's 
software version string:

NA

1.1.6 Device Profile 
Document Version 
Number:

V01.0, May 17, 
2011

1.1.7 DNP Levels Supported 
for:

Masters Only
Requests                 Responses
                                             None
                                             Level 1
                                             Level 2
                                             Level 3

Outstations Only
Requests and Responses
          None
          Level 1
          Level 2
          Level 3

1.1.8 Supported Function 
Blocks:

 Self-Address Reservation
 Object 0 - attribute objects
 Data Sets
 File Transfer
 Virtual Terminal 
 Mapping to IEC 61850 Object Models defined in 

a DNP3 XML file
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1.1.9 Notable Additions:    •  Start-stop (qualifier codes 0x00 and 0x01), limited 
quantity (qualifier codes 0x07 and 0x08) and indi-
ces (qualifier codes 0x17 and 0x28) for Binary In-
puts, Binary Outputs and Analog Inputs (object 
groups 1, 10 and 30)

   •  32-bit and 16-bit Analog Inputs with and without 
flag (variations 1, 2, 3 and 4)

   •  Analog Input events with time (variations 3 and 4)

   •  Fault Location information as analog readings 

   •  Event Log messages as Object groups 110 and 
111

1.1.10 Methods to set 
Configurable 
Parameters:

 XML - Loaded via DNP3 File Transfer
 XML - Loaded via other transport mechanism
 Terminal - ASCII Terminal Command Line
 Software - Vendor software named TESLA 

Control Panel
 Proprietary file loaded via DNP3 file transfer
 Proprietary file loaded via other transport mech-

anism
 Direct - Keypad on device front panel
 Factory - Specified when device is ordered 
 Protocol - Set via DNP3 (e.g. assign class)
 Other - explain _________________

Not supported

1.1.11 DNP3 XML files 
available On-Line:

RdWrFilenameDescription of Contents

 dnpDP.xml Complete Device Profile 
 dnpDPcap.xml Device Profile Capabilities
 dnpDPcfg.xml Device Profile config. 
          values
   _____*.xml ___________________

*The Complete Device Profile Document contains 
the capabilities, Current Value, and configurable 
methods columns.

*The Device Profile Capabilities contains only the 
capabilities and configurable methods columns.

*The Device Profile Config. Values contains only the 
Current Value column.

Not supported

1.1.12 External DNP3 XML 
files available Off-line:

Rd  Wr     Filename Description of Contents
  dnpDP.xml Complete Device Profile 
  dnpDPcap.xml Device Profile Capabilities
  dnpDPcfg.xml Device Profile config. 
         values
  _______*.xml ___________________

*The Complete Device Profile Document contains 
the capabilities, Current Value, and configurable 
methods columns.

*The Device Profile Capabilities contains only the 
capabilities and configurable methods columns.

*The Device Profile Config. Values contains only the 
Current Value column.

Not supported

1.1.13 Connections 
Supported:

 Serial (complete section 1.2)
 IP Networking (complete section 1.3)
 Other, explain ______________________

1.1 Device Identification Capabilities Current Value
If configurable, 
list methods
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1.2 Serial Connections Capabilities Current Value
If configurable, 
list methods

1.2.1 Port Name SCADA (Port 414)

1.2.2 Serial Connection 
Parameters:

 Asynchronous - 8 Data Bits, 1 Start Bit, 1 Stop 
Bit, No Parity

 Other, explain - Asynchronous with selectable 
parity

Not configured 
for DNP

TESLA Control 
Panel 

1.2.3 Baud Rate:  Fixed at _______
 Configurable, range _______ to _______
 Configurable, selectable from 300, 1200, 2400, 

9600, 19200, 38400 and 57600
 Configurable, other, describe_______________

Not configured 
for DNP

TESLA Control 
Panel 

1.2.4 Hardware Flow Control 
(Handshaking):

Describe hardware signaling 
requirements of the interface.
Where a transmitter or receiver 
is inhibited until a given control 
signal is asserted, it is consid-
ered to require that signal prior 
to sending or receiving charac-
ters.
Where a signal is asserted prior 
to transmitting, that signal will 
be maintained active until after 
the end of transmission.
Where a signal is asserted to 
enable reception, any data sent 
to the device when the signal is 
not active could be discarded.

 None
RS-232 / V.24 / V.28 Options:
   Before Tx, Asserts:        RTS
                                          DTR
   Before Rx, Asserts:        RTS
                                          DTR
   Always Asserts:              RTS
                                          DTR
   Before Tx, Requires:  Asserted      Deasserted
                                          CTS
                                          DCD
                                          DSR
                                          RI
                                          Rx Inactive
   Before Rx, Requires:  Asserted      Deasserted
                                          CTS
                                          DCD
                                          DSR
                                          RI
   Always Ignores:
                                                               CTS
                                                               DCD
                                                               DSR
                                                               RI

 Other, explain ____________
RS-422 / V.11 Options:
 Requires Indication before Rx
 Asserts Control before Tx
 Other, explain ____________
RS-485 Options:
 Requires Rx inactive before Tx 
 Other, explain ____________

1.2.5 Interval to Request Link 
Status:

 Not Supported
 Fixed at_________ seconds
 Configurable, range _____ to ______ seconds
 Configurable, selectable from __,__,__ seconds
 Configurable, other, describe______________

1.2.6 Supports DNP3 
Collision Avoidance:

 No
 Yes, explain ______________________
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1.2.7 Receiver Inter-
character Timeout:

 Not checked
 No gap permitted
 Fixed at _____ bit times
 Fixed at _____ ms
 Configurable, range ____ to ____ bit times
 Configurable, range ____ to ____ ms
 Configurable, Selectable from __,__,__bit times
 Configurable, Selectable from ___, ___, ___ ms 
 Configurable, other, describe______________
 Variable, explain ____

1.2.8 Inter-character gaps in 
transmission:

 None (always transmits with no inter-character 
gap)

 Maximum _____ bit times
 Maximum _____ ms

1.2 Serial Connections Capabilities Current Value
If configurable, 
list methods
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1.3 IP Networking Capabilities Current Value
If configurable, 
list methods

1.3.1 Port Name Port 411 or Port 412

1.3.2 Type of End Point:  TCP Initiating (Master Only)
 TCP Listening (Outstation Only)
 TCP Dual (required for Masters)
 UDP Datagram (required)

Not configured 
for DNP

TESLA Control 
Panel

1.3.3 IP Address of this 
Device:

192.168.100.10
1

TESLA LITE 
Maintenance 
utilities

1.3.4 Subnet Mask: Not set TESLA LITE 
Maintenance 
utilities

1.3.5 Gateway IP Address: Not set TESLA LITE 
Maintenance 
utilities

1.3.6 Accepts TCP 
Connections or UDP 
Datagrams from:

 Allows all (show as *.*.*.* in 1.3.7)
 Limits based on an IP address
 Limits based on list of IP addresses
 Limits based on a wildcard IP address
 Limits based on list of wildcard IP addresses
 Other validation, explain_________________

Limits based on 
an IP address

TESLA Control 
Panel

1.3.7 IP Address(es) from 
which TCP Connections 
or UDP Datagrams are 
accepted:

192.168.1.1 TESLA Control 
Panel

1.3.8 TCP Listen Port 
Number:

 Not Applicable (Master w/o dual end point)
 Fixed at 20,000
 Configurable, range 1025 to 32737
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

20,000 TESLA Control 
PanelTESLA 
Control Panel

1.3.9 TCP Listen Port 
Number of remote 
device:

 Not Applicable (Outstation w/o dual end point)
 Fixed at 20,000
 Configurable, range _______ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

NA

1.3.10 TCP Keep-alive timer:  Fixed at ___________ms
 Configurable, range 5 to 3,600 s
 Configurable, selectable from ___,___,___ms
 Configurable, other, describe______________

Disabled TESLA Control 
Panel

1.3.11 Local UDP port:  Fixed at 20,000
 Configurable, range 1025 to 32737
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________
 Let system choose (Master only)

20,000 TESLA Control 
Panel

1.3.12 Destination UDP port 
for DNP3 Requests 
(Master Only):

NA
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1.3.13 Destination UDP port 
for initial unsolicited null 
responses (UDP only 
Outstations):

 None
 Fixed at 20,000
 Configurable, range _______ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

NA

1.3.14 Destination UDP port 
for responses:

 None
 Fixed at 20,000
 Configurable, range 1025 to 32737
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________
 Use source port number

20,000 TESLA Control 
Panel

1.3.15 Multiple master 
connections 
(Outstations Only):

 Supports multiple masters (Outstations only)
If supported, the following methods may be used:
 Method 1 (based on IP address) - required
 Method 2 (based on IP port number) - 

recommended
 Method 3 (browsing for static data) - optional

Method 1 (based 
on IP address)

TESLA Control 
Panel

1.3.16 Time synchronization 
support:

 DNP3 LAN procedure (function code 24)
 DNP3 Write Time (not recommended over LAN)
 Other, explain _________________________
 Not Supported

1.3 IP Networking Capabilities Current Value
If configurable, 
list methods
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1.4 Link Layer Capabilities Current Value
If configurable, 
list methods

1.4.1 Data Link Address:  Fixed at______
 Configurable, range 1 to 65519
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

1 TESLA Control 
Panel

1.4.2 DNP3 Source Address 
Validation:

 Never
 Always, one address allowed (shown in 1.4.3)
 Always, any one of multiple addresses allowed
 (each selectable as shown in 1.4.3)
 Sometimes, explain________________

1.4.3 DNP3 Source 
Address(es) expected 
when Validation is 
Enabled:

 Configurable to any 16 bit DNP Data Link 
Address value

 Configurable, range _______ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

NA

1.4.4 Self Address Support 
using address 0xFFFC:

 Yes (only allowed if configurable)
 No

NA

1.4.5 Sends Confirmed User 
Data Frames:

 Always
 Sometimes, explain _____________________
 Never
 Configurable, either always or never

TESLA Control 
Panel
(to disable, set 
Data Link Time-
out to 0)

1.4.6 Data Link Layer 
Confirmation Timeout:

  None
  Fixed at _ ms
S Configurable, range __0____ to 2,000 ms
  Configurable, selectable from ___,___,___ms
  Configurable, other, 

describe________________
  Variable, explain _______________________

1,000

1.4.7 Maximum Data Link 
Retries:

 Never Retries
 Fixed at 3
 Configurable, range ________ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

3

1.4.8 Maximum number of 
octets Transmitted in a 
Data Link Frame: 

 Fixed at 292
 Configurable, range ________ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

292

1.4.9 Maximum number of 
octets that can be 
Received in a Data Link 
Frame:

 Fixed at 292
 Configurable, range ________ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

292
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1.5 Application Layer Capabilities Current Value
If configurable, 
list methods

1.5.1 Maximum number of 
octets Transmitted in an 
Application Layer 
Fragment other than 
File Transfer:

 Fixed at 2048
 Configurable, range ________ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

2048

1.5.2 Maximum number of 
octets Transmitted in an 
Application Layer 
Fragment containing 
File Transfer:

 Fixed at ___________
 Configurable, range ________ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

NA

1.5.3 Maximum number of 
octets that can be 
Received in an 
Application Layer 
Fragment:

 Fixed at 2048
 Configurable, range ________ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________

2048

1.5.4 Timeout waiting for 
Complete Application 
Layer Fragment:

 None
 Fixed at 2,000 ms
 Configurable, range _______ to _______ms
 Configurable, selectable from ___,___,___ms
 Configurable, other, describe______________
 Variable, explain _______________________

2,000 ms

1.5.5 Maximum number of 
objects allowed in a 
single control request 
for CROB (group 12):

 Fixed at 16
 Configurable, range ________ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________
 Variable, explain _______________________

16

1.5.6 Maximum number of 
objects allowed in a 
single control request 
for Analog Outputs 
(group 41):

 Fixed at _ 
 Configurable, range ________ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________
 Variable, explain _______________________

Analog Outputs 
not supported

1.5.7 Maximum number of 
objects allowed in a 
single control request 
for Data Sets (groups 
85,86,87):

 Fixed at __
 Configurable, range ________ to _______
 Configurable, selectable from ____,____,____
 Configurable, other, describe______________
 Variable, explain _______________________

Data Sets not 
supported

1.5.8 Supports mixing object 
groups (AOBs, CROBs 
and Data Sets) in the 
same control request:

 Not applicable - controls are not supported
 Yes
 No

Analog Outputs 
not supported
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1.6 Fill Out The Following 
Items For Outstations 
Only

Capabilities Current Value
If configurable, 
list methods

1.6.1 Timeout waiting for 
Application Confirm of 
solicited response 
message:

 None
 Fixed at 5,000 ms
 Configurable, range _______ to _______ms
 Configurable, selectable from ___,___,___ms
 Configurable, other, describe______________
 Variable, explain _______________________

5,000 ms

1.6.2 How often is time 
synchronization 
required from the 
master?

 Never needs time
 Within ______ seconds after IIN1.4 is set
 Periodically every _______ seconds

1.6.3 Device Trouble Bit 
IIN1.6:

 Never used
 Reason for setting: Unable to access requested 

data or execute CROB, assuming a valid 
request has been received

1.6.4 File Handle Timeout:  Not applicable, files not supported
 Fixed at______ ms
 Configurable, range _______ to _______ms
 Configurable, selectable from ___,___,___ms
 Configurable, other, describe______________
 Variable, explain _______________________

1.6.5 Event Buffer Overflow 
Behaviour:

 Discard the oldest event 
 Discard the newest event
 Other, explain _________________________

1.6.6 Event Buffer 
Organization:

   •  Single buffer for the Object Groups 2 and 32, size 
200.

   •  Separate buffer for the Object Group 111, size 
100.

   •  Separate buffer for the Fault Locator events, size 
100.

1.6.7 Sends Multi-Fragment 
Responses:

 Yes
 No

1.6.8 DNP Command 
Settings preserved 
through a device reset:

 Assign Class
 Analog Deadbands
 Data Set Prototypes
 Data Set Descriptors

Not supported
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1.7 Outstation Unsolicited 
Response Support

Capabilities Current Value
If configurable, 
list methods

1.7.1 Supports Unsolicited 
Reporting:

 Not Supported
 Configurable, selectable from On and Off

NA
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1.8 Outstation Performance Capabilities Current Value
If configurable, 
list methods

1.8.1 Maximum Time Base 
Drift (milliseconds per 
minute): 

NA, not synchro-
nized by DNP

1.8.2 When does outstation 
set IIN1.4?

 Never
 Asserted at startup until first Time Synchroniza-

tion request received
 Periodically, range ____to____ seconds
 Periodically, selectable from ____,____,___ 

seconds
 Range ____to____ seconds after last time sync
 Selectable from___,___,___seconds after last 

time sync
 When time error may have drifted by range 

____to____ ms
 When time error may have drifted by selectable 

from ____,____,___

NA

1.8.3 Maximum Internal Time 
Reference Error when 
set via DNP (ms):

NA

1.8.4 Maximum Delay 
Measurement error 
(ms):

NA

1.8.5 Maximum Response 
time (ms):

100 ms (for the 
case all sup-
ported points 
mapped to the 
DNP point lists) 

TESLA Control 
Panel

1.8.6 Maximum time from 
start-up to IIN 1.4 
assertion (ms):

NA

1.8.7 Maximum Event Time-
tag error for local Binary 
and Double-bit I/O (ms):

   •  0.1736 ms for 
60Hz sys-
tems

   •  0.2083 ms for 
50 Hz sys-
tems

1.8.8 Maximum Event Time-
tag error for local I/O 
other than Binary and 
Double-bit data types 
(ms):

   •  0.1736 ms for 
60Hz sys-
tems

   •  0.2083 ms for 
50 Hz sys-
tems
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Capabilities and 
Current 
Settings for 
Device 
Database 

The following tables identify the capabilities and current settings for each 
DNP3 data type. Each data type also provides a table defining the data points 
available in the device or a description of how this information can be obtained 
if the database is configurable.

2.1 Single-Bit Binary Inputs
Static (Steady-State) Group Number: 1
Event Group Number: 2

Capabilities Current Value
If configurable, 
list methods

2.1.1 Static Variation reported 
when variation 0 
requested:

 Variation 1 - Single-bit Packed format
 Variation 2 - Single-bit with flag
 Based on point Index (add column to table 

below)

2.1.2 Event Variation 
reported when variation 
0 requested:

 Variation 1 - without time
 Variation 2 - with absolute time
 Variation 3 - with relative time
 Based on point Index (add column to table 

below)

2.1.3 Event reporting mode:  Only most recent
 All events

2.1.4 Binary Inputs included 
in Class 0 response:

 Always
 Never
 Only if point is assigned to Class 1, 2, or 3
 Based on point Index (add column to table 

below)

TESLA Control 
Panel

2.1.5 Definition of Binary 
Input Point List:

 Fixed, list shown in table below
 Configurable
 Other, explain_____________________

Complete list is 
shown in the 
table below; 
points excluded 
from the default 
configuration are 
marked with '*'

TESLA Control 
Panel

NOTES

1. Binary Inputs are scanned with 1 ms resolution.

2. Binary Input data points are user selectable; the data points available in the 
device for any given Binary Input point selection can be obtained through the 
TESLA Control Panel software (see SCADA Setting Summary).

Point 
Index

Name
Default Class
Assigned to Events
(1, 2, 3 or none)

Name for 
State when 
value is 0

Name for 
State when 
value is 1

Description

0 External Input 1 1 Inactive Active

1 External Input 2 1 Inactive Active

2 External Input 3 1 Inactive Active

3 External Input 4 1 Inactive Active
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4 External Input 5 1 Inactive Active

5 External Input 6 1 Inactive Active

6 External Input 7 1 Inactive Active

7 External Input 8 1 Inactive Active

8 External Input 9 1 Inactive Active

9 External Input 10 1 Inactive Active

10 External Input 11 1 Inactive Active

11 External Input 12 1 Inactive Active

12 External Input 13 1 Inactive Active

13 External Input 14 1 Inactive Active

14 External Input 15 1 Inactive Active

15 External Input 16 1 Inactive Active

16 External Input17 1 Inactive Active

17 External Input 18 1 Inactive Active

18 External Input19 1 Inactive Active

19 External Input 20 1 Inactive Active

20 External Input 21 1 Inactive Active

21 External Input 22 1 Inactive Active

22 External Input 23 1 Inactive Active

23 External Input 24 1 Inactive Active

24 External Input 25 1 Inactive Active

25 External Input 26 1 Inactive Active

26 External Input 27 1 Inactive Active

27 External Input 28 1 Inactive Active

28 External Input 29 1 Inactive Active

29 External Input 30 1 Inactive Active

30 External Input 31 1 Inactive Active

31 External Input 32 1 Inactive Active

32 External Input 32 1 Inactive Active

33 External Input 34 1 Inactive Active

34 External Input 35 1 Inactive Active

35 External Input 36 1 Inactive Active

36 External Input 37 1 Inactive Active

Point 
Index

Name
Default Class
Assigned to Events
(1, 2, 3 or none)

Name for 
State when 
value is 0

Name for 
State when 
value is 1

Description
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37 External Input 38 1 Inactive Active

38 Fault Information Available 
for Fault Locator 1

1 Inactive Active

39 Fault Information Available 
for Fault Locator 2

1 Inactive Active

40 Fault Information Available 
for Fault Locator 3

1 Inactive Active

41 Fault Information Available 
for Fault Locator 4

1 Inactive Active

42 Fault Information Available 
for Fault Locator 5

1 Inactive Active

43 Logic 1 1 Inactive Active

44 Logic 2 1 Inactive Active

45 Logic 3 1 Inactive Active

46 Logic 4 1 Inactive Active

47 Logic 5 1 Inactive Active

48 Logic 6 1 Inactive Active

49 Logic 7 1 Inactive Active

50 Logic 8 1 Inactive Active

51 Logic 9 1 Inactive Active

52 Logic 10 1 Inactive Active

53 Logic 11 1 Inactive Active

54 Logic 12 1 Inactive Active

55 Logic 13 1 Inactive Active

56 Logic 14 1 Inactive Active

57 Logic 15 1 Inactive Active

58 High/low speed recording 
active

none Inactive Active

59 High/low speed recording 
space nearly full alarm

1 Inactive Active

60 Trend Recording Active none Inactive Active

61 Trend Recording Accumu-
lation Alarm

1 Inactive Active

62* Output Contact 1 1 Inactive Active

63* Output Contact 2 1 Inactive Active

64* Output Contact 3 1 Inactive Active

65* Output Contact 4 1 Inactive Active

Point 
Index

Name
Default Class
Assigned to Events
(1, 2, 3 or none)

Name for 
State when 
value is 0

Name for 
State when 
value is 1

Description
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66* Output Contact 5 1 Inactive Active

67* Output Contact 6 1 Inactive Active

Point 
Index

Name
Default Class
Assigned to Events
(1, 2, 3 or none)

Name for 
State when 
value is 0

Name for 
State when 
value is 1

Description
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2.2 Binary Output Status 
And Control Relay 
Output Block 

Binary Output Status Group Number: 10
Binary Output Event Group Number: 11
CROB Group Number: 12
Binary Output Command Event Object 
Num: 13

Capabilities Current Value
If configurable, 
list methods

2.2.1 Minimum pulse time 
allowed with Trip, 
Close, and Pulse On 
commands:

 Fixed at 0,000 ms (hardware may limit this 
further)

 Based on point Index (add column to table 
below)

2.2.2 Maximum pulse time 
allowed with Trip, 
Close, and Pulse On 
commands:

 Fixed at 0,000 ms (hardware may limit this 
further)

 Based on point Index (add column to table 
below)

2.2.3 Binary Output Status 
included in Class 0 
response:

 Always
 Never
 Only if point is assigned to Class 1, 2, or 3
 Based on point Index (add column to table 

below)

2.2.4 Reports Output 
Command Event 
Objects:

 Never
 Only upon a successful Control
 Upon all control attempts

Not supported

2.2.5 Event Variation 
reported when variation 
0 requested:

 Variation 1 - without time
 Variation 2 - with absolute time
 Based on point Index (add column to table 

below)

Not supported TESLA Control 
Panel
(See Note 2 
below)

2.2.6 Command Event 
Variation reported when 
variation 0 requested:

 Variation 1 - without time
 Variation 2 - with absolute time
 Based on point Index (add column to table 

below)

Not supported TESLA Control 
Panel
(See Note 2 
below)

2.2.7 Event reporting mode:  Only most recent
 All events

Not supported TESLA Control 
Panel
(See Note 2 
below)

2.2.8 Command Event 
reporting mode:

 Only most recent
 All events

Not supported

2.2.9 Maximum Time 
between Select and 
Operate:

 Not Applicable
 Fixed at 10 seconds
 Configurable, range ______ to ______ seconds
 Configurable, selectable 

from___,___,___seconds
 Configurable, other, describe______________
 Variable, explain _______________________
 Based on point Index (add column to table 

below)

10 s

2.2.10 Definition of Binary 
Output Status/Control 
relay output block 
(CROB) Point List:

 Fixed, list shown in table below
 Configurable
 Other, explain_____________________

Complete list is 
shown in the 
table below; 
points excluded 
from the default 
configuration are 
marked with '*'

TESLA Control 
Panel
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NOTES

1. Binary Outputs are scanned with 500 ms resolution.

2. Events are not supported for Binary Outputs (group 10), but most of Binary 
Output points can be mapped to Binary Inputs (group 2) with full Event and Class 
Data support. See TESLA Control Panel /DNP Configuration/Point Map screen 
for complete point lists and configuration options.

3. Binary Output data points are user selectable; the data points available in the 
device for any given Binary Output point selection can be obtained through the 
TESLA Control Panel software (see SCADA Setting Summary).

Supported Control Operations
Default Class

Assigned to Events
(1, 2, 3 or none)
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Name for 
State when 
value is 0

Name for 
State when 
value is 1

Change Command Description

0 Output contact 1 - - - - - - - - - - - Open Closed None None

1 Output contact 2 - - - - - - - - - - - Open Closed None None

2 Output contact 3 - - - - - - - - - - - Open Closed None None

3 Output contact 4 - - - - - - - - - - - Open Closed None None

4 Output contact 5 - - - - - - - - - - - Open Closed None None

5 Output contact 6 - - - - - - - - - - - Open Closed None None

6 Retrieve Next Fault 
Information Event 
for Fault Locator 1

Y Y Y Y - Y Y - - - - Inactive Active None None Pulse duration fixed 
at 1 

7 Retrieve Next Fault 
Information Event 
for Fault Locator 2

Y Y Y Y - Y Y - - - - Inactive Active None None Pulse duration fixed 
at 1 

8 Retrieve Next Fault 
Information Event 
for Fault Locator 3

Y Y Y Y - Y Y - - - - Inactive Active None None Pulse duration fixed 
at 1 

9 Retrieve Next Fault 
Information Event 
for Fault Locator 4

Y Y Y Y - Y Y - - - - Inactive Active None None Pulse duration fixed 
at 1 

10 Retrieve Next Fault 
Information Event 
for Fault Locator 5

Y Y Y Y - Y Y - - - - Inactive Active None None Pulse duration fixed 
at 1 
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2.3 Analog Input Points
Static (Steady-State) Group Number:  30
Event Group Number:  32

Capabilities Current Value
If configurable, 
list methods

2.3.1 Static Variation reported 
when variation 0 
requested:

 Variation 1 - 32-bit with flag
 Variation 2 - 16-bit with flag
 Variation 3 - 32-bit without flag
 Variation 4 - 16-bit without flag
 Variation 5 - single-precision floating point with 

flag
 Variation 6 - double-precision floating point with 

flag
 Based on point Index (add column to table 

below)

2.3.2 Event Variation 
reported when variation 
0 requested:

 Variation 1 - 32-bit without time
 Variation 2 - 16-bit without time
 Variation 3 - 32-bit with time
 Variation 4 - 16-bit with time
 Variation 5 - single-precision floating point w/o 

time
 Variation 6 - double-precision floating point w/o 

time
 Variation 7 - single-precision floating point with 

time
 Variation 8 - double-precision floating point with 

time
 Based on point Index (add column to table 

below)

2.3.3 Event reporting mode:  Only most recent
 All events

2.3.4 Analog Inputs Included 
in Class 0 response:

 Always
 Never
 Only if point is assigned to Class 1, 2, or 3
 Based on point Index (add column to table 

below)

2.3.5 How Deadbands are 
set:

 A. Global Fixed
 B. Configurable through DNP
 C. Configurable via other means
 D. Other, explain ________________________
 Based on point Index - column specifies which 

of the options applies, B, C, or D

TESLA Control 
Panel

2.3.6 Analog Deadband 
Algorithm:

simple - just compares the difference from 
the previous reported value

 Simple
 Integrating
 Other, explain __________________________

2.3.7 Definition of Analog 
Input Point List:

 Fixed, list shown in table below
 Configurable
 Other, explain_____________________

Default list is 
shown in table 
below

TESLA Control 
Panel
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NOTES

1. Analog Inputs are scanned with 500 ms resolution.

2. Nominal values in calculations for the following table are based on 69V sec-
ondary voltage * PT ratio for voltage channels, and either 1 A or 5A secondary 
current * CT ratio for current channels dependent upon the format of CT installed 
in the TESLA LITE.

3. Analog Input data points are user selectable; the data points available in the 
device for any given Analog Input point selection can be obtained through the 
TESLA Control Panel software (see SCADA Setting Summary).

4. When a fault location event is available for any of the 5 fault locator functions, 
associated Binary Input "Fault Information Available for Fault Locator x" (default 
point indices 38-42) is asserted while there are still fault location events in the 
buffer (size 200). When a Pulse or Latch is received for the Binary Output "Re-
trieve Next Fault Information Event for Fault Locator x" (default point indices 6-
10, previous state is not important), fault event information is put into the Analog 
Inputs (default point indices 143-167). If there is no fault location event available 
when the Binary Output is pulsed, the fault type is set to zero. Not all fault loca-
tion events are reported trough DNP. In a burst of fault locations from a fault, only 
the first processed event is available through DNP, all other events within the fol-
lowing 100 ms interval are ignored. Outside 100 ms from the processed fault lo-
cation event, the system accepts another fault location event and performs the 
same filtering.

The following bitmap id used for the fault information Type points:

0x0001 - Phase A

0x0002 - Phase B

0x0004 - Phase C

0x0008 - Ground
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Transmitted Value1 Scaling2

P
o

in
t 

In
d

ex

Name

Default Class
Assigned to 

Events
(1, 2, 3 or none)

Minimum Maximum6 Multiplier
(default/ (range))

Offset Units
Resolutiona

(default/ 
maximal)

Description

0 Analog Input 1 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

1 Analog Input 1 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

2 Analog Input 1 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

3 Analog Input 1 SHL 2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

4 Analog Input 2 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

5 Analog Input 2 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

6 Analog Input 2 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

7 Analog Input 2 SHL 2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

8 Analog Input 3 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

9 Analog Input 3 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

10 Analog Input 3 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

11 Analog Input 3 SHL 2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

12 Analog Input 4 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

13 Analog Input 4 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

14 Analog Input 4 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

15 Analog Input 4 SHL 2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

16 Analog Input 5 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

17 Analog Input 5 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

18 Analog Input 5 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

19 Analog Input 5 SHL 2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

20 Analog Input 6 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

21 Analog Input 6 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

22 Analog Input 6 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

23 Analog Input 6 SHL 2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

24 Analog Input 7 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

25 Analog Input 7 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

26 Analog Input 7 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

27 Analog Input 7 SHL 2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

28 Analog Input 8 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

29 Analog Input 8 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

30 Analog Input 8 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

31 Analog Input 8 SHL 2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01
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32 Analog Input 9 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

33 Analog Input 9 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

34 Analog Input 9 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

35 Analog Input 9 SHL 2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

36 Analog Input 10 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

37 Analog Input 10 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

38 Analog Input 10 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

39 Analog Input 10 
SHL

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

40 Analog Input 11 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

41 Analog Input 11 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

42 Analog Input 11 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

43 Analog Input 11 
SHL

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

44 Analog Input 12 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

45 Analog Input 12 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

46 Analog Input 12 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

47 Analog Input 12 
SHL

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

48 Analog Input 13 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

49 Analog Input 13 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

50 Analog Input 13 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

51 Analog Input 13 
SHL

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

52 Analog Input 14 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

53 Analog Input 14 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

54 Analog Input 14 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

55 Analog Input 14 
SHL

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

56 Analog Input 15 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

57 Analog Input 15 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

58 Analog Input 15 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

59 Analog Input 15 
SHL

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

60 Analog Input 16 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

61 Analog Input 16 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

62 Analog Input 16 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

Transmitted Value1 Scaling2
P

o
in

t 
In

d
e

x

Name

Default Class
Assigned to 

Events
(1, 2, 3 or none)

Minimum Maximum6 Multiplier
(default/ (range))

Offset Units
Resolutiona

(default/ 
maximal)

Description
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63 Analog Input 16 
SHL

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

64 Analog Input 17 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

65 Analog Input 17 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

66 Analog Input 17 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

67 Analog Input 17 
SHL

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

68 Analog Input 18 
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

69 Analog Input 18 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

70 Analog Input 18 
THD

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.00001

71 Analog Input 18 
SHL

2 0 Configurable 0.01 / (0.01- 1.0) 0.0 % 0.1 / 0.01

72 Summation 1 Mag-
nitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

73 Summation 1 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

74 Summation 2  
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

75 Summation 2  
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

76 Summation 3 Mag-
nitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

77 Summation 3 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

78 Summation 4  
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

79 Summation 4 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

80 Summation 5  
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

81 Summation 5 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

82 Summation 6  
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

83 Summation 6 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

84 Summation 7  
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

85 Summation 7 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

86 Summation 8  
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

87 Summation 8 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

88 Summation 9  
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

89 Summation 9 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

90 Summation10  
Magnitude

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

91 Summation 10 
Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

92 Sequence Function 
1 Positive

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

93 Sequence Function 
1 Negative

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

Transmitted Value1 Scaling2
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t 
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Default Class
Assigned to 
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(1, 2, 3 or none)
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(default/ (range))

Offset Units
Resolutiona

(default/ 
maximal)

Description
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94 Sequence Function 
1 Zero

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

95 Sequence Function 
2 Positive

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

96 Sequence Function 
2 Negative

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

97 Sequence Function 
2 Zero

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

98 Sequence Function 
3 Positive

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

99 Sequence Function 
3 Negative

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

100 Sequence Function 
3 Zero

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

101 Sequence Function 
4 Positive

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

102 Sequence Function 
4 Negative

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

103 Sequence Function 
4 Zero

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

104 Sequence Function 
5 Positive

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

105 Sequence Function 
5 Negative

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

106 Sequence Function 
5 Zero

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

107 Sequence Function 
6 Positive

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

108 Sequence Function 
6 Negative

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

109 Sequence Function 
6 Zero

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Configurable 0.1 / 0.00001

110 Watts/Vars Func-
tion 1 P

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MW 0.1 / 0.00001

111 Watts/Vars Func-
tion 1 Q

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MVAR 0.1 / 0.00001

112 Watts/Vars Func-
tion 1 S

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MW 0.1 / 0.00001

113 Watts/Vars Func-
tion 2 P

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MW 0.1 / 0.00001

114 Watts/Vars Func-
tion 2 Q

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MVAR 0.1 / 0.00001

115 Watts/Vars Func-
tion 2 S

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MW 0.1 / 0.00001

116 Watts/Vars Func-
tion 3 P

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MW 0.1 / 0.00001

117 Watts/Vars Func-
tion 3 Q

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MVAR 0.1 / 0.00001

118 Watts/Vars Func-
tion 3 S

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MW 0.1 / 0.00001

119 Watts/Vars Func-
tion 4 P

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MW 0.1 / 0.00001

120 Watts/Vars Func-
tion 4 Q

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MVAR 0.1 / 0.00001

121 Watts/Vars Func-
tion 4 S

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MW 0.1 / 0.00001

122 Watts/Vars Func-
tion 5 P

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MW 0.1 / 0.00001

123 Watts/Vars Func-
tion 5 Q

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MVAR 0.1 / 0.00001

124 Watts/Vars Func-
tion 5 S

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 MW 0.1 / 0.00001
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Events
(1, 2, 3 or none)

Minimum Maximum6 Multiplier
(default/ (range))

Offset Units
Resolutiona

(default/ 
maximal)

Description
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125 Frequency 1 2 0 Configurable 0.01 / (0.001 - 1.0) 0.0 Hz 0.01 / 0.001

126 Impedance Func-
tion 1 Mag

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Ohm 0.1 / 0.00001

127 Impedance Func-
tion 1 Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

128 Impedance Func-
tion 2 Mag

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Ohm 0.1 / 0.00001

129 Impedance Func-
tion 2 Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

130 Impedance Func-
tion 3 Mag

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Ohm 0.1 / 0.00001

131 Impedance Func-
tion 3 Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

132 Impedance Func-
tion 4 Mag

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Ohm 0.1 / 0.00001

133 Impedance Func-
tion 4 Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

134 Impedance Func-
tion 5 Mag

2 0 Configurable 0.1 / (0.00001- 1.0) 0.0 Ohm 0.1 / 0.00001

135 Impedance Func-
tion 5 Angle

2 -18,000 18,000 0.1 / (0.01 - 1.0) 0.0 degrees 0.1 / 0.01

136 Power Factor 
Function 1 Level

none 0 1.0 0.01 0.0 0.01

137 Power Factor 
Function 2 Level

none 0 1.0 0.01 0.0 0.01

138 Power Factor 
Function 3 Level

none 0 1.0 0.01 0.0 0.01

139 Power Factor 
Function 4 Level

none 0 1.0 0.01 0.0 0.01

140 Power Factor 
Function 5 Level

none 0 1.0 0.01 0.0 0.01

141 High/low speed 
recording space 
used

none 0 100 1.0 0.0 % 1.0

142 Trend Recording 
days Accumulated

none 0 90 1.0 0.0 day 1.0

Fault Locator 1

143 Fault Information - 
DNP Time - High 
16 bits

none 0 65,535 1.0 0.0 NA 1.0 See note #4 above on 
how to access Fault Infor-
mation

144 Fault Information - 
DNP Time - Middle 
16 bits

none 0 65,535 1.0 0.0 NA 1.0

145 Fault Information - 
DNP Time - Low 16 
bits

none 0 65,535 1.0 0.0 NA 1.0

146 Fault Information - 
Distance

none 0 Configurable 0.1 0.0 Configurable 0.1

147 Fault Information - 
Type

none 0 15 1.0 0.0 NA 1.0

Fault Locator 2

148 Fault Information - 
DNP Time - High 
16 bits

none 0 65,535 1.0 0.0 NA 1.0 See note #4 above on 
how to access Fault Infor-
mation

149 Fault Information - 
DNP Time - Middle 
16 bits

none 0 65,535 1.0 0.0 NA 1.0

150 Fault Information - 
DNP Time - Low 16 
bits

none 0 65,535 1.0 0.0 NA 1.0

151 Fault Information - 
Distance

none 0 Configurable 0.1 0.0 Configurable 0.1
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1 The minimum and maximum transmitted values are the lowest and highest values that the out-
station will report in DNP analog input objects. These values are integers if the outstation trans-
mits only integers. If the outstation is capable of transmitting both integers and floating-point, 
then integer and floating-point values are required for the minimums and maximums.

For example, a pressure sensor is able to measure 0 to 500 kPa. The outstation provides a linear 
conversion of the sensor's output signal to integers in the range of 0 to 25000 or floating-point 
values of 0 to 500.000. The sensor and outstation are used in an application where the maximum 
possible pressure is 380 kPa. For this input, the minimum transmitted value would be stated as 
0 / 0.0 and the maximum transmitted value would be stated as 19000 / 380.000.

2 The scaling information for each point specifies how data transmitted in integer variations (16 
bit and 32 bit) is converted to engineering units when received by the Master (i.e. scaled accord-
ing to the equation:  scaled value = multiplier * raw + offset). Scaling is not applied to Floating 
point variations since they are already transmitted in engineering units.

152 Fault Information - 
Type

none 0 15 1.0 0.0 NA 1.0

Fault Locator3

153 Fault Information - 
DNP Time - High 
16 bits

none 0 65,535 1.0 0.0 NA 1.0 See note #4 above on 
how to access Fault Infor-
mation

154 Fault Information - 
DNP Time - Middle 
16 bits

none 0 65,535 1.0 0.0 NA 1.0

155 Fault Information - 
DNP Time - Low 16 
bits

none 0 65,535 1.0 0.0 NA 1.0

156 Fault Information - 
Distance

none 0 Configurable 0.1 0.0 Configurable 0.1

157 Fault Information - 
Type

none 0 15 1.0 0.0 NA 1.0

Fault Locator 4

158 Fault Information - 
DNP Time - High 
16 bits

none 0 65,535 1.0 0.0 NA 1.0 See note #4 above on 
how to access Fault Infor-
mation

159 Fault Information - 
DNP Time - Middle 
16 bits

none 0 65,535 1.0 0.0 NA 1.0

160 Fault Information - 
DNP Time - Low 16 
bits

none 0 65,535 1.0 0.0 NA 1.0

161 Fault Information - 
Distance

none 0 Configurable 0.1 0.0 Configurable 0.1

162 Fault Information - 
Type

none 0 15 1.0 0.0 NA 1.0

Fault Locator 5

163 Fault Information - 
DNP Time - High 
16 bits

none 0 65,535 1.0 0.0 NA 1.0 See note #4 above on 
how to access Fault Infor-
mation

164 Fault Information - 
DNP Time - Middle 
16 bits

none 0 65,535 1.0 0.0 NA 1.0

165 Fault Information - 
DNP Time - Low 16 
bits

none 0 65,535 1.0 0.0 NA 1.0

166 Fault Information - 
Distance

none 0 Configurable 0.1 0.0 Configurable 0.1

167 Fault Information - 
Type

none 0 15 1.0 0.0 NA 1.0

a.

Transmitted Value1 Scaling2
P

o
in

t 
In

d
e

x

Name

Default Class
Assigned to 

Events
(1, 2, 3 or none)

Minimum Maximum6 Multiplier
(default/ (range))

Offset Units
Resolutiona

(default/ 
maximal)

Description
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3 Resolution is the smallest change that may be detected in the value due to quantization errors 
and is given in the units shown in the previous column. This parameter does not represent the 
accuracy of the measurement.

5 Maximal values are calculated as (2 * Configured Nominal / Multiplier) for voltage channels 
and as (20 * Configured Nominal / Multiplier) for current channels (see Note 2 above for the 
nominal definitions).
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* Object 110 and 111 are Octet String Object used to provide access to the 
Event Log text of the relay. Object 110 always contains the most recent event 
in the relay. Object 111 is the corresponding change event object. 

As stated in the DNP specifications, the variation of the response object repre-
sents the length of the string. The string represents the ASCII values of the 
event text. The first two characters in the string can be used to quickly identify 
fault location events. Fault locator events begin with the characters "FL" 
(0x46, 0x4C hex). The following example shows a fault distance event re-
turned through either of the octet string objects:

Event Message:

2.4 Octet String Points
Static (Steady-State) Group Number:  110
Event Group Number:  111

Capabilities Current Value
If configurable, 
list methods

2.4.1 Event reporting mode *:  Only most recent
 All events

2.4.2 Octet Strings Included 
in Class 0 response:

 Always
 Never
 Only if point is assigned to Class 1, 2, or 3
 Based on point Index (add column to table 

below)

2.4.3 Definition of Octet 
String Point List:

 Fixed, list shown in table below
 Configurable (current list may be shown in table 

below)
 Other, explain Used for Event Log access as 

described below

FL2000Sep21 20:16:16.966: Line 16:FLoc BG 39.7 miles

DNP Octet string object components:

0x46 0x4C 0x32 0x30 0x30 030x

0x53 0x65 0x70 0x32 0x31 0x20

0x33 0x30 0x3A 0x31 0x36 0x3A

0x31 0x36 0x2E 0x39 0x36 0x36

0x20 0x3A 0x20 0x4C 0x69 0x6E

0x65 0x20 0x31 0x36 0x3A 0x46

0x4C 0x6F 0x63 0x20 0x42 0x47

0x20 0x33 0x39 0x2E 0x37 0x20

0x6D 0x69 0x6C 0x65 0x73
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Implementation 
Table

The following implementation table identifies which object groups and varia-
tions, function codes and qualifiers the device supports in both requests and re-
sponses. The Request columns identify all requests that are parsed by an 
Outstation. The Response columns identify all responses that may be sent by 
an Outstation.

NOTES

The implementation table lists all functionality required by the device (Outsta-
tion) as defined within the DNP3 IED Conformance Test Procedures. Any func-
tionality beyond the highest subset level supported is indicated by highlighted 
rows. Any Object Groups not provided by an outstation are indicated by strike-
through (note these Object Groups will still be parsed).

DNP Object Group & Variation Request
Outstation parses

Response
Outstation can issue

Group 
Num

Var 
Num

Description
Function Codes 
(dec)

Qualifier Codes (hex)
Function Codes 
(dec)

Qualifier Codes (hex)

1 0 Binary Input - Any Variation 1                        (read) 06 (no range, or all) 129    (response) 00, 01    (start-stop) 

00, 01    (start-stop) 
07, 08  (limited qty) 
17, 28          (index)

1 1 Binary Input - Packed format 1                        (read) 06 (no range, or all) 
00, 01    (start-stop) 
07, 08  (limited qty) 
17, 28          (index)

129    (response) 00, 01    (start-stop) 

1 2 Binary Input - With flags 1                        (read) 06 (no range, or all) 
00, 01    (start-stop) 
07, 08  (limited qty) 
17, 28          (index)

129    (response) 00, 01    (start-stop) 

2 0 Binary Input Event - Any Variation 1                        (read) 06 (no range, or all) 
07, 08  (limited qty)

129    (response) 17, 28          (index)

2 1 Binary Input Event - Without time 1                        (read) 06 (no range, or all) 
07, 08  (limited qty)

129 (response)
130 (unsol. resp)

17, 28          (index)

2 2 Binary Input Event - With absolute 
time

1                        (read) 06 (no range, or all) 
07, 08  (limited qty)

129 (response)
130 (unsol. resp)

17, 28          (index)

2 3 Binary Input Event - With relative 
time

1                        (read) 06 (no range, or all) 
07, 08  (limited qty)

129 (response)
130 (unsol. resp)

17, 28          (index)

10 0 Binary Output - Any Variation 1                        (read) 06 (no range, or all) 129    (response) 00, 01    (start-stop)

00, 01    (start-stop) 
07, 08  (limited qty) 
17, 28          (index)

10 2 Binary Output - Output Status with 
flag

1                        (read) 06 (no range, or all) 
00, 01    (start-stop) 
07, 08  (limited qty) 
17, 28          (index)

129    (response) 00, 01    (start-stop)

12 1 Binary Command - Control relay 
output block (CROB)

3                      (select)
4                   (operate)
5                 (direct op)
6        (dir. op, no ack)

17, 28 (index) 129    (response) Echo of request

20 0 Counter - Any Variation 1                        (read)
7                     (freeze)
8         ( freeze noack)
9            (freeze clear)
10         (frz. cl. noack)

06 (no range, or all) 129    (response)
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20 1 Counter - 32-bit with flag 129    (response) 00, 01 (start-stop)

20 2 Counter - 16-bit with flag 129    (response) 00, 01 (start-stop)

20 5 Counter - 32-bit without flag 129    (response) 00, 01 (start-stop)

20 6 Counter - 16-bit without flag 129    (response) 00, 01 (start-stop)

21 0 Frozen Counter - Any Variation 1                        (read) 06 (no range, or all)

21 1 Frozen Counter - 32-bit with flag 129 (response) 00, 01    (start-stop)

21 2 Frozen Counter - 16-bit with flag 129 (response) 00, 01    (start-stop)

21 9 Frozen Counter - 32-bit without flag 129 (response) 00, 01    (start-stop)

21 10 Frozen Counter - 16-bit without flag 129 (response) 00, 01    (start-stop)

22 0 Counter Event - Any Variation 1                        (read) 06 (no range, or all) 
07, 08  (limited qty)

22 1 Counter Event - 32-bit with flag 129 (response)
130 (unsol. resp)

17, 28          (index)

22 2 Counter Event - 16-bit with flag 129 (response)
130 (unsol. resp)

17, 28          (index)

30 0 Analog Input - Any Variation 1                        (read) 06 (no range, or all) 129 (response) 00, 01    (start-stop)

00, 01    (start-stop) 
07, 08  (limited qty) 
17, 28          (index)

30 1 Analog Input - 32-bit with flag 1                        (read) 06 (no range, or all) 
00, 01    (start-stop) 
07, 08  (limited qty) 
17, 28          (index)

129 (response) 00, 01    (start-stop)

30 2 Analog Input - 16-bit with flag 1                        (read) 06 (no range, or all) 
00, 01    (start-stop) 
07, 08  (limited qty) 
17, 28          (index)

129 (response) 00, 01    (start-stop)

30 3 Analog Input - 32-bit without flag 1                        (read) 06 (no range, or all) 
00, 01    (start-stop) 
07, 08  (limited qty) 
17, 28          (index)

129 (response) 00, 01    (start-stop)

30 4 Analog Input - 16-bit without flag 1                        (read) 06 (no range, or all) 
00, 01    (start-stop) 
07, 08  (limited qty) 
17, 28          (index)

129 (response)

32 0 Analog Input Event - Any Variation 1                        (read) 06 (no range, or all)
07, 08  (limited qty)

129 (response) 17, 28          (index)

32 1 Analog Input Event - 32-bit without 
time

1                        (read) 06 (no range, or all)
07, 08  (limited qty)

129 (response)
130 (unsol. resp)

17, 28          (index)

32 2 Analog Input Event - 16-bit without 
time

1                        (read) 06 (no range, or all)
07, 08  (limited qty)

129 (response)
130 (unsol. resp)

17, 28          (index)

32 3 Analog Input Event - 32-bit with time 1                        (read) 06 (no range, or all)
07, 08  (limited qty)

129    (response) 17, 28          (index)

32 4 Analog Input Event - 16-bit with time 1                        (read) 06 (no range, or all)
07, 08  (limited qty)

129    (response) 17, 28          (index)

40 0 Analog Output Status - Any Varia-
tion

1                        (read) 06 (no range, or all) 129    (response)

40 2 Analog Output Status - 16-bit with 
flag

129    (response) 00, 01    (start-stop)

DNP Object Group & Variation Request
Outstation parses

Response
Outstation can issue

Group 
Num

Var 
Num

Description
Function Codes 
(dec)

Qualifier Codes (hex)
Function Codes 
(dec)

Qualifier Codes (hex)
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41 2 Analog Output - 16-bit 3                     (select)
4                  (operate)
5                 (direct op)
6        (dir. op, no ack)

17, 28          (index) 129    (response) Echo of request

50 1 Time and Date - Absolute time 2                      (write) 07  (limited qty = 1) 129    (response)

51 1 Time and Date CTO - Absolute time, 
synchronized

129 (response)
130 (unsol. resp)

07        (limited qty)                     
(qty = 1) 

51 2 Time and Date CTO - Absolute time, 
unsynchronized

129 (response)
130 (unsol. resp)

07        (limited qty)                     
(qty = 1) 

52 1 Time Delay - Coarse 129    (response) 07        (limited qty)                     
(qty = 1) 

52 2 Time delay - Fine 129    (response) 07        (limited qty)                     
(qty = 1) 

60 1 Class Objects - Class 0 data 1                        (read) 06 (no range, or all) 129    (response) 00, 01    (start-stop)

60 2 Class Objects - Class 1 data 1                        (read) 06 (no range, or all) 129    (response) 17, 28          (index)

60 3 Class Objects - Class 2 data 1                        (read) 06 (no range, or all) 129    (response) 17, 28          (index)

60 4 Class Objects - Class 3 data 1                        (read) 06 (no range, or all) 129    (response) 17, 28          (index)

80 1 Internal Indications - Packet format 2                        (write) 00          (start-stop)  
(index = 7)

129    (response)

110 0 Octet string 1                        (read) 06 (no range, or all) 129    (response) 07        (limited qty)

111 0 Octet string event 1                        (read) 06 (no range, or all) 129    (response) 07        (limited qty)

No Object (function code only) 13           (cold restart) 129    (response)

No Object (function code only) 14         (warm restart) 129    (response)

No Object (function code only) 23         (delay meas.) 129    (response)

DNP Object Group & Variation Request
Outstation parses

Response
Outstation can issue

Group 
Num

Var 
Num

Description
Function Codes 
(dec)

Qualifier Codes (hex)
Function Codes 
(dec)

Qualifier Codes (hex)
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Appendix F TESLA LITE Handling and 
Disposition 

Unpacking To unpack a TESLA LITE System Unit

   •  Open the bottom of the box.

   •  Place the box on the floor or a secure table.

   •  Lift the box off of the unit leaving the TESLA LITE and packing material 
standing intact.

   •  Remove the packing material from the TESLA LITE.

   •  Dispose of the packing materials and box in a manner consistent with local 
waste disposal procedures and regulations. We recommend recycling the 
box.

Long Term 
Storage

For long term storage:

   •  Store the TESLA LITE system unit in original packing container.

   •  Protect any of the components not in original packing from dust accumu-
lation and moisture.

   •  Store all components indoors and protect from moisture accumulation.

Final 
Disposition

Regulations governing disposal of electronics are rapidly being adopted and 
are constantly changing. We recommend that local electronics disposal regu-
lations be reviewed prior to disposal of a TESLA LITE system when it has 
reached the end of its useful life. The TESLA LITE system unit contains a bat-
tery that should be disposed of separately and may contain other electronic 
components that are potentially subject to specific disposal instructions. Use a 
local electronics recycler who is familiar with local regulations.
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Appendix G  TESLA LITE Drawings
This appendix contains mechanical and connection drawings for the TESLA. 

TESLA LITE Mechanical Overview

TESLA LITE Rear Panel View

Electronic versions of the drawings in both PDF and DWG formats are avail-
able on the TESLA LITE CD in the Manuals directory. The PDF documents 
are scaled for 11" x 17" printing for improved readability.
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Appendix G TESLA LITE Drawings
Figure H.1: Mechanical Drawings

401 450
Appendix G-2 TESLA LITE User Manual  D03283R01.02



Appendix G TESLA LITE Drawings
Figure I.2: Back View
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Index
Index

A
absolute time 10-21, 10-64, 10-66
AC 8-18
AC scaling 8-18
ac scaling 8-18
active trace information 10-19, 10-76
alarm contacts 2-2, A-1
analog graph 10-14, 10-31, 10-34, 10-
39, 10-40, 10-41, 10-42, 10-55
analog input 7-11
analog input channels 8-15, 8-16
automatic record transfer 7-13
autopoll 9-2
autoprint 9-2

C
calibration

analog input 7-11
dc channel 7-12

channel grouping 8-7
channel view 8-9, 8-11
communication ports 4-1, 4-18
configuation editor 8-4
configuration manager 8-1, 8-2, 8-3
connection status 5-5
control tabs 5-6
cross-trigger notification 7-13

D
data acquisition 1-1
diagnostics 4-15
digital graph 10-15, 10-31, 10-34, 10-
39, 10-40
DNP 8-46

E
edit configuration 8-2
element tree 8-9, 8-10
ethernet LAN link 4-3
event log 9-6
event messages 9-6
external input channels 2-2, 8-19, 8-
20

F
fault locator

functions 8-38, 8-39
settings 8-39

frequency channels 8-33, 8-34
front panel 1-4
front panel LEDs 2-3
fundamental RMS 10-21, 10-43, 10-

64, 10-67

G
get from IED 9-2
get remote summaries 9-2
graph 9-2

measure menus 10-19
graphs

absolute time 10-66
add 10-34
add analog 10-14
add channels 10-34
add digital 10-15
calculated channels 10-71
COMTRADE import 10-77, 10-78
COMTRADE inport 10-77
delete 10-15
digital channel status 10-76
export file 10-9
exporting channel data 10-73
exporting views 10-72
fundamental RMS 10-67
graph title 10-63
harmonic view 10-42
harmonics 10-69
impedance view 10-43, 10-44, 10-

45, 10-46
keyboard functions 10-37, 10-38
menus 10-14
move 10-16
overlay view 10-40
pan 10-37
print 10-78
record summary 10-75
reouts and measurements 10-64
superimpose L-PRO characteristics

10-48, 10-49, 10-50, 10-
51, 10-52, 10-53

symcom view 10-41
symmetrical components 10-70
templates 10-56, 10-57, 10-58, 10-

59, 10-60, 10-61
TESLA swing record 10-53, 10-54
timeline view 10-39
trace 10-16, 10-17, 10-18
trend view 10-55
true RMS 10-68
view and graph titles 10-62
view menus 10-11
view title 10-62
window time control 10-47
zoom 10-35
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Index
H
harmonics 10-21

I
identification 8-5
impedance channel 8-28
impedance channels 8-27
install on Windows 2000 3-5
install on Windows XP 3-2
installation 1-1
installing TESLA 3-1
IRIG-B time input 4-2
IRIG-B time signal 2-2

L
logic functions 8-35, 8-36

M
maintenance menu 12-1
maintenance menu, commands 12-3
maintenance menu, error handling
12-5
measure menus 10-20, 10-21
meter groups 8-43
metering 6-1
MODBUS 8-46
modem

external 4-10
internal 4-12
LAN gateway 4-12

modem link 4-10
mount TESLA recorder 2-1

N
navigating TESLA 5-6
notify 7-13
notify settings 7-14

O
offline operation 5-5
online operation 5-5
options menus 10-26, 10-27, 10-28,
10-29
out of range 7-12

P
password

protection 7-15
setting 7-15

phase angle reference channel 8-10
power factor

functions 8-40, 8-41
settings 8-41

power supply 2-1
print

configuration 8-46
SCADA address list 8-46

printing 8-46

R
rear connections 1-5
record

filter 9-1
lists 9-1
summary 9-2

recorder workspace 5-1
RecordGraph

components 10-4
graphs 10-34
help menus 10-30
import file 10-10
launch 10-3
menus 10-5, 10-6
print 10-7, 10-8, 10-9
tool bar 10-30
view add 10-32
view delete 10-32
view rename 10-33
views 10-32

RecordGraph,
launch 10-1

recordings stored 9-3
records 9-1
refresh 9-3
rename 9-3

S
sag and swell 8-18
SCADA services 4-13
scale menus 10-22, 10-23, 10-24, 10-
25
sequenc component channel 8-25
sequence component channels 8-24
setting Windows serial port parame-
ters 4-18
show record summary 10-10
signal connections 2-2
specifications A-1
start-up 3-6
startup sequence 2-3
status bar 5-6
storage alarms 8-6
summation channel 8-21, 8-22
symmetrical components 10-22
system requirements 3-1

T
template manager 10-7
trend log 9-4
trend logging 8-44, 8-45
trigger fault 9-3
trigger swing 9-3
true RMS 10-21
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V
view channel list 10-13

W
watts and VARS channels 8-30, 8-31
workspace 5-6

add/edit 5-3
settings 5-3
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